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АННОТАЦИЯ 

 
Настоящее пособие знакомит читателя с технологией компьютерного проектирования 

конструкций на основе конечно-элементного моделирования и выполнения расчетов в среде 
современного инструмента CAE-технологий – в системе инженерного анализа и оптимизации 
MSC.Nastran с пре- и постпроцессором MSC.Patran. С помощью примеров моделирования 
конструкций разного типа, характерных для ракетно-космической техники (РКТ), и примеров 
ведения конечно-элементных расчетов, типичных для разных этапов проектирования, пособие 
помогает пользователю начать работать в этой сложной интеллектуальной среде. 

В пособии обсуждаются основные идеи технологии виртуального проектирования, 
приводятся приемы моделирования разнообразных конструкций; основные типы конечных 
элементов системы MSC.Nastran, их назначение, особенности использования при 
моделировании конструкций РКТ; необходимые сведения о работе с системой MSC.Nastran и 
пре- и постпроцессором MSC.Patran. 

Для получения практических навыков работы в пособии рассматривается решение 7-и задач 
по моделированию и конечно-элементным расчетам конструкций нарастающей сложности: 
пластина с отверстием; массивный кронштейн; ферменная конструкция; стрингерный отсек; 
углесотопластиковый головной обтекатель ракеты-носителя. При решении этих задач 
изучаются: построение конечно-элементных моделей с использованием геометрического 
моделирования; задание граничных условий; решение задач анализа 
напряженно-деформированного состояния в линейной постановке, линейной потери 
устойчивости, определения собственных форм и частот колебаний, оптимизации распределения 
материала в конструкции; приемы обработки и анализа результатов расчетов. 



Введение 
Разработка новых конкурентоспособных изделий ракетно-космической техники требует 

постоянного совершенствования процесса проектирования конструкций с целью сокращения 
цикла разработки, повышения качества и надежности, снижения материалоемкости. 

Оптимизировать процесс проектирования возможно при использовании современных 
средств инженерного анализа, основанных на разработке компьютерных моделей 
проектируемой конструкции. Современный уровень компьютерного моделирования позволяет 
исследовать, анализировать и оптимизировать конструкцию целиком и каждый ее элемент в 
компьютерной, виртуальной среде до изготовления дорогостоящей конструкции. При этом 
проектирование сложных современных конструкций, как правило, требует совместного 
использования широкого набора различных программных систем инженерного анализа, 
ответственных за тот или иной этап расчетного сопровождения проекта. 

Основными инструментами современного компьютерного моделирования являются: 
1. Программные системы геометрического моделирования и автоматизации 

конструкторских работ CAD (Computer-Aided Design). Наиболее популярными в мире 
системами геометрического моделирования являются AutoCAD, CATIA, Pro/ENGINEER, 
SolidWorks и другие. Твердотельные модели, разработанные в этих системах, могут стать 
основой конечно-элементной модели конструкции. 

2. Программные системы CAE (Computer-Aided Engineering) – системы инженерного 
моделирования, анализа и оптимизации в задачах автоматизированного проектирования. 
Это системы, реализующие метод конечных элементов. Наиболее популярными в мире 
системами CAE являются программные продукты MSC.Software Corporation - Nastran, 
Marc, Adams, Dytran, FlightLoads and Dynamics, а также программные продукты других 
разработчиков, например, ANSIS. 

Метод конечных элементов (МКЭ) [1, 2] представил в алгебраической форме классические 
законы механики сплошной среды. Алгебраическая форма идеально подходит для цифровой 
вычислительной техники, что закономерно привело к разработке специального программного 
обеспечения типа упомянутых выше систем. Реализация МКЭ дала возможность достаточно 
точно моделировать конструкции практически любых форм, с произвольными граничными 
условиями, из разнообразных материалов, в том числе композиционных. Это позволило решать 
задачи расчета реальных сложных конструкций в линейной постановке и с учетом нелинейного 
поведения конструкций и неупругого поведения конструкционных материалов; задачи потери 
устойчивости конструкций и их закритического (после потери устойчивости) поведения; 
решать динамические задачи о собственных частотах, переходных процессах, вынужденных 
гармонических колебаниях; задачи оптимизации характеристик конструкции. Те же подходы 
позволяют решать задачи теплопередачи, теплообмена и термоупругости 

Аналогичные подходы разработаны для механики жидкости и газа. Это позволило не только 
решать задачи аэро- и гидромеханики, но и комплексные задачи взаимодействия конструкции с 
газовой и жидкой средой, то есть задачи аэроупругости и гидроупругости. 

Легко просматривается необходимость взаимодействия между CAD- и CAE-этапами 
проектирования. Так при разработке твердотельной модели будущей конструкции перед 
разработчиком очень скоро возникнут вопросы типа “какое сечение”, “какую толщину” нужно 
задать в том или ином месте, чтобы обеспечить допустимые уровни напряжений, требуемую 
жесткость, устойчивость, долговечность и так далее. Ответы на эти вопросы, так же как вопрос 
о действующих на детали и узлы силах являются предметом CAE – исследований. С другой 
стороны, разработка конечно-элементной модели (КЭ-модель) существенно облегчается при 
наличии геометрической модели. Частично эта дилемма решается следующим образом. 
Практически все серьезные CAD-системы имеют конечно-элементные решатели. Это обычно 
упрощенная или адаптированная система, не требующая от конструктора больших знаний в 
области конечно-элементного анализа. С помощью такой системы конструктор, создав 
геометрическую твердотельную модель детали, задав закрепления и нагрузки, получает 
информацию о напряжениях и деформациях детали. При этом все специфические конечно-



элементные операции максимально автоматизированы. С другой стороны, современные 
конечно-элементные CAE-системы для подготовки исходных данных используют элементы 
геометрического моделирования, включая твердотельную геометрию, используемые обычно 
CAD-системами. 

Таким образом, очевидна тенденция к объединению CAD-систем и CAE-систем, но также 
очевидны коренные различия в подходах к представлению элементов конструкции, 
препятствующие такому объединению. Например, стержень для CAD-системы это профиль, 
имеющий определенную конфигурацию и размеры, назначаемые из соображений компоновки, 
способа соединения со смежными деталями и из других (геометрических, конструктивных и 
технологических) соображений. А для CAE-системы это элемент из конструкционного 
материала с определенными физико-механическими свойствами, обладающий определенными 
жесткостными характеристиками при растяжении-сжатии, изгибе, сдвиге и кручении. Задачей 
CAE-системы при проектировании как раз и является выбор материала и жесткостных 
характеристик каждой детали, чтобы получить наилучшее качество всего изделия (слова 
выделены, чтобы подчеркнуть, что оптимизация одной детали не обязательно ведет к 
оптимизации всей конструкции, а необходим анализ и оптимизация всей конструкции 
целиком). 

Из примера очевидна естественная очередность этапов проектирования конструкции - 
сначала этап CAE, а затем этап CAD. 

Однако к середине ХХ столетия сложилась обратная практика в проектировании. Вначале 
разрабатывалась конструкторская документация. Сечения силовых элементов подбирались с 
помощью упрощенных, так называемых “конструкторских” расчетов. По завершению 
разработки конструкторской документации выполнялись более точные “поверочные” расчеты. 
Их выполняли профессиональные “прочнисты”, используя численные и аналитические методы 
строительной механики. Точность этих методов была относительной, так как расчетные модели 
были, как правило, схематичны и не учитывали многих особенностей конструкции или 
учитывали их приближенно. Были очень ограничены возможности решения нелинейных и не 
статических задач. Расчеты выполнялись либо вручную, либо с помощью простых программ 
для первых маломощных вычислительных машин. Естественно, эти расчеты не вызывали 
большого доверия и основным средством проверки качества конструкции являлись испытания. 
Фактически сложилось правило, по которому расчеты нужны были для того, чтобы разработать 
программу испытаний. Особое внимание на испытаниях обращалось на места, где при 
прочностных расчетах получались высокие напряжения или где результаты расчетов вызывали 
наибольшие сомнения. Для этого и нужны были расчеты. Вот почему спешили с разработкой 
конструкторской документации (по-современному CAD-разработка) – чтобы быстрей 
изготовить опытные образцы изделия для испытаний. А расчеты (CAE-разработка), как сказано 
выше, были нужны позже, для подготовки испытаний. Если на испытаниях конструкции 
выявлялся недостаток прочности или жесткости или других требований, испытания 
останавливались, конструкция ремонтировалась, вносились изменения в документацию и 
испытания возобновлялись. При высоких требованиях к качеству изделия испытания 
использовались как продолжение проектирования, для доводки конструкции до нужной 
кондиции. 

Из основных недостатков такой последовательности проектирования следует отметить 
следующие. 
1. Значительное время, требующееся на изготовление одного или нескольких экземпляров 

конструкции специально для испытаний; разработка, изготовление и монтаж специального 
оборудования на специально оборудованных производственных площадях; 
продолжительность самих испытаний, сопровождающихся многочисленными остановками 
из-за отказов и ремонтов. 

2. Высокая стоимость испытаний, включающая стоимость изделий, стоимость производства и 
эксплуатации оборудования, стоимость производственных площадей и содержания 
значительного штата специалистов, обслуживающих испытания. 

3. Сложность определения причин отказов конструкции на испытаниях и способов ее ремонта. 



4. Сложность выявления избытков массы конструкции. 
5. Большое количество работ по доработке и изменению конструкторской документации из-за 

устранения недостатков, выявленных на испытаниях. 
Что изменится, если при проектировании конструкции уже в самом начале будут 

использоваться современные САЕ–системы? Предположим, что в результате проектировочных 
расчетов и оптимизации конструкция в целом и все ее детали удовлетворяют всем 
необходимым требованиям – прочности, жесткости, долговечности и так далее. Мы сразу 
получим существенный выигрыш по времени и по затратам только за счет того, что испытания 
пройдут с намного меньшим количеством отказов. Это приведет к уменьшению 
продолжительности испытаний, сокращению числа изменений в конструкцию и, 
соответственно, уменьшению объема работ по внесению изменений в конструкторскую 
документацию. Кроме того, в результате оптимизации будет минимизирована масса 
конструкции, что особенно важно для аэрокосмической техники. 

Системное применение CAE-расчетов увеличивает доверие к результатам проектирования, 
что должно приводить к сокращению программы испытаний, оставляя только самые 
необходимые. В результате существенно сокращается цикл проектирования, и экономятся 
средства. 

Однако выигрыш от применения CAE-систем в решающей степени зависит от того 
насколько последовательно, системно они применяются и как результаты расчетов внедряются 
в проект. В связи с этим можно говорить о технологии проектирования, основные положения 
которой обсуждаются в следующем разделе. 

Данное пособие знакомит пользователя с основными идеями технологии конечно-
элементного проектирования конструкций, и помогает начать работать в сложной 
интеллектуальной среде программного продукта MSC.Nastran и пре- и постпроцессора 
MSC.Patran на примерах моделирования, расчетов и оптимизации конструкций разного типа, 
характерных для ракетно-космической техники. 

При подготовке пособия использованы материалы фирменного руководства на английском 
языке  
[3, 4], которые могут быть полезными для дальнейшего углубленного самостоятельного 
совершенствования в данной области. 

 



 

 

1. Технологии компьютерного проектирования конструкций на основе  
КЭ-моделей 

Оптимизировать процесс цикла “проектирование конструкции - изготовление 
конструкторской документации” в значительной мере позволяет использование 
конечно-элементных технологий проектирования. Их применение начинается с ранних 
этапов проектирования, когда внесение изменений в проект связано с наименьшими 
трудностями и продолжается на всех этапах проектирования вплоть до разработки 
конструкторской документации, поверочных и сертификационных расчетов, подготовки 
испытаний и запуска изделия в производство. 

Проектировщик начинает свою работу с разработки конечно-элементной модели 
конструкции, в которую он закладывает необходимые, по его мнению, силовые элементы, 
чтобы конструкция соответствовала своему назначению. Приложив силы, которые будут 
действовать на будущую конструкцию, он получит деформации конструкции, силы и 
напряжения, действующие во всех деталях. Анализируя эти данные, он может менять 
конструкционные материалы, силовую схему, размеры и форму деталей, чтобы добиться 
улучшения конструкции, проверяя внесенные изменения расчетами. Таким образом, 
проектировщик дорабатывает и улучшает КЭ-модель, рассчитывая все воздействия на 
конструкцию, проверяя все требования, предъявляемые к конструкции, и в результате 
получает КЭ-модель конструкции, удовлетворяющей этим требованиям. В реальности этой 
конструкции еще нет. Ее нужно разработать так, чтобы она соответствовала своей 
КЭ-модели. Такой порядок проектирования возник и развивается в связи с появлением и 
развитием систем, реализующих метод конечных элементов. Он получил название “от 
модели к конструкции” или “Virtual Product Development”, что можно перевести как 
вирт уальное исследование изделия или вирт уальное проект ирование (VPD - технология). 

Использование виртуального проектирования позволяет решать задачи выбора проектных 
вариантов силовых схем перспективных средств ракетно-космической техники, повысить 
качество проекта, уменьшить сроки проектирования и количество ошибок, значительно 
снизить расходы на весь цикл проектировочных работ от эскиза до запуска изделия в 
производство. 

Важной особенностью проектирования на КЭ-моделях является возможность увидеть на 
экране монитора в наглядном виде, в интерактивном режиме, во всех ракурсах, в целом и по 
частям, в реальных пропорциях будущую конструкцию, что помогает составить о ней 
правильное представление и мобилизует интуицию для ее совершенствования. Возможность 
вывести на экран (визуализировать) сечения элементов, закрепления, нагрузки позволяет 
эффективно контролировать исходные данные. Отображение непосредственно на КЭ-модели 
в наглядном масштабе деформаций нагруженной конструкции, при свободных колебаниях, в 
переходных динамических процессах в виде линий равных уровней, графиков; отображение 
внутренних усилий, напряжений в виде эпюр, линий равных уровней, графиков, позволяют 
оперативно и наглядно получать детальную информацию о силовой работе конструкции, 
выявлять недостатки, предлагать изменения. Создается впечатление работы с реальной 
конструкцией, хотя ее еще не существует. Отсюда и происходит термин “виртуальное 
проектирование”. 

Проектирование - многоэтапный итерационный процесс, при котором неизбежны 
переделки части работ при выявлении ошибочности или неэффективности отдельных 
проектных решений. Например, поверочный расчет выявил недостаточную прочность одной 
детали. Необходимо перепроектировать ее, изменив всю конструкторскую документацию, в 



 

 

которой она присутствует. Вполне вероятно, что придется заменять и смежные детали, так 
как измененная деталь не сможет с ними сопрягаться. Чем больше таких возвратов - 
итераций, тем больше время проектирования. Уменьшить количество итераций можно только 
при тщательной и глубокой проработке каждого этапа, что как раз и предусматривает VPD - 
технология. 

Объем и содержание проектных работ зависит от многих факторов: 
• сложности объекта проектирования - табурет это или космический аппарат; 
• целей проектирования - создается ракета для первого в истории полета в космос, или мы 

стараемся удержаться на насыщенном рынке за счет новой модификации автомобиля; 
• наличия базовой модели или прототипов или их отсутствия; 
• применения в конструкции новых материалов и технологий или использования 

традиционных; 
• и др. 

Очевидно, что содержание и объем работ в разных ситуациях будет разный. Тем не менее, 
можно выделить этапы, характерные для технологии виртуального проектирования: 
• исследовательский этап; 
• проектирование силовой схемы; 
• детальное проектирование; 
• поверочные и сертификационные расчеты; 
• подготовка и контроль испытаний. 

Исследоват ельский эт ап присутствует тогда, когда в проекте используются те или иные 
новшества. Например, новые материалы, требующие разработки конструктивных решений, 
позволяющих наилучшим образом использовать полезные свойства этих материалов. 
Предметом исследований могут быть поиск толщины полотна, шага, ориентации и размеров 
ребер вафельной оболочки и многое другое. Для таких работ разрабатываются специальные 
модели типовых фрагментов исследуемых конструкций. Могут быть выполнены 
исследования несущей способности конструкции с учетом пластичности, геометрической 
нелинейности, потери устойчивости и несущей способности конструкции после местной 
потери устойчивости. Раньше такие исследования были возможны только посредством 
физических испытаний образцов. Теперь можно экономить значительные средства, заменив 
испытания расчетами. 

Проект ирование силовой схемы заключается в поиске оптимальных путей передачи 
усилий в конструкции и выборе силовых элементов, нужных для этого. На этом этапе 
используются специальные КЭ-модели, предназначенные для моделирования передачи 
только основных усилий и не содержащие второстепенных деталей. Один из возможных 
подходов при поиске оптимальных путей передачи усилий состоит в сравнении нескольких 
вариантов силовых схем и выборе наилучшего по какому либо критерию, например, по 
наименьшей массе конструкции. 

Другой подход состоит в том, что все пространство, в котором может размещаться 
силовая конструкция, заполняется изотропной упругой средой, способной передавать усилия 
в любом направлении. К такой КЭ-модели прикладываются нагрузки, получают и 
анализируют напряженно-деформированное состояние. Далее, из зон конструкции, где 
напряжения и внутренние усилия малы, материал убирают, а в зоны с большими 
внутренними усилиями добавляют. В таком процессе важно учитывать интенсивность 
компонентов тензора напряжений. Часто удобно работать с главными напряжениями, так как 
они более наглядно показывают интенсивность и направленность действия внутренних 
усилий, что может подсказать выгодное расположение силовых элементов, ориентацию 



 

 

подкрепляющих ребер, направление армирующих волокон в композиционных материалах. 
В современных системах, реализующих МКЭ, разработано множество алгоритмов, 

автоматизирующих такой подход. Например, из сплошного куска металла с помощью таких 
алгоритмов рождается изящная ажурная конструкция. При этом сетка конечных элементов по 
ходу процесса оптимизации перестраивается, следуя за изменением формы конструкции. 

Дет альное проект ирование заключается в разработке КЭ-модели, которая должна стать 
основой будущей конструкции. В такой модели присутствуют все силовые элементы, в 
которых нужно определить действующие силы и сечения элементов, необходимые для 
конструкторской проработки. На этом этапе проверяются все ограничения не только по 
прочности, но также по устойчивости, динамическим характеристикам, по долговечности в 
случаях повторяющихся нагрузок и другим ограничениям, связанным с требованиями 
проекта. Если требования не выполняются, модель модифицируется. Сечения элементов 
увеличиваются, при недостатке прочности, жесткости и так далее, или уменьшаются при их 
избытке. При этом наилучшие результаты получаются при использовании алгоритмов 
оптимизации. В качестве функции цели обычно принимается минимум массы конструкции. В 
качестве параметров оптимизации - толщины оболочек, площади и моменты перечных 
сечений одномерных элементов. В качестве ограничений - максимальные напряжения и 
перемещения, частоты собственных колебаний, критические нагрузки потери устойчивости и 
другие, а так же конструктивно-технологические ограничения на минимальные и 
максимальные значения параметров оптимизации. В результате оптимизации получается 
КЭ-модель конструкции, удовлетворяющая всем требованиям и имеющая минимальную 
массу. 

Таким образом, КЭ-модель доводится до такого состояния, при котором конструкция, 
будучи изготовлена в точном соответствии с моделью, может удовлетворить всем 
требованиям проекта, относящимся к силовой конструкции. 

Результаты проектирования КЭ-модели являются исходными данными для 
CAD-разработки конструкции и созданию конструкторской документации. 

Однако полное соответствие конструкторской документации САЕ-разработкам может 
быть только в идеале. На практике неизбежны отклонения, но они не должны существенно 
менять силовую работу конструкции, обязательно должны быть согласованы с 
разработчиками САЕ-проекта и, при необходимости внесения изменения, проверяться 
расчетами. 

Поверочные и серт ификационные расчет ы выполняются после приведения КЭ-модели 
в соответствие с конструкторской документацией, если были внесены изменения в проект. 
После этого разработанная в процессе проектирования и согласованная с конструкторской 
документацией КЭ-модель может служить основой для поверочных расчетов, которые не 
только окончательно проверяют прочность конструкции на весь спектр нагрузок, но и служат 
основанием документального подтверждения годности изделия к эксплуатации. 

Подгот овка и конт роль испыт аний. Расчеты, выполненные в процессе проектирования 
и поверочных расчетов, дают обширную информацию о поведении конструкции в различных 
условиях эксплуатации. Однако для сложных конструкций, эксплуатация которых может 
быть связана с риском для жизней, в обозримом будущем испытания останутся необходимым 
завершающим этапом проектирования. Нельзя забывать и о “человеческом факторе” - 
ошибках, возможных при компьютерном моделировании и расчетах, а так же незамеченных 
ошибках конструкторской проработки, нарушениях технологий изготовления и сборки 
конструкции. Однако наличие подробной информации о напряженно деформированном 
состоянии конструкции позволяет сократить время испытаний и материальные затраты. 
Во-первых, испытания хорошо спроектированной конструкции проходят с минимальным 



 

 

количеством остановок, т.е. быстро. Во вторых, подробная информация о напряженно 
деформированном состоянии во всех случаях нагружения позволяет выбрать для испытаний 
действительно самые тяжелые нагрузки, обоснованно выбрать места установки датчиков, 
измеряющих перемещения и напряжения, и оптимизировать число датчиков, чтобы повысить 
информативность испытаний 

Одной из задач испытаний всегда было сравнение результатов испытаний с расчетами. С 
развитием компьютерного проектирования эта задача становится основной. При хорошем 
совпадении результатов испытаний с расчетами программу дорогостоящих испытаний можно 
существенно сокращать. С другой стороны, результаты испытаний могут служить для 
проверки результатов расчетов и уточнения компьютерных моделей. 

При изложении последовательности работ по VPD-технологии проектирования 
пропущены несколько очень важных вопросов, так как их сложно привязать к определенному 
этапу проектирования, - они актуальны на протяжении нескольких этапов или всего процесса 
VPD-проектирования. Это расчет нагрузок, вопросы взаимодействия с конструкторами, 
прогноз и контроль массы конструкции, и вопросы организационного обеспечения процесса 
VPD-проектирования. 

Нагрузки. Нагрузки на изделие зависят от воздействия внешней среды, от параметров 
движения (траектории, скорости, ускорения), от динамической реакции изделия на внешние 
воздействия и параметры движения. Динамическая реакция зависит от упругих свойств 
(жесткости) конструкции. Жесткость конструкции может уменьшать нагрузки, например, как 
действуют рессоры автомобиля, так и увеличивать нагрузки, например, как в случае 
резонанса при совпадении периода внешней нагрузки с периодом собственных колебаний. 

В начале проектирования жесткость конструкции не известна и нагрузки могут быть 
определены только приближенно. В каждом конкретном случае могут использоваться разные 
подходы. Обычно, сначала изделие считается либо абсолютно жестким, либо используются 
данные из прототипов, либо используются специальные методы. Приближенные нагрузки 
используются на начальных этапах конечно-элементных расчетов. Уже в процессе 
разработки силовой схемы появляются данные о жесткостных свойствах моделируемой 
конструкции, которые используются для уточнения нагрузок. По мере более детальной 
проработки КЭ-модели данные о жесткостных свойствах конструкции и нагрузки 
продолжают уточняться. Таким образом, КЭ-модель дает исходные данные для уточнения 
нагрузок и служит сама, или является основой упругой динамической модели. На упругих 
динамических моделях просчитывается и анализируется большое количество ситуаций, 
связанных с динамическими воздействиями на конструкцию. Это могут быть порывы ветра, 
маневрирование, ударные воздействия, аэроупругие явления - флаттер, дивергенция, бафтинг 
и др. После обработки и анализа результатов динамических расчетов отбирается конечное 
число случаев нагружения, которые являются определяющими при проектировании 
конструкции. 

Взаимодействие с конструкторами. В САЕ-разработках конструкции важна роль 
ведущих специалистов-конструкторов. Их мнение должно быть решающим при разработке 
силовой схемы и при детальной проработке проектировочной КЭ-модели. Ведущие 
конструкторы осуществляют контроль проектных решений, их конструктивной, 
технологической и экономической выполнимости. Очень важно, чтобы при переходе от 
КЭ-модели к чертежам конструкции, не возникало ни технических, ни психологических 
препятствий. 

Контроль массы конструкции. Важным показателем качества конструкции является ее 
масса. Для любых изделий снижение массы при прочих равных условиях уменьшает 
стоимость изделия за счет уменьшения материалоемкости. Для транспортных средств, 



 

 

особенно для аэрокосмической техники, снижение массы конструкции позволяет на ту же 
величину увеличивать полезную нагрузку, что дает большой экономический эффект. Для 
таких изделий увеличение массы может привести к потере конкурентоспособности, 
рентабельности и даже возможности осуществления проекта. Поэтому необходимо оценивать 
массу конструкции с самого начала разработки изделия. Масса КЭ-модели конструкции 
может быть легко автоматически подсчитана и уточняться по мере ее проработки. Однако 
масса КЭ-модели представляет собой теоретическую массу конструкционного материала, 
необходимую для передачи внутренних сил в конструкции. В ней не учитываются 
вспомогательные элементы, крепеж, технологические особенности изготовления, которые, 
обычно, не моделируются в КЭ-модели всей конструкции. Однако, опираясь на 
теоретическую массу, можно определить реальную массу будущей конструкции, используя 
статистические методы и экспертные оценки, и таким образом прогнозировать и 
контролировать массу силовой конструкции уже на начальных этапах и далее на следующих 
этапах проектирования, не допуская превышения весовых лимитов. 

Организационная поддержка. Первостепенное значение при использовании 
VPD-технологий проектирования имеет обеспечение процесса компьютерного 
проектирования квалифицированными специалистами. Такие специалисты должны обладать 
знаниями в области механики твердого деформируемого тела, строительной механики, 
материаловедения и уметь решать сложные много дисциплинарные проектировочные и 
оптимизационные задачи. От них требуется достаточное знание возможностей современных 
программных продуктов и умение ими эффективно пользоваться. Им придется на своем 
предприятии хранить и поддерживать большое количество КЭ-моделей конструкций, 
находящихся в процессе проектирования, производства и эксплуатации. 

В проектных организациях целесообразна организация специальных структурных 
подразделений, занятых только разработкой КЭ-моделей и обеспечением процесса 
проектирования комплексом необходимых конечно-элементных расчетов. При помощи и под 
контролем специалистов этого подразделения частные задачи могут решаться и в других 
отделах предприятия. 

Важнейшую роль играет руководство проектом. Руководитель проекта должен 
контролировать процесс проектирования, обеспечивая достаточно полную проработку на 
каждом из этапов и обеспечивая соблюдение сроков работ. 

Каждый новый этап разработки должен продолжать работы предыдущих этапов, не 
требуя переделок сделанного ранее. 

Основные характеристики и параметры проектируемой конструкции - силовая схема, 
жесткостные характеристики всей конструкции и отдельных элементов, массы элементов 
конструкции должны определяться на возможно более ранних этапах, по крайней мере, до 
начала разработки конструкторской документации и быть на постоянном контроле у 
руководителя проекта. Их изменение исполнителями должно быть обоснованным и 
допускаться в исключительных случаях после серьезного анализа. 

VPD-технология проектирования может увеличивать объем исследований и проработок 
на ранних этапах, но зато приводит к намного более значительному сокращению работ на 
последующих этапах и к созданию надежной и легкой конструкции. 

 



2. Среда моделирования MSC.Nastran/Patran 
Расчет конструкций методом конечных элементов с практической точки зрения делится на 

три этапа. 
1. Cоздание конечно-элементной модели конструкции. 
2. Конечно-элементный расчет конструкции на основе созданной модели. 
3. Анализ результатов расчета. 

В соответствии с этим конечно-элементные системы состоят из трех программных частей: 
препроцессора, решателя и постпроцессора. Препроцессор предназначен для создания конечно-
элементной модели конструкции. Решатель реализует необходимые вычислительные 
алгоритмы для выполнения заданного конечно-элементного расчета модели, подготовленной в 
препроцессоре. Постпроцессор предназначен для отображения результатов расчета, 
полученных решателем. 

Функции препроцессора и постпроцессора MSC.Nastran могут выполнять различные 
программы. Наиболее популярными являются программы FEMAP и Patran. В этом пособии 
рассматривается работа с программой Patran. 

Интерфейс MSC.Patran. включает меню, линейки инструментов и приложений, формы для 
ввода данных, просмотра геометрических объектов и др. Интерфейс обеспечивает доступ ко 
всем часто используемым возможностям системы MSC.Nastran. 

Инструменты и приложения – это основа интерфейса системы MSC.Patran. 
Инструменты позволяют выполнять различные работы в среде MSC.Patran (создавать 

геометрические объекты, задавать пакеты заданий для решения задач, обрабатывать результаты 
анализа, проверять ошибки и сигнализировать об этом и др.). 

Модули приложений осуществляют большие специализированные работы по разработке 
КЭ-моделей, выполнению конечно-элементных расчетов и представлению результатов. 

Важной особенностью инфраструктуры MSC.Patran является интегрированная база данных. 
Вся информация о модели и расчетах сосредоточена в базе данных, и таким образом можно 
всегда сравнивать варианты, модифицировать их, добавлять и изучать конструктивные 
изменения объекта. 

MSC.Patran имеет открытую архитектуру. Это позволяет обмениваться данными с 
различными программными продуктами, включая CAD-системы, конечно-элементные 
объектные коды других моделирующих программ, базы данных по характеристикам 
материалов. Базы данных и модели, созданные в одной программной системе, могут быть 
просто перенесены в MSC.Patran с минимальными затратами по времени и без потерь данных 
при конвертировании кодов. 

MSC.Patran воспринимает модели объектов, созданных в таких мощных CAE-системах как 
Unigraphics, CATIA, CAD-системах среднего и малого уровня: SolidWorks, SolidEdge, 
КОМПАС, T-flex, ARIES и др. Для системы MSC.Patran можно с помощью алгоритмического 
языка высокого уровня PCL (Patran Custom Language) составлять программы, предназначенные 
для решения специфических инженерных задач. 

Создание конечно-элементной модели конструкции в программе Patran состоит из 
нескольких этапов: 

1. Геометрическое моделирование; 
2. Задание характеристик материалов; 
3. Задание типов конечных элементов и их свойств; 
4. Создание конечно-элементной сетки; 
5. Задание граничных условий (закрепления и нагружения); 
6. Проверка корректности конечно-элементной модели. 
В данном пособии приводятся те сведения об интерфейсе пользователя, которые 

понадобятся для первоначального ознакомления и выполнения простых заданий по 
моделированию, расчетам, оптимизации и обработке и документированию результатов. 
 



2.1. Основные файлы 

Основные файлы, создающиеся при работе в среде моделирования, и о которых нужно знать 
рядовому пользователю, имеют следующие расширения: 
 *.db, создается программой Patran, хранит всю информацию о геометрии конкретной 

модели, свойствах используемых материалов, конечных элементов, нагрузок, условий 
опирания и т.д. Это база данных модели; 

 *.bdf, содержит входные данные для программы конечно-элементного расчета 
(решателя). Файл создается в процессе экспортирования модели из Patran для расчета в 
решатель Nastran; 

 *.f06, содержит информационные сообщения, сообщения об ошибках и некоторые 
результаты расчета в текстовом виде. Создается решателем Nastran; 

 *.op2, содержит результаты успешно выполненного задания на расчет, создается 
решателем Nastran, загружается в Patran для анализа, обработки и документирования 
результатов; 

 *.xdb содержит результаты расчета. В отличие от файла с расширением .op2 результаты 
расчета из файла с расширением .xdb не копируются в базу данных Patran-а. При 
просмотре результатов Patran производит чтение непосредственно из файла .xdb. Формат 
.xdb удобен, но он новый и не все алгоритмы системы Nastran адаптированы для работы 
с ним. 



2.2. База данных модели  

База данных модели Patran оперирует следующими объектами. 
Геометрические объекты: 
 Point (точка); 
 Curve (линия, кривая); 
 Surface (поверхность); 
 Solid (твердое тело); 
 Coord SyS (система координат); 
 Plane (плоскость); 
 Vector (вектор). 
Объекты конечно-элементной модели: 
 Node (узел); 
 Element (элемент); 
 Superelement (подконструкция); 
 Properties (свойства); 
 Material (материал); 
 Load Case (вариант нагрузок); 
 Field (поле). 
Объекты результатов: 
 Plots (графическое отображение результатов расчета или свойств модели) 
 Result Cases (результаты расчета) 
 Result Data (данные одного вида полученные в одном расчете) 
 Вспомогательные объекты: 
 Group (некоторая, выделенная в группу совокупность объектов). 
Все объекты имеют либо уникальные номера (ID), либо имена (Name). Узлы, элементы и 

геометрические объекты обозначаются номерами, а все остальные – именами. 
 



2.3. Окна 

Вид главного окна препроцессора MSC.Patran показан на рис. 2.3.1. 

 
Рис. 2.3.1. Главное окно и среда моделирования Patran 

В главном окне находятся главное меню (рис. 2.3.2), панель приложений (рис. 2.3.18), 
панели инструментов (рис. 2.3.12-2.3.17), одно или более графических окон для отображения 
модели и результатов расчетов, командная строка и окно сообщений. Окно сообщений 
расположено в нижней части экрана под графическим окном. Оно предназначено для вывода 
протокола действий пользователя, предупреждения об ошибках, вывод информации о 
разрабатываемой модели. 

На панели инструментов, как обычно, вынесены наиболее часто используемые команды. 
Интерфейс пользователя детально описан на английском языке в справочнике системы, 

доступ к которому осуществляется с помощью команды Help. 
 



 

 

2.3.1. Главное меню 

 
Рис. 2.3.2. Главное меню 

Главное меню предоставляет доступ к командам, традиционно располагаемым в главных 
меню окон приложений Windows, таким как работа с файлами, помощь и настройки видов 
приложения. Кроме того, в главное меню помещены некоторые команды, относящиеся к 
геометрическому и конечно-элементному моделированию не вошедшие в приложения. 

При загрузке MSC.Patran пользователю сначала доступен только пункт меню File. Для 
активизации остальных пунктов главного меню нужно открыть или создать базу данных 
задачи (модели), т.е. начать работать. 

Меню File (рис.2.3.3) содержит команды работы с файлами: создание новых (New), 
открытие существующих (Open), сохранение (Save), импорт, (Import), экспорт (Export), 
печать (Print) и другие действия, выход из текущей сессии (Quit). Сессия это процесс работы 
в системе MSC.Patran от ее запуска до закрытия. 

Меню Group (рис.2.3.4) содержит команды, предназначенные для создания групп 
объектов (из точек, кривых, поверхностей, твёрдых тел, узлов, элементов и др.) и работы с 
ними. Меню содержит команды работы с группами: создание группы (Create), модификация 
существующих (Modify), копирование (Copy), удаление, (Delete), объявление текущей группы 
(Set Current) и другие действия. Объединение отдельных объектов по различным признакам 
дает возможность отображать модель по частям, облегчает выбор объектов при выполнении 
команд. Кроме того, имя группы объектов является необходимым параметром для некоторых 
команд. Создаваемые объекты попадают в текущую группу (Current). В начале работы 
существует одна группа Default Group, куда попадают все объекты до тех пор, пока не будет 
создана и объявлена текущей другая группа. 

Меню Viewpor t (рис.2.3.5) содержит команды, предназначенные для управления 
отображением объектов модели, результатов расчетов и настройками графических окон. 
Каждое окно содержит один вид модели и группу параметров, определяющих ее вид. Меню 
содержит команды: создания вида (Create), модификации существующих (Modify), удаления 
(Delete) и определения списка отображаемых видов (Post). 

Меню Viewing (рис.2.3.6) содержит команды для управления размером и ориентацией 
модели в графическом окне. Можно вращать модель, изменять ее размер в процентах от вида 
(Zoom % of View), расположение, тип проекции, изменять масштаб (Scale Factors), задавать 
секущую плоскость (Clipping Plane), изменять точку расположения наблюдателя (Select 
Center, Select Corners), удалять и приближать модель и др. 

Меню Display (рис.2.3.7) содержит команды, которые помогают формировать и 
совершенствовать внешний вид элементов модели. С помощью этого меню можно назначить 
цвет объектов модели (Entity Color/Label/Render), определить, какие объекты модели нужно 
показывать (Geometry, Finite Elements, Load/BC) и как их показывать, управлять 
изображением c тенями (Shading) и положением источника освещения (Light Sources) и др. 

Меню Preferences (рис.2.3.8) содержит команды, с помощью которых можно выбрать 
параметры, которые должны управлять разработкой модели. Это меню определяет 
глобальные параметры, которые могут быть изменены для прикладной программы, 
работающей совместно с системой MSC.Patran (в нашем случае это MSC.Nastran). Например, 
можно изменить величину глобального допуска на представление линейных размеров модели 
(если расстояние между точками меньше этой величины, то они считаются совпадающими). 



 

 

Меню Tools (рис.2.3.9) содержит команды, которые исполняют специфические 
приложения. С помощью этих команд можно определить массу модели и ее элементов (Mass 
Properties), управлять моделированием формы и ориентации поперечных сечений балочных 
элементов (Beam Library) др. 

Меню Help (рис.2.3.10) позволяет обращаться к различным разделам справки. 
Меню Utilities (рис.2.3.11) позволяет запускать подпрограммы, созданные 

пользователями MSC.Patran. Если стандартные команды MSC.Patran не достаточно гибки для 
выполнения каких-либо действий, то, возможно, здесь есть подходящая команда. 

 



2.3.2. Панели инструментов 

 
Рис. 2.3.12. Панель инструментов. Системные функции 

На панели инструментов (рис. 2.3.12 – 2.3.17) в виде клавиш с иконками вынесены часто 
используемые функции из главного меню. Если ввести курсор мышки в поле клавиши и 
задержать его, загорится название команды, которое характеризует ее функцию. 

Панель инструментов, показанная на рис. 2.3.12, содержит следующие команды: 
 - File New – создание файла базы данных для новой задачи; 

 - File Open – открытие файла существующей базы данных; 
 - File Save – сохранение каких-либо изменений в текущей базе данных в процессе 

работы; 

 - Print – печать содержимого на экране окна (Viewport) или окна с x-y графиком; 

 - Copy to Clipboard – копирование содержимого вида в буфер обмена данных; 

 - клавиша Undo отменяет результат последнего нажатия клавиши Apply (исполнить). Эта 
клавиша запускает выполнение всех команд, изменяющих базу данных MSC.Patran; 

 - Abort – в течение выполнения сессии может возникнуть ситуация, когда на какой-либо 
операции происходит “зацикливание” или потребляется много времени процессора, на что 
указывает вращение значка с логотипом MSC.Software  в правом верхнем углу экрана. 
Можно отменить выполнение операции, если нажать клавишу Abort. При этом на экране 
появится сообщение “Do you wanted to abandon the operation in progress”, на которое нужно 
ответить “да”; 

 -Reset Graphics – удаление всех выделенных изображений, и деформированных форм. 
Восстанавливается вид в проволочном изображении Wireframe (видны все рёбра объекта). Эта 
клавиша работает на всех изображениях в режиме ввода элементов (в режиме построения), но 
только в текущем виде; 

 - Refresh Graphics – восстановление всех графических видов. 
Панель инструментов, показанная на рис. 2.3.13, содержит команды изменения режима 

динамического вращения модели на экране с помощью мышки. Команды работают, если при 
движении мышки нажать среднюю кнопку (при трёхкнопочном манипуляторе) или 
одновременно обе кнопки (при двухкнопочном). С помощью этих команд можно: 

• Mouse Rotate XY– вращать объекты вокруг осей X и Y системы координат, связанной с 
экраном, либо базовой системы координат (эти режимы переключаются с помощью 
команды главного меню Preferences>Mouse); 

• Mouse Rotate Z – вращать объекты вокруг оси Z; 
• Mouse Translate XY –перемещать объекты в направлении осей X и Y; 
• Mouse Zoom –отодвигать или приближать объекты на экране относительно пользователя, 

таким образом меняя размер изображения. 

 
Рис. 2.3.13. Панель инструментов с функциями мышки 

Панель инструментов, показанная на рис. 2.3.14, содержит команды изменения способов 
отображения объектов, управления масштабом и расположением модели в графическом окне: 



 - View Corners – увеличение фрагмента изображения модели путём заключения 
просматриваемой области в прямоугольную рамку; 

  - Fit View – заключение всех объектов отображаемых на виде в поле рамки экрана; 
  - View Center – перемещение модели путём указания нового центра вида; 
 - Rotation Center – позволяет выбирать центр динамического вращения (по умолчанию в 

центре вида); 
 -  Model Center – устанавливает центр вращения в центре показанной на виде части 

модели; 
  - Zoom Out –уменьшение масштаба изображения в два раза; 
  - Zoom In – увеличение масштаба изображения в два раза. 

 
Рис. 2.3.14. Панель инструментов.  

Управление масштабом и расположением модели в графическом окне 

Панель инструментов, показанная на рис. 2.3.15, содержит команды для установки 
различных стандартных видов изображения объектов в плоскостях и аксонометрических 
проекциях базовой системы координат. Назначение клавиш понятно из иконок, на которых 
изображены соответствующие положения осей координат. 

 
Рис. 2.3.15. Панель инструментов.  

Управление ориентацией модели в графическом окне 

Панель инструментов, показанная на рис.  2.3.16, содержит команды для установки 
следующих режимов изображения объектов: 

 - Wire Frame – изображение модели в прозрачном “проволочном виде”; 
 - Hidden Line – изображение модели с удалением невидимых линий; 
 - Smooth Shaded – изображение модели с “закрашенными” плоскостями (как твёрдое 

тело) и тенями от регулируемого источника освещения; 
 - Show Labels – вывод на экран всех номеров объектов; 
 - Hide Labels – удаление всех номеров объектов с экрана. 

 
Рис. 2.3.16. Панель инструментов.  

Выбор видов изображения модели в графическом окне 

Панель инструментов, показанная на рис. 2.3.17, содержит команды для установки 
следующих видов изображения объектов: 

 - Plot/Erase – отображение или не отображение объектов на экране; 
 - Label Control – вызов панели включения отображения номеров для разных типов 

объектов; 
 - Point Size –изменения размера изображения точек (от одного до девяти пиксел); 
 - Node Size –изменения размера изображения узлов (от одного до девяти пиксел); 
 - Display Lines – вкл./выкл. штриховки поверхностей. 



 
Рис. 2.3.17. Панель инструментов 



2.3.3. Панель приложений 
Панель приложений (рис.  2.3.18) включает в себя приложения, которые содержат 

совокупности команд, использующихся при разработке геометрической модели конструкции, 
конечно-элементной модели, создании нагрузок и закреплений, задании характеристик 
конструкционных материалов и свойств конечных элементов, при проведении расчетов и 
обработке их результатов. 

  
Рис. 2.3.18. Панель приложений 

Выбор нужных команд приложений в большинстве случаев построен по схеме: 
1) Action - выбор действия; 
2) Object - выбор объекта, над которым будет совершаться действие; 
3) Method или Type - выбор метода, способа как это будет делаться. 
Обозначение команд в данном пособии будем строить по такой же схеме - 

Action>Object>Method. 
Рассмотрим в общих чертах функции каждого приложения. Более подробно работа с ними 

будет описана на примере решения конкретных задач. 

Приложение  (Геометрия) содержит команды, создающие геометрические 
объекты. 

Каждая из команд имеет множество вариантов (рис.2.3.19). Использование некоторых из 
них будет пояснено в разделах пособия, где описывается геометрическое моделирование 
конструкций. 

Меню команд Action (выбор действия) содержит команды: сделать (Create); удалить 
(Delete); редактировать (Edit); показать (Show); перенумеровать (Renumber) и др. 

Меню команд  Object содержит команды выбора всех геометрических объектов. 
Меню команд Method содержит команды выбора метода: задание координат (XYZ); 

выдавливание (Extract); интерполяция (Interpolate); пересечение (Intersect); смещение (Offset); 
проекция (Project); и др. 

Приложение   (Конечно-элементная модель) содержит команды построения 
конечно-элементных сеток. 

Каждая из команд имеет множество вариантов (рис.2.3.20). Использование основных из 
них будет пояснено в разделах пособия, где описывается моделирование конструкций. 

Меню команд Action содержит команды: создать (Create); преобразить (Transform); 
выдавит ь (Sweep); перенумеровать (Renumber); удалить совпадающие узлы (Equvalence); 
показать (Show); модифицировать (Modify);  удалить (Delete) и др. 

Меню команд Object содержит пункты: размер элементов вдоль кривой (Mesh Seed); 
размер элементов на поверхности (Mesh Control); конечно-элементная сетка (Mesh); узел 
(Node); элемент (Element); кинематическая связь (MPC) и др. 

Приложение  (Граничные условия) содержит команды задания граничных 
условий - нагрузок и закреплений. 

Каждая из команд имеет множество вариантов (рис.2.3.21). Использование основных из 



них будет пояснено в разделах пособия, где описывается моделирование граничных условий. 
Меню команд Action содержит команды: создать (Create); модифицировать (Modify);  

удалить (Delete) и др. 
Меню команд Object содержит команды задания граничных условий в виде: перемещений 

(Displacement); сосредоточенных сил (Force); давления (Pressure); температуры 
(Temperature); перегрузок (Inertial Load); ускорений (Acceleration); скорости (Velocity); 
распределенной нагрузки (Distributed Load) и др. 

Меню команд Type содержит команды выбора типа граничных условий: узловые (Nodal); 
постоянные на элементе (Element Uniform); переменные на элементе (Element Variable). 

Использование наиболее часто употребляемых команд будет пояснено в разделах 
пособия, где описывается задание граничных условий в конструкции. 

Приложение   (Материалы) содержит команды задания характеристик самых 
разных конструкционных материалов (рис.2.3.22). 

Меню команд Action (выбор действия) содержит команды: сделать (Create); показать 
(Show); модифицировать (Modify); удалить (Delete). 

Меню команд Object содержит команды выбора типа материала: изотропный (Isotropic); 
ортотропный двухмерный (2dOrthotropic); ортотропный объемный (3dOrthotropic); 
анизотропный двухмерный (2dAnisotropic); анизотропный объемный (3dAnisotropic); 
композиционный (Composite). 

Меню команд Method содержит команды способа: задания характеристик материала: 
ручное (Manual Input); выбора из базы данных (Materials Selector) и др. 

Каждая из команд имеет множество вариантов. Использование некоторых из них будет 
пояснено в разделах пособия, где описывается задание конструкционных материалов. 

Приложение  (Свойства) содержит команды задания свойств конечных элементов 
(рис.2.3.23). 

Меню команд Action содержит команды: сделать (Create); модифицировать (Modify);  
удалить (Delete); показать (Show) и др. 

Меню команд Object содержит команды задания размерности конечного элемента: 
точечный (0D); одномерный (1D); двухмерный (2D); трехмерный (3D). 

Меню команд Type содержит команды выбора типа конечных элементов: 
сосредоточенная масса (Mass); балка (Beam); тонкая пластинка (Shell); объемный элемент 
(Solid) и др. 

Каждая из команд имеет множество вариантов. Использование некоторых из них будет 
пояснено в разделах пособия, где описывается задание свойств конечных элементов. 

Типы конечных элементов MSCNastran: 
Размерность конечного элемента - 0D: 
• Mass   сосредоточенная масса; 
• Grounded Spring упругий элемент, присоединенный к основанию; 
• Grounded Damper  демпфер, присоединенный к основанию. 
Размерность конечного элемента - 1D: 
• Beam   балка; 
• Rod   стержень; 
• Spring   пружина; 
• Gap   контакт. 
Размерность конечного элемента - 2D: 
• Shell   тонкая оболочка; 



• Bending Panel  тонкая изгибная оболочка; 
• 2D Solid  или осесимметричный элемент или элемент плоского 

деформированного состояния; 
• Membrane  мембранная оболочка; 
• Shear Panel  сдвиговая оболочка. 
Размерность конечного элемента - 3D: 
• Solid   объемный элемент. 
Краткие описания некоторых конечных элементов и наиболее распространенное 

применение их при моделировании конструкций приведены в разделе 3 и 4. 

Приложение  (Случаи нагружения) содержит команды формирования из 
отдельных граничных условий случаев нагружения для конкретного расчета (рис.2.3.24). 

Меню команд Action (выбор действия) содержит команды: сделать (Create); 
модифицировать (Modify); удалить (Delete); показать (Show). 

Приложение  (Поля) предназначено для создания функциональных зависимостей, 
на которые могут ссылаться команды других приложений, например, при задании 
переменного давления по оболочке (рис.2.3.25). 

Меню команд Action (выбор действия) содержит команды: сделать (Create); 
модифицировать (Modify); удалить (Delete); показать (Show). 

Меню команд Object содержит команды, позволяющие выбрать тип поля: 
пространственное (Spatial); свойства материалов (Material Property); непространственное 
поле (Non Spatial). 

Меню команд Method содержит команды способа задания полей: табличный ввод 
(Tabular Input), функциональная зависимость (PCL Expression) и др. 

Приложение  (Анализ) содержит команды запуска на расчет (рис.2.3.26). 
Меню команд Action (выбор действия) содержит команды: расчет (анализ) (Analyze); 

оптимизация (Optimize); считать результаты из файла .op2 (Read Output2); загрузить модель 
из файла задания на расчет (Read Input File); присоединить к базе данных результаты из 
файла .xdb (Attach XDB); удалить (Delete). 

Меню команд Object содержит команды: полная модель (Entire Model); текущая группа 
(Current Group) и др.  

Меню команд Method содержит команды: полный запуск (Full Run); проверка модели 
(Check Run); создать файл задания на расчет, но расчет не выполнять (Analysis Deck), и др. 

Приложение  (Результаты) содержит команды отображения результатов расчета 
(рис.2.3.27). 

Меню команд Action (выбор действия) содержит команды: сделать (Create); 
модифицировать (Modify); выбор списка выводимых на экран графических отображений 
результатов (Post); удалить (Delete). 

Меню команд Object содержит типы графических отображений результатов: быстрое 
отображение (Quick Plot); деформация (Deformation); цветовая заливка (Fringe); стрелки 
(Marker); графики (Graph); анимация (Animation); результаты в текстовом виде (Report), и др. 

Клавиши приложения, вызывающие окна получения и настройки видов отображения 
результатов на экране монитора: 

  -  Select Results - окно выбора результата расчета; 



 - Fringe Attributes - окно настройки способов отображения результатов заливкой 
разными спектрами цветов; 

  -  Deform Attributes - окно настройки отображения деформаций модели; 

  -  Animation Option - окно настройки анимации. 

Приложение  (Альтернативное отображение результатов) предоставляет 
дополнительные возможности по отображению результатов расчетов. 

Приложение   (Графики) содержит команды построения графиков. В этом пособии 
это приложение не используется. 

 



2.3.4. Дополнительные меню для выбора объектов 
Во многих случаях, когда вызываются разные приложения и команды, появляются 

дополнительные меню слева или справа от окна приложения. В системе MSC.Patran имеется 25 
различных вспомогательных меню для выбора элементов объектов (Select Menu). С помощью 
этих меню можно выбирать объекты прямо на экране, предварительно включив 
соответствующую клавишу меню. Таким образом, исключается необходимость вводить 
вручную идентификаторы (номера) этих объектов в соответствующие поля приложений. 

Например, если создаётся новая точка на геометрической модели, то появляется Point Select 
Menu, если необходимо выбрать конечные элементы, которые уже были сгенерированы, то 
появляется Element Select Menu. 

Каждое вспомогательное меню имеет серию клавиш с графическим изображением. При 
передвижении курсора по этим меню появляются подсказки с названиями команд. 

На вспомогательных меню доступны следующие команды: 
• Toggle Visible Entities Only Selection – выбор либо только видимых объектов, либо 

видимых и скрытых; 
• Polygon Pick – выбор всех объектов, которые лежат внутри многогранника (полигона). 

Для выбора полигона необходимо нажимать левую кнопку мыши в углах 
многоугольника на экране (при этом будет появляться линия), затем замкнуть полигон, 
совместив стрелку мыши с начальной точкой и щёлкнув левой кнопкой; 

• Any Point – выбрать точку, принадлежащую к какому-либо геометрическому объекту или 
конечному элементу; 

• Point – выбрать точку; 
• Node – выбрать узел; 
• Curve Intersect – выбрать точку пересечения двух кривых; 
• Point on Curve – выбрать точку на кривой; 
• Any Vertex – выбрать вершину элемента; 
• Pierce – выбрать точку, в которой кривая линия и поверхность пересекаются; 
• Point on Surface – выбрать точку на поверхности; 
• и др. 
Некоторые вспомогательные меню могут находиться на втором или третьем уровне Select 

Menu. Каждый уровень автоматически указывается на специальных иконках, изображающих 
иерархию расположения уровней. 

 – нажатие на эту клавишу указателем мыши позволяет возвратиться в предыдущее 
выбранное меню; 

 – нажатие на эту клавишу указателем мыши осуществляет возврат к корневому меню. 
 



3. Анализ, проектирование и оптимизация конструкций ракетнокосмической 
техники в среде MSC.Patran/MSC.Nastran  

Примеры решения задач, представленные в данной главе, предназначены для 
первоначального ознакомления с приемами моделирования и расчетами разных типов ракетно-
космических конструкций в среде программного продукта MSC.Patran/MSC.Nastran. Кроме 
того, эти задачи характерны для всех этапов конечно-элементного проектирования ракетно-
космических конструкций. При решении этих задач могут быть полезны издания [5, 6 ,7]. 

Пример решения задачи №1 “Моделирование и статический расчет пластинчатой 
конструкции с использованием MSC.Patran/MSC.Nastran” позволяет на простом примере 
освоить общую последовательность работы при моделировании и статическом расчете, 
знакомит с универсальным конечным элементом оболочки Shell. 

Пример решения задачи №2 “Моделирование и статический расчет объемных силовых 
элементов конструкции с использованием MSC.Patran/MSC.Nastran” служит для приобретения 
навыков моделирования объемных тел в препроцессоре Patran с помощью конечных элементов 
типа Solid. 

Пример решения задачи №3 “Моделирование ферменных и рамных силовых элементов 
конструкции с использованием MSC.Patran/MSC.Nastran и расчет на устойчивость” знакомит с 
моделированием ферменных и рамных конструкций балочными конечными элементами Beam, 
элементами сосредоточенной массы Mass и выполнением расчетов потери устойчивости 
конструкции в линейной постановке (Buckling). 

Пример решения задачи №4 “Моделирование и расчет конструкции стрингерного отсека 
ракеты-носителя в среде MSC.Patran/MSC.Nastran” знакомит с моделированием конструкции 
типового стрингерного отсека ракеты-носителя. В этой работе выполняются расчеты 
напряженно-деформированного состояния и потери устойчивости в линейной постановке. 

Пример решения задачи №5 “Проектирование конструкции углесотопластикового головного 
обтекателя ракеты-носителя в среде MSC.Patran/MSC.Nastran”. Целью данной работы является 
моделирование конструкции головного обтекателя ракеты-носителя с использованием 
слоистого конечного элемента типа Laminate, выполнение расчетов напряженно-
деформированного состояния, потери устойчивости конструкции в линейной постановке, 
частот и форм собственных колебаний. Выполняется подбор числа слоев однонаправленного 
углепластика в несущих слоях обтекателя по условиям прочности. 

Пример решения задачи №6 “Оптимизация распределения материала в оболочечных 
конструкциях около концентраторов напряжений в среде MSC.Patran/MSC.Nastran”. Целью 
работы является ознакомление с постановкой задач оптимизации. В работе определяется 
оптимальное распределение материала в оболочечной конструкции около отверстия или места 
приложения сосредоточенной нагрузки. 

Пример решения задачи №7 “Оптимизация ферменных и рамных конструкций в среде 
MSC.Patran/MSC.Nastran”. Цель работы получить как можно более легкую конструкцию 
фермы, отвечающую условиям прочности и жесткости, оптимизируя размеры поперечных 
сечений стержней фермы. 

 



3.1. Пример решения задачи №1 “Моделирование и статический расчет 
пластинчатой конструкции с использованием MSC.Patran/MCS.Nastran 

Главная цель при решении данной задачи - освоить общую последовательность действий 
при моделировании конструкции в MSC.Patran/MSC.Nastran. Поэтому в данной работе будет 
рассматриваться весьма простая конструкция – прямоугольная пластинка c отверстием. 



3.1.1. Описание конструкции 
Рассматриваемая конструкция представляет собой прямоугольную пластинку с 

отверстием из алюминиевого сплава размером a x b и толщиной t. С одной стороны 
пластинка заделана (рис. 3.1.1). К стороне, противоположной заделке, приложена сила Р, 
равномерно распределенная по стороне. Величины a, b, t и P для разных вариантов 
приведены в табл.3.1.1. 

Требуется рассчитать поведение данной конструкции, предположив, что перемещения 
точек конструкции малы (отсутствие геометрической нелинейности) и материал работает в 
пределах линейного участка диаграммы напряжения-деформации (отсутствие физической 
нелинейности). 

При таких допущениях можно исследовать поведение конструкции с помощью решателя 
Линейная статика. Данный решатель является наиболее простым из всех алгоритмов, 
реализованных в методе конечных элементов, и представляет собой решение системы 
линейных уравнений метода перемещений: 

[К]{u} = {P},           (1) 

где [К] - матрица жесткости; {P} - вектор узловых сил; {u} - вектор перемещений. 
Составление и решение этой системы уравнений рассматривается в курсах “Строительная 

механика” и “Прочность”. 
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Рис. 3.1.1 Рассматриваемая конструкция 

 



3.1.2. Конечный элемент тонкой изгибной оболочки типа Shell 
Для моделирования пластинки с отверстием используем конечный элемент Shell. 
Элемент Shell может воспринимать мембранную нагрузку, сдвиг в плоскости оболочки, 

поперечный сдвиг и изгиб. Этот элемент применяется для моделирования конструкций, 
состоящих из тонких пластин и оболочек. Более детально с элементом Shell можно 
познакомиться в разделе 4.3. 



3.1.3. Создание базы данных задачи 
Для того чтобы начать работу в системе MSC.Patran нужно открыть базу данных, в которой 

будет храниться вся информация о Вашей задаче. Для этого нужно выполнить команду 
главного меню File>New. В появившемся окне (рис. 3.1.2) требуется задать следующую 
информацию: 
• В поле “имя файла” набрать имя файла, в котором будет располагаться база данных Вашей 

задачи. Файл имеет расширение .db; 
• В поле “Папка”, если не установлено, набрать адрес файла (путь директории на диске), где 

будет помещен созданный файл; 
• Для исполнения команды – нажать клавишу ОК. 

 
Рис. 3.1.2. Окно создания базы данных задачи 



 

 

3.1.4. Геометрическое моделирование 
Геометрическая модель в современных конечно-элементных системах используется для 

автоматизации процесса создания модели. Это достигается благодаря тому, что в 
препроцессорах реализованы алгоритмы автоматического разбиения геометрических 
объектов (кривых, поверхностей, объемов) на конечные элементы. 

Геометрическая модель может быть импортирована в Patran из CAD-систем или сделана 
средствами самого препроцессора. В данном пособии геометрические модели будем 
создавать средствами Patran. 

Поскольку наша конструкция представляет собой тонкую пластинку, ее можно 
моделировать оболочечными элементами Shell. На оболочечные элементы в программе 
Patran легче всего можно разбить поверхности. Таким образом, геометрическая модель нашей 
конструкции будет представлять собой прямоугольную поверхность с отверстием. 

Программа Patran предоставляет пользователю много возможностей для создания 
поверхностей. Воспользуемся одним из подходящих в данном конкретном случае способов. 

1. Создадим четыре угловые точки и центр отверстия пластинки, для чего нужно войти в 

окно приложения Geometry, нажав клавишу , (рис.3.1.3) и вызвать окно 
команды Create>Point>XYZ. Нужная команда набирается в выпадающих меню опций 
Action, Object, Method. 

Эта команда реализует один из возможных способов задания точек - XYZ. В поле Point 
Coordinates List в квадратных скобках задаются координаты X, Y, Z точек, разделенные либо 
пробелами, либо запятыми. Номер создаваемой точки система предлагает в поле Point ID List. 
Создание каждой точки происходит после правильного ввода всех необходимых данных, 
если включена опция Auto Execute. В противном случае - после нажатия клавиши Apply. 
Создайте угловые точки пластины и точку центра отверстия. Можно вывести на экран их 
номера, нажав на клавишу Show labels панели инструментов. 

2. Геометрическую модель предлагается сделать в виде плоской поверхности, 
ограниченной кривыми. Для создания такой поверхности в системе Patran требуется создать 
кривые по внешним границам поверхности и по границам отверстия. После этого нужно 
объединить кривые по внешним границам и по границам отверстия в составные замкнутые 
контуры. Ссылаясь на эти контуры создать поверхность пластинки. Это можно сделать так: 

• Для создания линий внешнего контура в приложении  вызвать окно команды 
Create>Curve>Points (рис.3.1.4). В полях Starting point и Ending point указать 
начальную и конечную точку создаваемой линии. Выбор точек осуществляется либо с 
помощью мыши, либо ручным вводом с клавиатуры номера точки в поля Starting Point 
List и Ending Point List. Номер создаваемой кривой система сама предлагает в позиции 
Curve ID List. Выполнить команду, нажав клавишу Apply. 

• Для создания кривой внутреннего контура в приложении  вызвать окно 
команды Create>Curve>2DCircle. В поле Coordinate Plane List указать плоскость, в 
которой будет построена окружность. В примере на рис.3.1.5 плоскость определена 
3-й осью (Z) 0-ой (базовой) системы координат. Это означает, что окружность будет 
лежать в плоскости, перпендикулярной этой оси. В поле Input Radius укажите радиус 
окружности, а в поле Center Point List - точку в центре окружности. Выполнить 
команду, нажав клавишу Apply. 



 

 

• Для создания внешнего контура в приложении  выполнить команду 
Create>Curve>Chain (рис.3.1.6). В поле Curve List укажите кривые внешнего контура. 
Внутренний контур объединять не нужно, поскольку он и так состоит из одной 
кривой. Выполнить команду, нажав клавишу Apply. 

• Для создания поверхности в приложении  вызвать окно команды 
Create>Surface>Trimmed (рис.3.1.7). В поле Outer Loop List укажите кривую 
внешнего контура, а в поле Inner Loop List -  кривую внутреннего контура. 

В результате на экране появится поверхность, ограниченная кривыми с отверстием 
внутри. 

Для того чтобы посмотреть номера поверхности, кривых и точек, нажмите мышкой на 

клавишу  (Label Control) панели инструментов в правом верхнем углу экрана. В 
появившемся меню (рис. 3.1.8) щелкните по соответствующей клавише. 

 
Рис. 3.1.8. Панель визуализации идентификаторов объектов 

Клавиши панели означают следующее: 

 - показать идентификаторы всех объектов (All Labels); 

 - показать идентификаторы всех геометрических объектов(All Geometry); 

 - показать идентификаторы всех объектов конечно-элементной модели (All Fem); 

 - показать идентификаторы точек (Point); 

 - показать идентификаторы кривых (Curve); 

 - показать идентификаторы поверхностей (Surface); 

 - показать идентификаторы солидов (Solid); 

 - показать идентификаторы узлов (Node); 

 - показать идентификаторы элементов (Element). 
 



 

 

3.1.4. Задание характеристик конструкционных материалов и свойств элементов 

Характеристики материалов задаются в окне приложения , (рис.3.1.9). 
В этом окне для задания изотропного материала пластинки выберем команду 

Create>Isotropic>Manual Input. В поле Material Name нужно задать имя материала. 
Нажатием клавиши Input Properties вызвать окно задания характеристик материалов 
(рис.3.1.10) 

В этом окне можно задать упругие характеристики материала, коэффициенты теплового 
расширения и теплопроводности, а также плотность, демпфирование и многое другое. Для 
линейного статического расчета в опции Constitutive Model нужно выбрать линейно-упругий 
тип материала Linear Elastic. Далее задать модуль упругости (Elastic Modulus), коэффициент 
Пуассона (Poisson Ratio). В позиции Density можно задать плотность материала. В окне 
(рис.3.1.10) после ввода данных не забудьте нажать ОК, а в окне создания материалов - 
Apply. 

Следующим шагом создания конечно-элементной модели является задание свойств 
конечных элементов (Property), где вводятся главным образом геометрические 
характеристики элементов и область применения свойства. Свойства каждого типа элементов 
содержат свой набор характеристик (см. главу 4). Так, геометрия оболочечных элементов 
Shell характеризуется толщиной оболочки, а балочных элементов Beam - площадью 
поперечного сечения, моментами инерции поперечного сечения и т.д. 

Нажатием клавиши  вызовем окно приложения Proper ty (рис.3.1.11) и вызовем 
команду Create>2D>Shell. В поле Property Set Name нужно задать имя создаваемого 
свойства. 

При нажатии клавиши Input Properties появляется окно задания значений свойств 
элементов (рис.3.1.12). Для элементов тонкой изгибной оболочки задаются материал (поле 
Material name) и толщина оболочки (поле Thickness). Остальные поля в этой работе задавать 
не нужно. Выполните команду - ОК. 

В поле Select members окна создания свойств элемента (рис.3.1.11) нужно задать область 
применения этих свойств. Поместите курсор в это поле, и затем укажите курсором мышки на 
поверхность пластинки. Выполните команду - Apply. 

 



3.1.6. Создание конечно-элементной сетки 
Размер конечного элемента в этой задаче рекомендуется выбрать такой, чтобы каждая 

сторона поверхности была разбита не менее чем на 10 элементов. Данная рекомендация 
основана на двух соображениях. Во-первых, большее количество элементов не даст 
существенного увеличения точности в данной задаче. Во-вторых, брать меньшее количество 
элементов нецелесообразно, так как в такой маленькой задаче экономить не имеет смысла. 

Для создания конечных элементов на поверхности необходимо выполнить следующие 
действия. 

1) Указать размер элементов. Войти в приложение Elements, нажав клавишу . 
Вызвать окно команды Create>Mesh Seed>Uniform (рис.3.1.13). Здесь можно задать 
либо число элементов вдоль кривой (опция Number of elements) либо размер элементов 
(опция Element length). Указав один из этих параметров, в поле Curve list следует 
указать (выбрать мышкой) к какой кривой (Curve) это относится. Выполнить команду - 
Apply. Таким образом назначить размеры элементов для всех кривых поверхности 
пластинки. 

1. Разбить на конечные элементы поверхность пластинки. Это можно сделать в 
приложении Elements с помощью команды Create>Mesh>Sur face (рис.3.1.14) 
следующим образом: 
• Щелкнув мышкой в поле Select Surface ввести идентификатор поверхности 

пластинки - или набрать номер поверхности или указав ее мышкой на экране; 
• Установить опцию Elem Shape в положение Quad, так как разбивать пластинку 

будем на четырехугольные элементы; 
• Установить опцию Mesher в положение Paver. Этот алгоритм разбиения способен 

создать сетку на поверхностях любой сложности. Алгоритм IsoMesh может 
разбивать только топологически четырехугольные или треугольные области; 

• Установить опцию Topology в положение Quad4, так как элементы будут 
четырехузловыми. В полях Node и Element система показывает, с какого значения 
она начнет нумеровать новые узлы и элементы при выполнении этой команды; 

• Размер элемента внутри поверхности определяется параметром Global Edge Length. 
Для этой задачи рекомендуется отключить автоматическое вычисление значения 
этого параметра (опция Automatic Calculation) и задать это значение в поле Value 
примерно равным размеру элементов вдоль границ; 

• Перед выполнением команды (нажатие клавиши Apply) рекомендуется сохранять 
модель, потому что в случае неправильного указания размера конечного элемента, 
элементов на поверхности может оказаться слишком много и компьютер повиснет. 
Сохранение модели осуществляется командой File>Save главного меню. 

В результате выполнения команды на экране появится КЭ-модель. Примерный вид 
модели пластинки приведен на рис. 3.1.15. 



 
Рис. 3.1.15. Конечно-элементная модель пластинки с отверстием 

Для разных размеров элементов по границам и внутри поверхности получаются разные 
конечно-элементные сетки. Наиболее точные результаты будут получаться, если все 
оболочечные конечные элементы по форме будут близки к квадратной. Меняя размеры 
элементов вдоль границ и внутри поверхности, постарайтесь добиться, чтобы конечные 
элементы по возможности имели правильную форму (отношение длины к ширине элемента 
меньше 2, отклонение углов от прямого угла не более 30°). 



3.1.7. Задание граничных условий 
Граничные условия по физическому воздействию разделяются: 
 на силы и моменты в виде сосредоточенных и распределенных по длине и площади 

нагрузок; 
 заданные перемещения; 
 кинематические воздействия - ускорения, скорости и перемещения; 
 тепловые воздействия в виде температуры и теплового потока. 

По способу приложения к объектам модели нагрузки классифицируются как: 
 объемные; 
 узловые; 
 элементные. 

Расчет может проводиться для сложного сочетания граничных условий. 
Граничные условия в системе MSC.Nastran можно разделить на нагрузки и закрепления. 

Нагрузки преобразуются в компоненты вектора узловых сил (вектор Р в уравнении (1)), а 
закрепления являются дополнительным уравнением, исключающим закрепляемые степени 
свободы из расчета. Например, перемещение по какой либо степени свободы приравнивается 
нулю. К закреплениям относятся заданные перемещения, заданные поля температур в задаче 
теплопроводности и др. Нагрузки могут задаваться в любой удобной системе координат, а 
закрепления - только в системе координат узлов модели, оси которой совпадают со 
степенями свободы узлов в расчете. В связи с этим мы будем разделять граничные условия на 
закрепления и нагрузки, хотя в системе MSC.Patran они и задаются одним приложением. 

Граничные условия задаются в приложении Loads/BCs (клавиша ). Создадим 
закрепления вдоль одной стороны пластинки с помощью команды 
Create>Displacement>Nodal (рис.3.1.16): 

• в поле New Set Name задайте имя закрепления; 
• клавишей Input Data вызовите окно задания величины заданных перемещений 

(рис.3.1.17). В поле Translations следует ввести вектор поступательных 
перемещений, состоящий из трех компонентов, разделенных пробелами или 
запятыми и объединенных в угловые скобки. В поле Rotations следует ввести 
вектор поворотов в том же формате. Заделке соответствует закрепление по всем 
степеням свободы и в этом случае оба вектора, определяющие заданные 
перемещения, примут вид “< 0, 0, 0 >”. Если нужно задать перемещения не по всем 
степеням свободы узлов, то значение перемещения по незакрепляемым степеням 
свободы нужно пропустить (например, < 0,  , 0 >). Вернитесь в окно приложения 
Loads/BCs, нажав клавишу ОК; 

• клавишей Application Region вызовите окно задания области применения 
граничного условия (рис.3.1.18). В нашем случае мы должны задать перемещения 
для узлов, лежащих на одной из граней поверхности пластинки. Это можно сделать 
либо выбрав опцию Geometry и указав в поле Select Geometry Entities грань 
поверхности, либо выбрав опцию FEM (английская аббревиатура от “конечно-
элементная модель”) и указав в поле Select Nodes узлы, лежащие на грани 
поверхности. Выполнить команду, нажав клавишу Apply. 

Приложим к нашей конструкции действующую силу. Поскольку сила распределена по 
стороне пластинки, то ее необходимо распределить между узлами, лежащими на данной 
стороне. Для того чтобы сила распределилась равномерно, в каждый узел на стороне надо 
приложить долю силы, равную P/nэлем, где nэлем - число элементов вдоль стороны. В угловые 



же узлы должны быть приложены силы P/(2nэлем). 
Зададим силу вдоль стороны пластинки, противоположной закрепленной, с помощью 

команды Create>Force>Nodal, (рис.3.1.19). Это делается подобно заданию заданных 
перемещений. Только вместо векторов перемещений задаются векторы сил. 

Совокупность граничных условий, описывающих условия функционирования 
конструкции в какой-либо ситуации, называются случаем нагружения. Все созданные 
граничные условия помещаются в случай нагружения с именем Default (по умолчанию). На 
практике часто приходится исследовать поведение конструкции для нескольких случаев 
нагружения, каждый из которых характеризуется своими нагрузками и своими 
закреплениями. Для того чтобы не создавать для каждого случая нагружения модель со 
своими закреплениями и нагрузками модель может содержать несколько случаев нагружения. 
Посмотреть состав этого случая нагружения или создать другие случаи нагружения можно с 
помощью приложения  

Load Cases (клавиша ). 
 



3.1.8. Запуск на расчет 
Запуск на расчет выполняется в окне приложения Analysis (рис. 3.1.20), которое 

открывается нажатием клавиши , командой Analyze>Entire Model>Full Run.  

 
Рис. 3.1.20. Окно команды Analyze>Entire Model>Full Run приложения Analysis 

Вид анализа выбирается с помощью клавиши Solution type (рис. 3.1.21).  



 
Рис. 3.1.21. Окно выбора вида анализа 

При решении этой задачи мы считаем, что в материале нет пластических деформаций, 
перемещения точек конструкции малы и существенно не изменяют геометрию конструкции. 
Нагрузка не меняется во времени. Такой ситуации соответствует вид анализа Linear Static 
(линейная статика). Клавиша Subcases позволяет настроить расчетный случай (выбор случая 
нагружения, набора выдаваемых результатов и др.), а клавиша Select Subcases позволяет 
выбрать расчетный случай (случаи) для расчета. Для случая нагружения Default расчетный 
случай настраивается и выбирается по умолчанию. Остальные клавиши дают доступ к 
различным опциям, в которых здесь нет необходимости разбираться, поскольку их значения по 
умолчанию подходят в нашем случае. 

После нажатия клавиши Apply происходит следующее: 
• Patran генерирует файл задания на расчет для системы конечно-элементного анализа 

MSC.Nastran; 
• Система MSC.Nastran запускается и выполняет расчет в соответствии с заданием на 

расчет. В результате расчета создается файл (в нашем случае с расширением .xdb), 
содержащий результаты расчета. 

Для того чтобы посмотреть результаты в системе Patran, нужно присоединить файл 
результатов к базе данных Patran-а. Это можно сделать с помощью команды 
Access Result Data>Attach XDB>Result Entities. Здесь нужно указать файл с результатами с 
помощью клавиши Select Result File и нажать клавишу Apply. 

 



 

 

3.1.9. Просмотр результатов расчета 
В результате расчета конструкции MSC.Nastran получает различную информацию, 

характеризующую поведение конструкции. Эта информация, полученная для одного случая 
нагружения, объединяется в один Result Case (множество, совокупность результатов расчета). 
Result Case содержит разные виды результатов (например, перемещения всех точек 
конструкции - один вид результатов, эквивалентные напряжения во всех элементах - другой). 

Виды результатов могут быть скалярными и векторными: содержащие скалярную 
информацию и трехмерные векторы. Скалярные виды результатов обычно отображают 
заливкой цветом. Векторные виды результатов обычно отображают в виде деформаций или 
маркеров. 

Некоторые виды результатов приведены в табл.3.1.2. 

Просмотр результатов осуществляется с помощью приложения Results (клавиша ). 
В этой задаче мы используем команду Create>Quick Plot. Эта команда позволяет отобразить 
одновременно два вида результатов: один в виде перемещений узлов конечно-элементной 
модели, а другой в виде заливки конечно-элементной модели цветом, соответствующим 
значению отображаемой величины. 

Четыре клавиши в верхней части окна приложения Results для команды Create>Quick 
Plot открывают разные окна этого приложения. 

Окно с нажатой клавишей  (Select Result), (рис.3.1.22) служит для выбора результатов 
для отображения. В поле Select Result Cases нужно выбрать результат расчета. В поле Select 
Fringe Result нужно выбрать вид результата для отображения в виде заливки (обычно это 
напряжения, деформации или другие скалярные данные). Если здесь выбрать тензор 
напряжений, то ниже этого поля появится опция Quantity, с помощью которой можно 
выбрать отображаемый компонент тензора напряжений. Если выбрать другой тензорный или 
векторный результат, то эта опция позволит выбрать один из компонентов этого вектора или 
тензора для отображения в виде заливки. В поле Select Deformation Result нужно выбрать 
результат для отображения в виде перемещений узлов (обычно это перемещения или другие 
векторные данные). После нажатия клавиши Apply в графическом окне появится 
деформированная конечно-элементная модель, покрытая заливкой 

Клавиша  (Fringe Attributes) открывает окно настройки заливки (рис.3.1.23). Здесь 
пользуясь опциями Spectrum и Range можно изменить палитру заливки, пользуясь опциями 
Style и Shading стиль заливки, вывести на экран название результата и его максимальное и 
минимальное значение (Show MaxMin label)и др. 

Клавиша  (Deform Attributes) открывает окно настройки отображения деформации 
модели (рис.3.1.24). В этом окне можно выбрать цвет и толщину линий отображения 
деформированного и недеформированного состояния модели, применить способ 
отображения деформированной модели: 

• прозрачной сеткой (Wireframe); 
• с удалением невидимых линий (Hidden Line); 
• с заливкой граней элементов и с затенением (Shaded). 

Задать масштаб деформаций модели можно в поле Scale Factor. Интерпретация этого 
масштаба зависит от опции Scale Interpretation. Если включена опция Modal Scale, то 
величина, введенная в поле Scale Factor, будет интерпретироваться как величина 



 

 

максимальной деформации в процентах от характерного размера модели. Значение масштаба 
1 в этом случае означает, что максимальное перемещение будет равно максимальному 
размеру модели. Если включена опция True Scale, то величина, введенная в пункте Scale 
Factor, действительно является масштабом деформаций. 

Попробуйте разные способы отображения результатов. 

Клавиша  (Animation Attributes) открывает окно настройки отображения деформаций 
способом анимации (рис.3.1.25). Попробуйте самостоятельно разобраться, как получить 
изображение деформаций в движении и настроить изображение. 

Примеры отображения результатов приведены на рис. 3.1.26 и на рис. 3.1.27. 

 
Рис. 3.1.26. Деформированное состояние конструкции 

 
Рис. 3.1.27. Эквивалентные напряжения по Мизесу (4-я теория прочности) 

 в верхнем слое оболочечных элементов 
 

Чтобы получить представление о работе конструкции, обязательно выведите на экран и 



 

 

рассмотрите следующие основные результаты расчетов (табл.3.1.2): 
• Деформации конструкции. Особое внимание обратите на максимальный прогиб, 

значение которого выводится в левом нижнем углу экрана при отображении 
деформаций; 

• Эквивалентные напряжения по Мизесу (4 теория прочности); 
• Силы в закреплениях; 
• Нормальные напряжения - Stress Tensor>X Component, Stress Tensor>Y Component; 
• Касательные напряжения - Stress Tensor>XY Component; 
• И другие результаты по желанию. 
 



3.1.10. Анализ результатов 
Как Вы могли заметить, моделирование даже такой простой конструкции, как пластинка, 

рассмотренная в данном примере, требует от инженера определения многих величин, 
характеризующих материалы, геометрию конструкции, граничные условия. При задании 
каждой из этих характеристик Вы могли ошибиться. Еще более остро данная проблема встает 
при моделировании сложных технических объектов, таких как летательный аппарат, где 
приходится отображать в модели все сколько-нибудь значительные особенности конструкции, 
и при описании каждой из этих особенностей возможна ошибка. Поэтому, получив результаты 
расчета, Вы ни в коем случае не должны считать, что работа закончена, и полученный 
результат можно передавать Заказчику. Полученные результаты необходимо проанализировать. 

Самым распространенным приемом, используемым для проверки моделирования, является 
качественный анализ результатов. Инженер рассматривает рассчитанное поведение 
конструкции и пытается его для себя объяснить. Если поведение конструкции кажется ему 
правдоподобным, то он считает модель адекватной. Естественно, чтобы использовать данный 
способ проверки, инженер должен быть очень опытным. 

Гораздо более надежный способ проверки – рассмотреть поведение модели при случае 
нагружения, для которого решение может быть предсказано аналитически (хотя бы 
приблизительно). Такой случай нагружения может быть как одним из расчетных случаев 
нагружения, так и специально создаваться для проверки модели. 

Ошибка моделирования может проявляться и только при определенных особенностях 
нагружения конструкции. Поэтому, проверив результаты для одного случая нагружения, нельзя 
успокаиваться и принимать результаты для остальных случаев нагружения на веру. Анализу 
должно подвергаться поведение конструкции при всех случаях нагружения. 

Существует множество приемов проверки модели, многие из которых поддерживаются 
возможностями MSC.Nastran и будут рассмотрены в дальнейшем. 

Проверку нашей модели можно провести, рассмотрев нашу пластинку как консольную 
балку, нагруженную на конце перерезывающей силой (рис. 3.1.28). 

 
Рис. 3.1.28. Изгиб балки 

По балочной теории приближенно прогиб на конце пластинки можно оценить с помощью 
следующего соотношения: 
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где J – момент инерции сечения (для прямоугольного сечения J = b3t/12);  E – модуль 
упругости;  
G = E/2(1+µ) – модуль сдвига; µ – коэффициент Пуассона; αсд – коэффициент сдвига, а 
остальные обозначения видны на рис. 3.1.28. Для прямоугольного поперечного сечения αсд = 
3/2. 

Сравните вычисленный Вами прогиб с полученным в расчете. 
 



3.1.11. Контрольные вопросы 
Решив задачу №1, Вы должны были получить начальное представление о моделировании и 

анализе конструкций в системе MSC.Nastran. Для проверки знаний Вам предлагается ответить 
на следующие вопросы: 

1. Назовите основные этапы расчета конструкций в системе MSC.Nastran. 
2. Назовите основные этапы создания конечно-элементной модели в препроцессоре Patran. 
3. Какие конструкции моделируются универсальным оболочечным элементом Shell? 
4. Зачем нужна геометрическая модель? 
5. Какие приложения программы Patran использовались при решении задачи? 
6. Как посмотреть номера (идентификаторы) объектов? 
7. Какие характеристики определяются для материалов? 
8. Что такое свойство элементов? 
9. Граничные условия, виды граничных условий. 
10. Почему при приложении распределенной нагрузки в угловые узлы пластинки 

прикладывались силы вдвое меньшие, чем в остальные узлы, лежащие на стороне 
пластинки? 

11. В каких случаях корректно использовать для расчета напряжений и деформаций 
алгоритм линейной статики? 

12. Что необходимо указать при запуске линейного статического расчета? 
13. Какие результаты MSC.Nastran выдает для оболочечных элементов? 
14. Особенности задания масштаба отображения деформаций. 
15. Объясните распределение нормальных и касательных напряжений по конструкции. 
16. Объясните, почему вблизи заделки напряжения повышены? 
17. Как удостовериться в правильности полученных результатов конечно-элементного 

расчета? 
 



3.2. Пример решения задачи №2 “Моделирование и статический расчет 
объемных силовых элементов конструкции с использованием 
MSC.Patran/MSC.Nastran” 

Целью решения данной задачи является приобретение навыков моделирования объемных 
тел в препроцессоре Patran с помощью объемных конечных элементов типа Solid на примере 
моделирования и расчета конструкции кронштейна. Будет уделено внимание возможностям 
визуализации модели и результатов. 



3.2.1. Объемный элемент типа Solid 
Библиотека конечных элементов MSC.Nastran содержит шесть видов объемных конечных 

элементов (см. раздел 4.5 и рис. 3.2.1): 
• линейный тетраэдальный элемент (4 - узловой); 
• линейный призматический элемент (6 - узловой); 
• линейный гексагональный элемент (8 - узловой); 
• параболический тетраэдальный элемент (8 - узловой); 
• параболический призматический элемент (12 - узловой); 
• параболический гексагональный элемент (16 - узловой). 

 
Рис. 3.2.1. Объемные элементы в MSC.Nastran 

У линейных элементов на одну кромку приходится два узла (через две точки можно 
провести прямую линию), а у параболических - по три узла (через три точки можно провести 
параболу). Поскольку линейные элементы содержат меньше узлов, построенные на их основе 
модели содержат меньше степеней свободы и, следовательно, более экономичны. Однако 
четырехузловой тетраэдр обычно завышает жесткость конструкции. Чтобы избежать этого, 
нужно либо измельчать конечно-элементную сетку, либо применять параболический тетраэдр. 
Опыт показывает, что второй способ более экономичен, так как требуемая точность расчета 
достигается при меньшем количестве узлов конечно-элементной сетки. Таким образом, обычно 
рекомендуется использовать линейные призматические и гексагональные элементы и 
параболический тетраэдальный элемент. 

 



3.2.2. Геометрическое моделирование объемных тел 
Моделирование объемных тел в MSC.Patran осуществляется с помощью Solid-ов. Solid-ы 

представляют собой объединение поверхностей, образующих замкнутый объем. Patran 
рассматривает их как объемное тело и позволяет разбить это тело на объемные конечные 
элементы. 

Объемные конечные элементы в Patran также называются Solid-ами, но не надо путать их с 
геометрическими солидами. 

Создать Solid-ы в системе Patran можно многими способами, используя команды 

приложения  : 
 выдавливание из поверхности вдоль какого-либо вектора на заданную длину – команда 

Create>Solid>Extrude; 
 создание тела вращением поверхности вокруг заданной оси на заданный угол – команда 

Create>Solid>Revolve; 
 создание геометрических примитивов, а именно, прямоугольного параллелепипеда, конуса, 

сферы и цилиндра – команда Create>Solid>Primitives; 
 создание Solid-а по координатам его вершин - команда Create >Solid>Vertex. 
 и др. 

Solid-ы могут быть разбиты на составляющие их поверхности – команда 
Edit>Solid>Disassemble, у них могут быть срезаны фаски – команда Edit>Solid>Edge Blend, 
они могут быть рассечены плоскостями – команда Edit>Solid>Break. 

Несколько Solid-ов могут быть объединены в один – команда Edit>Solid>Boolean, клавиша 

Add . 
Из одного Solid-а можно вычесть несколько Solid-ов – команда Edit>Solid>Boolean, 

клавиша Subtract . 
Может быть создан Solid, являющийся пересечением двух Solid-ов – команда 

Edit>Solid>Boolean, клавиша Intersect  и другие возможности. 



3.2.3. Конструкция кронштейна 
В данной задаче рассматривается конструкция кронштейна (рис. 3.2.2,3.2.3). Кронштейн 

присоединяется к остальной конструкции четырьмя крепежными элементами, 
расположенными по углам основания кронштейна и нагружается силой, приложенной к 
нижней стороне отверстия проушины. Конструкция изготовлена из сплава АМГ-6 (модуль 
упругости - 70000 МПа, коэффициент Пуассона - 0.3, плотность - 2700кг/м3 и предел 
текучести - 160 МПа). 

Варианты размеров конструкции и нагрузок приведены в табл.3.2.1. 
Рекомендуется при задании данных использовать следующую систему единиц: силы в [Н], 

размеры в [мм], напряжения и давления в [МПа], а массу в [т]. 

 
Рис. 3.2.2. Конструкция кронштейна 



 
Рис. 3.2.3. Нагрузки и закрепления для кронштейна 



3.2.4. Геометрическое моделирование кронштейна 
Препроцессор MSC.Patran предоставляет широкий набор приемов моделирования 

объемных тел и предлагаемый здесь способ создания геометрической модели кронштейна 
является одним из многих возможных способов. 

Кронштейн состоит из трех плит с толщинами S1, S2 и S3 (рис. 3.2.4). 
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Рис. 3.2.4. Поверхности для выдавливания Solid-ов 

Solid-ы, соответствующие этим плитам, можно сформировать с помощью выдавливания 
их из поверхностей. Затем, объединив три сформированных Solid-а в один, получим 
геометрическую модель кронштейна. Таким образом, необходимо построить три 
поверхности, из которых можно было бы выдавить вышеупомянутые Solid-ы. Эти 
поверхности будем строить совпадающими с верхней или нижней поверхностями плит. 

Геометрическое моделирования кронштейна начнем с активации приложения Geometry, 

нажав кнопку  панели приложений. 
Построим поверхность для основания кронштейна (рис. 3.2.4, поверхность 1) по четырем 

угловым точкам - команда Create>Surface>Ver tex. При выполнении этой команды в полях 
Surface Vertex 1-4 List следует указать четыре угла поверхности, задав их координаты в 
квадратных скобках. Вместо координат точек можно указать на созданные ранее точки. В 
поле Surface ID List обозначен номер (идентификатор) создаваемой поверхности. 

После исполнения команды (нажать клавишу Apply) на экране появится поверхность. 

Если Вы ошиблись, можно отменить команду, нажав клавишу  на панели инструментов и, 
исправив данные, повторить команду, нажав клавишу Apply. 



При выборе геометрических объектов удобно пользоваться панелью визуализации 
идентификаторов объектов, а также панелями инструментов, позволяющими назвать тип 
выбираемого объекта, например, точки - клавиша Point , узлы - клавиша Node , кривые - 
клавиша Curve , поверхности - клавиша Surface  , грани Solid-а - клавиша Solid Face  
и многих других. Эти панели инструментов появляются рядом с окнами команд в 
зависимости от того, какими объектами эта команда будет оперировать. 

Построим поверхность для кольцевой части проушины кронштейна (рис. 3.2.4, 
поверхность 3). Для этого проведем две окружности радиусом R2, воспользовавшись, 
например, командой Create>Curve>2D Circle. При выполнении этой команды в секции 
Circle Radius следует ввести значение радиуса окружности, в поле Construction Plane List 
следует указать вектор, перпендикулярный к плоскости, в которой будет лежать окружность 
(ссылка на ось системы координат Coord 0.1 - ось Х 0-ой (базовой) системы координат). В 
поле Center Point List указать координаты точки центра окружности. Для удобства работы 
можно изменить проекцию изображения геометрической модели на экране, нажав одну из 
клавиш панели инструментов, управляющих ориентацией модели в графическом окне. 

Теперь создадим круглую поверхность, ограниченную окружностью радиусом R2, с 
помощью команды Create>Surface>Trimmed. В списке Option этой команды следует 
выбрать пункт Planar. В поле Outer Loop List следует указать окружность для внешнего 
контура поверхности, а поле Inner Loop List - оставить пустым. На вопрос системы “Удалить 
ли оригинальные кривые, по которым создается поверхность” можно ответить “нет”, так как 
они могут понадобиться для дальнейших построений. 

Построим поверхность для остальной части кронштейна (рис. 3.2.4, поверхность 2). 
Сначала построим две точки для проведения линии, по которой пересекаются срединная 
поверхность проушины и граница основания - точки А и В (рис. 3.2.4), используя команду 
Create>Point>XYZ. Координаты точек А и В легко найти из чертежа. Затем построим и саму 
линию, выполнив команду Create>Curve>Points. Точки можно выбирать мышкой или 
указывать их идентификаторы. Далее построим линию, проходящую через точку А и 
направленную по касательной к внешней окружности кольца - команда 
Create>Curve>TanPoint. В появившемся окне следует сделать: 

• отключить опцию Auto Execute; 

• установить клавишу  в положение All Tangents, чтобы построить все 
касательные; 

• в поле Point List мышкой выбрать точку, из которой будет проведена касательная, а в 
поле Curve List выбрать окружность, которой линия будет касаться. 

Аналогичным способом провести касательную линию из точки В. 
Если опция Trim Original Curve включена, то оригинальные кривые в месте 

соприкосновения с касательной кривой будут обрезаны. 
Лишние геометрические объекты, в частности кривые, можно удалить командой 

Delete>Curve, указав в поле Curve List удаляемую кривую. 
Теперь нужно замкнуть контур поверхности 2, проведя линию через точки С и D с 

помощью команды Create>Curve>Points. Созданные кривые объединим в один контур 
командой Create>Curve>Chain. При выполнении этой команды в поле Curve List следует 
указать все кривые, образующие границу будущей поверхности 2. В опции Option нужно 
выбрать Planar. При выборе кривых мышкой, кроме первой в списке, нужно держать на 
клавиатуре нажатой кнопку SCHIFT. 

Наконец создадим поверхность 2 командой Create>Surface>Trimmed. На этот раз 



следует указать только одну кривую контура границы поверхности 2. 
Создадим объемные тела, используя команду выдавливания из поверхностей - 

Create>Solid>Extrude. В поле Translation Vector нужно указать вектор, вдоль которого и на 
длину которого будет выполняться выдавливание. В поле Surface List нужно указать 
поверхность, которая будет выдавливаться. Таким образом, выдавите объемные тела из всех 
трех поверхностей на соответствующие толщины. Объемные тела стенки и проушины 
кронштейна необходимо сместить к срединной поверхности. Это можно сделать командой 
Transform>Solid>Translate. При выполнении этой команды требуется в поле Translation 
Vector указать вектор, на который будет смещено объемное тело, а в поле Solid List указать 
перемещаемое тело. Включить опцию Delete Original Solid, чтобы был удален исходный 
Solid. 

При выполнении многих операций для получения изображения модели на экране, 
соответствующего последней выполненной команде нужно изображение перерисовывать, 

пользуясь клавишей  или  панели инструментов. 
Все ненужные геометрические объекты, появившиеся при моделировании, целесообразно 

удалить командой Delete, выбрав нужные объекты для удаления. 
Теперь объединим три объемных тела в одно командой Edit>Solid>Boolean (рис.3.2.5). 

В поле команды следует нажать клавишу объединения Add  и указать в поле Solid 
List список тел для объединения. В списке для объединения нужно указывать по два объекта. 
В результате должен получиться для всего кронштейна один Solid, который весь целиком 
меняет цвет при подведении к нему курсора. 

Углы основания нашего кронштейна должны быть скруглены. Это можно сделать 
командой Edit>Solid>Edge Blend (рис.3.2.6). 

При выполнении этой команды следует выбрать опцию, соответствующую округлению 

граней (клавиша Constant Radius ), и опцию скругления одной кромки (клавиша Edge(s) 

of Solid ). В поле Constant Radius введите значение радиуса скругления. В поле Solid Edge 
List укажите грани для скругления. При подведении мышки к конкретной грани появляется 
список прилегающих кромок прилегающих граней Solid-а (рис.3.2.7). 

Если указать на одну из позиций в списке, на изображении Solid-а загорается 
соответствующая кромка. Перебирая, таким образом, список, можно выбрать нужные кромки 
для скругления. 

Теперь сделаем отверстия для проушины кронштейна и болтов. Создадим сначала 
цилиндрическое тело с радиусом отверстия проушины, ось которого совпадает с осью 
отверстия. Высота цилиндра должна превышать толщину проушины и цилиндр должен 
располагаться так, чтобы выглядывать с обеих сторон проушины. Это можно сделать 
аналогично созданию цилиндрического тела из поверхности 3. Затем “пробъем” отверстие в 
проушине с помощью команды вычитания объемных тел Edit>Solid>Boolean. Для этого 

следует нажать клавишу объединения  (Subtract), выбрать в поле Target Solid тело, из 
которого будет производиться вычитание, а в поле Subtracting Solid выбрать тело, которое 
будет вычитаться. 

Аналогичным образом сделайте отверстия под болты. Для создания цилиндра пробивки 
отверстия под болты используйте для разнообразия команду Create>Solid>Pr imitive 
(рис.3.2.8). Теперь нужно передвинуть созданные примитивы, совместив их оси поочередно с 



осями отверстий под болты командой Transform>Solid>Translate, и сделать вычитание 
Solid-ов кронштейна и цилиндрического примитива, создав отверстия под болты. 

Для удобства приложения нагрузки на кронштейн целесообразно, чтобы узлы на 
поверхности отверстия проушины, в которые должна прикладываться нагрузка, лежали на 
одной поверхности, а узлы, в которые нагрузка прикладываться не должна, - на другой. Для 
создания поверхности отверстия проушины, на которую будет прикладываться нагрузка, 
нужно сделать следующее: 

• создать цилиндр внутри отверстия; 
• разбить его в горизонтальной плоскости командой Edit>Solid>Break. При выполнении 

этой команды выберите опцию Plane (разбивать плоскостью), в поле Solid List укажите 
цилиндр, а в поле Break Plane List укажите плоскость, которая будет проходить через 
центр отверстия и перпендикулярно которой будет приложена нагрузка; 

• с помощью команды Edit>Solid>Imprint (сделать отпечаток одного тела на другом) 
разбейте внутреннюю поверхность отверстия проушины. При выполнении этой 
команды следует в поле Imprinting Solid указать половину цилиндра, а поле Imprinted 
Solid указать тело кронштейна. 

Геометрическая модель одного из вариантов кронштейна показана на рис.3.2.9. 
 



3.2.5. Задание материалов и свойств 
В этой задаче для материала кроме модуля упругости (Elastic Modulus) и коэффициента 

Пуассона (Poisson’s Ratio) требуется также задать и плотность (Mass Density). 

Для создания материала войдем в приложение  и вызовем окно команды 
Create>Isotropic>Manual Input. Здесь в поле Material Name задайте имя материала. Нажатием 
клавиши Input Properties вызовите окно ввода свойств материала и задайте там значение модуля 
упругости, коэффициента Пуассона и плотности. В опции Constitutive Model нужно выбрать 
Linear Elastic (линейный упругий материал). Не забудьте выполнить команду, нажав клавишу 
Apply. 

Модифицировать созданный ранее материал можно командой Modify>Isotropic. 

Для создания свойства объемных конечных элементов надо перейти в приложение  и 
вызвать команду Create>3D>Solid. При выполнении этой команды следует задать имя свойства 
в поле Property Set Name и, нажав клавишу Input Properties, выбрать материал в поле Material 
Name. Кроме того, в разделе Application Region в поле Select Members нужно выбрать мышкой 
тело (Solid) кронштейна. 

Модифицировать ранее созданное свойство можно с помощью команды Modify>3D>Solid. 



3.2.6. Разбиение Solid-а на конечные элементы 

Для создания конечных элементов на Solid-е нужно перейти в приложение  и вызвать 
команду Create>Mesh>Solid. В поле Element Shape выберите тетраэдальную форму элемента 
(Tet). Алгоритм разбиения в поле Mesher выберите TetMesh. Топологию элемента в поле 
Topology выберите Tet10. Затем в поле Input List нужно выбрать разбиваемое на элементы 
объемное тело кронштейна, отключить опцию Automatic Calculation (автоматическое 
вычисление размера элемента) и задать размер элемента в поле Value. В качестве размера 
элемента можно принять минимальную толщину кронштейна. 

Теперь все готово для создания конечно-элементной сетки кронштейна. Перед выполнением 
команды создания конечно-элементной сетки во избежание потери информации рекомендуется 
сохранить модель. 

Примерный вид конечно-элементной сетки кронштейна показан на рис. 3.2.10. 

 
Рис. 3.2.10. Конечно-элементная модель варианта кронштейна 



 

 

3.2.7. Создание закреплений и нагрузок 
Кронштейн присоединяется к остальной части конструкции четырьмя крепежными 

элементами, расположенными по углам основания. Данное условие опирания 
приблизительно можно моделировать закреплением поступательных степеней свободы узлов, 
лежащих на контурах отверстий под крепеж. 

Для задания такого закрепления нужно перейти в приложение  (Граничные 
условия) и вызвать окно команды Create>Displacement>Nodal. В окне этой команды в поле 
New Set Name введите имя закрепления. Вызовите клавишей Input Data окно, в котором в 
поле Translations задайте нулевые перемещения по всем поступательным степеням свободы, 
(рис.3.2.11). Выполните команду, нажав клавишу ОК. 

Вернувшись в окно Loads/BCs, нажмите клавишу Select Application Region. В 
появившемся окне (рис.3.2.12), установив курсор в поле Select Geometry Entities, нужно 
поочередно мышкой выбирать объекты для закрепления и, действуя клавишами Add и 
Remove, сформировать список объектов, к которым прикладываются закрепления. Этот 
список будет отображен в поле Application Region. В нашем случае следует выбрать опцию 
Geometry (тогда будут выбираться для закрепления геометрические объекты) и указать 
кривые по периметрам отверстий под болты на обеих сторонах кронштейна. Выбирать 
кривые удобно нажав клавишу  панели выбора объектов, последовательно указывая 
нужную кривую и добавляя ее в список закрепляемых кривых нажатием клавиши Add. 

Не забывайте исполнять команды, нажимая соответствующие клавиши OK и Apply. 
Распределенная нагрузка должна быть приложена на грани элементов, которые лежат на 

нижней поверхности отверстия кронштейна, которую мы специально создавали. 
Распределенная нагрузка прикладывается к нижней половине поверхности отверстия 

проушины с помощью команды Create>Total Load>Element Uniform. При выполнении этой 
команды следует в поле New Set Name ввести имя нагрузки. Нажатием клавиши Input Data 
вызвать окно, в котором в поле Load нужно задать суммарный вектор нагрузки. Нажатием 
клавиши Select Application Region выберите поверхность, к которой прикладывается нагрузка. 
В нашем случае следует выбрать поверхность, соответствующую нижней половине 
поверхности отверстия проушины. 

Выполните команду, нажав клавишу Apply. На экране должно появиться изображение 
приложенных нагрузок. 



3.2.8. Запуск на расчет 

Запуск на расчет выполняется в приложении  (Анализ) командой 
Analyze>Entire Model>Full Run. 

Тип анализа выбирается с помощью клавиши Solution type. 
При решении этой задачи мы считаем, что в материале нет пластических деформаций и 

перемещения точек конструкции малы и существенно не изменяют геометрию конструкции. 
Нагрузка не меняется во времени. Такой ситуации соответствует тип анализа Linear Static 
(линейная статика). 

Клавиша Subcases позволяет настроить расчетный случай (выбор случая нагружения, набора 
выдаваемых результатов и др.), а клавиша Select Subcases позволяет выбрать расчетный случай 
(случаи) для расчета. Для случая нагружения Default расчетный случай настраивается и 
выбирается по умолчанию. Остальные клавиши дают доступ к различным опциям, в которых 
здесь нет необходимости разбираться, поскольку их значения по умолчанию подходят в нашем 
случае. 

После нажатия клавиши Apply происходит следующее: 
• Patran генерирует файл задания на расчет для системы конечно-элементного анализа 

MSC.Nastran; 
• запускается система MSC.Nastran, которая выполняет расчет в соответствии с заданием на 

расчет. В результате расчета создается файл (в нашем случае с расширением .xdb), который 
содержит результаты расчета. 



3.2.9. Просмотр результатов 
Для того чтобы просмотреть результаты в системе Patran нужно присоединить файл 

результатов, полученных системой MSC.Nastran, к базе данных Patran-а. Это можно сделать 
следующим образом: 

• Вызвать окно приложения ; 
• Установить команду Access Result>Attach XDB>Result Entities; 
• Нажать клавишу Select Result File и в появившемся окне указать файл с результатами 

(*.xdb); 
• Выполнить команду, нажав клавишу Apply. 

Визуализируем деформации и напряжения кронштейна, полученные в конечно-
элементном расчете. 

Просмотр результатов осуществляется с помощью приложения , где содержатся 
разнообразные возможности обработки результатов. Для отображения деформаций 
кронштейна в этой работе используем команду Create>Deformation (рис.3.2.13), которая 
позволяет отобразить деформации конструкции в виде перемещений узлов конечно-
элементной модели и команду Create>Fr inge (рис. 3.2.14), которая отобразит деформации и 
напряжения в виде заливки цветом, соответствующим значению отображаемой величины. 

Окна команды содержат клавиши: 

•  (Select Results) - выбор случая нагружения и типа результатов для отображения; 

•  (Target Entities) - выбор объектов, для которых визуализируются результаты; 

•  (Display Attributes) - настройки видов отображения; 

•  (Plot Options) - некоторые дополнительные возможности по обработке 
результатов расчетов; 

•  (Animation Option) - настройки параметров анимации. 

Нажатие клавиши  вызывает окно (рис. 3.2.13), в котором в поле Select Results Case(s) 
находится список случаев нагружения, имеющихся в базе данных задачи. Выберем мышкой 
нужный расчет, если их несколько. 

В поле Select Deformation Result находится список доступных видов результатов. Для 
отображения деформаций кронштейна выберем (отметив мышкой) вид Displacement 
Translational (перемещения). 

В поле Show As можно выбрать Resultant (полный вектор деформаций) или Component 
(компоненты вектора). 

Выполнить команду, нажав клавишу Apply 
Есть возможность отображать результаты только для части модели. Для этого нажатием 

клавиши  вызовем окно (рис.3.2.14), в котором в поле Target Entity можно выбрать в 
качестве объектов для отображения: 

• Current Viewport - объекты, расположенные в текущем виде на экране; 
• Nodes - узлы модели; 
• Elements - элементы модели; 



• Groups - группы; 
• и др. 
Выберем для отображения деформаций кронштейна опцию Current Viewport. 

Apply. 

Нажатием клавиши  вызовем окно, которое содержит настройки отображения 
деформации модели (рис.3.2.15). В этом окне можно выбрать цвет и толщину линий 
отображения деформированного и недеформированного состояния модели, применить 
способы отображения деформированной модели: 

• прозрачной сеткой (Wireframe); 
• с удалением невидимых линий (Hidden Line); 
• с заливкой граней элементов и тенями (Shaded). 

Задать масштаб деформаций модели можно в поле Scale Factor. Напомним, что 
интерпретация этого масштаба зависит от опции Scale Interpretation. 

Один из вариантов изображения деформаций кронштейна командой Create>Deformation 
показан на рис.3.2.16. 

 

 
Рис. 3.2.16. Деформированное и исходное (недеформированное) состояние кронштейна 

Теперь нарисуем деформации кронштейна командой Create>Fringe (рис.3.2.17). 

Оперируя клавишами , можно нарисовать деформации и напряжения в 

кронштейне способом заливки. Клавиша  в этой команде открывает окно настройки 
заливки, в котором можно изменить палитру заливки, тип заливки (с постоянными 
цветовыми областями на элементе, с непрерывным изменением цвета и др.). Примеры таких 
изображений приведены на рис.3.2.18, рис.3.2.19, рис.3.2.20,  рис.3.2.21. 



 
Рис. 3.2.18. Деформированное состояние кронштейна заливкой (Style - Discrete/Smooth) 

Отобразите деформации конструкции и напряжения (нормальные, касательные, 
эквивалентные по Мизесу). 

Список основных результатов, вычисляемых MSC.Nastran для объемных элементов, 
приведен на рис.3.2.22. Этот список для выбора нужного типа результата появляется в окне 

приложения Results при нажатой клавише , если в поле Fringe Result пометить строчку 
Stress Tensor и открыть выпадающее меню Quantity. Названия типов результатов, в основном, 
легко переводятся на русский язык. 

 



3.2.10. Анализ результатов 
Проверим правдоподобность полученных результатов. Проверка в данном случае может 

проводиться на основе вычисления максимальных значений напряжений в каком-либо сечении 
проушины по балочной теории (рис. 3.2.23). 

 
Рис. 3.2.23. Нормальные напряжения в сечении проушины согласно балочной теории 

Сечение для проверки может быть выбрано любое, лишь бы оно не пересекало основания 
кронштейна или кольцо проушины. Это ограничение связано с тем, что в основании 
кронштейна и в кольце проушины характер напряжений в принципе не подчиняется балочной 
теории из-за близости нагрузок или закреплений. 

В сечении проушины максимальное значение нормальных напряжений на площадке, 
параллельной основанию, определяется изгибающим моментом и согласно балочной теории 
равно: 

maxmax y
J
M

⋅=σ
, 

где σmax – максимальное значение нормальных напряжений в сечении; 
 М – изгибающий момент; 
 J – момент инерции сечения; 
 ymax – координата наиболее удаленной от центра тяжести сечения точки. 
Сравните в выбранном сечении максимальные значения напряжений, вычисленные по 

балочной теории и методом конечных элементов. Эти напряжения могут отличаться из-за того, 
что исследуемый объект не является балкой. Длина конструкции соизмерима с габаритами 
поперечного сечения, а само поперечное сечение изменяется по длине проушины. Тем не менее, 
это отличие не должно превышать 30 - 40%. 

Посмотреть напряжения в сечении, полученные в конечно-элементном расчете, можно 
построив график напряжений вдоль верхнего края стенки кронштейна. Это можно сделать в 
приложении Result с помощью команды Create>Graph>Y vs X0 следующим образом: 

• в поле Select Result Case выберите нужный расчет; 
• в поле Select Y Result выберите напряжения, действующие по направлению длины 

кронштейна; 
• в списке X выберите позицию Coordinate; 
• в поле Select Coordinate Axis задайте ось координат, направленную вдоль длины 

кронштейна; 



• нажмите клавишу  (Target Entities), в верхней части окна и в списке Target Entity 
выберите позицию Nodes, а в поле Select Nodes  укажите узлы вдоль верхней кромки 
стенки кронштейна. 

В результате на экране появится окно с графиком, с которого можно будет снять 
напряжения для нужного Вам сечения кронштейна по координате этого сечения. 

Для того чтобы оценить несущую способность кронштейна посмотрите, не превышает ли 
максимальное эквивалентное напряжение по Мизесу (4 теория прочности) предела текучести 
материала. Выведите на экран эти напряжения в виде заливки. В этом окне, если отмечена 
опция Show MaxMin Label, появятся максимальное и минимальное значения отображаемых 
напряжений. Сравните эти значения с допустимыми напряжениями и определите коэффициент 
запаса прочности. 

 



3.2.11. Контрольные вопросы 
При решении данной задачи изучались объемный элемент Solid, моделирование объемных 

тел средствами препроцессора Patran и некоторые возможности визуализации модели и анализа 
результатов расчета. После решения этой задачи Вы должны знать ответы на следующие 
вопросы: 

1. Объемный конечный элемент в MSC.Nastran. 
2. Для моделирования каких конструкций применяется объемный конечный элемент? 
3. Какие данные содержат свойства объемного элемента? 
4. Что такое геометрический Solid? 
5. Какими способами можно создать Solid? 
6. Какие основные операции существуют в Patran для работы с Solid-ами? 
7. Какую информацию запрашивает Patran при выдавливании Solid-а? 
8. Как создать скругление грани Solid –а? 
9. Как создать отверстия для болтов? 
10. Как разбить Solid на конечные элементы? 
11. Как задать распределенную нагрузку на поверхности? 
12. Как отобразить деформации модели? 
13. Как отобразить напряжения модели? 
14. Объясните распределение напряжений и деформаций в конструкции, положение 

концентраторов напряжений. 
15. Как проводилась проверка правильности модели? 



3.3. Пример решения задачи №3 “Моделирование и расчет ферменных и 
рамных силовых элементов конструкции с использованием 
MSC.Patran/MSC.Nastran и расчет критической силы потери устойчивости” 

Целью решения данной задачи является моделирование ферменных и рамных конструкций с 
использованием балочных конечных элементов Beam и элементов сосредоточенной массы 
Mass, выполнение расчетов формы и критической силы потери устойчивости в линейной 
постановке. 



 

 

3.3.1. Балочный элемент в MSC.Nastran  
Балочный элемент может воспринимать растягивающие/сжимающие усилия, сдвиг, изгиб, 

кручение, и предназначен для моделирования рамных и ферменных конструкций. 
Из семейства балочных элементов библиотеки конечных элементов MSC.Nastran наиболее 

универсальным является элемент Beam (см. раздел 4.1.2). Данный элемент связан с двумя 
узлами. Жесткости балочного элемента при различных видах нагружения определяются 
характеристиками поперечного сечения. 

Местная система координат балочного элемента строится следующим образом. Ось X 
направлена от первого узла элемента ко второму. Оси Y и Z перпендикулярны оси X. 
Положение осей Y и Z определяет ориентацию поперечного сечения элемента и не 
определяется топологией элемента. 

Характеристики балочного элемента задаются в приложении  командой 
Create>1D>Beam. 

В окне команды (рис.3.3.1) в поле Property Set Name задается имя свойства или это имя 
выбирается из списка в поле Existing Property Sets. 

Тип балочного элемента производится с помощью опции Option(s), которая предоставляет 
следующие возможности: 

• General Section - элемент MSC.Nastran CBAR - простой балочный элемент; 
• Curved w/General Section и Curved w/Pipe Section - элемент MSC.Nastran Cbend - балка 

с искривленной осью; 
• Lumped Section - элемент MSC.Nastran CBEAM/PBCOMP - балка сосредоточенными 

площадями (для моделирования пучков волокон композиционных материалов); 
• Tapered Section - элемент MSC.Nastran CBEAM - балка с переменным сечением 

(разные сечения для начала и конца балки); 
• General Section (CBEAM) - элемент MSC.Nastran CBEAM, но с одинаковыми 

сечениями на концах. 
Если выбрать в выпадающем меню опции Option(s) нужный пункт и нажать клавишу Input 

Properties появится окно, в котором нужно будет задать параметры для выбранного 
балочного элемента. 

Например, если выбрать пункт General Section (CBEAM) при нажатии клавиши Input 
Properties появится окно (рис.3.3.2). 

В этом окне в столбце Value, передвигая вниз движок, находящийся слева, можно задать 
все необходимые характеристики сечения вручную. 

В большинстве случаев достаточно определить значения следующих характеристик: 
• площадь поперечного сечения, А - позиция Cross Sect. Area; 
• моменты инерции поперечного сечения, Iz, Iy и Izy - позиции Inertias; 
• момент инерции на кручение, J -  позиция Torsional Constant; 
Здесь же можно задать координаты точек поперечного сечения, для которых будут 

вычисляться нормальные напряжения. Эти точки называются C, D, E и F и для них задаются 
координаты Y и Z в местной системе координат элемента (поля Ys of C points, Zs of C points, и 
т.д.). Эти точки обычно выбираются в местах поперечного сечения балки, наиболее 
удаленных от центра тяжести сечения, для того чтобы в результате расчета получить 
максимальные и минимальные значения напряжений в сечении (нормальные напряжения от 
изгиба в крайних точках сечения максимальны). Положение местной системы координат 
элемента описано в следующем разделе. 



 

 

Характеристики поперечного сечения необязательно вычислять и вводить вручную. В 
этом же окне нажатие клавиши Create Sections/Beam Library вызовет окно Beam Library 
(рис.3.3.3) со списком форм поперечных сечений, для которых можно вычислить все 
необходимые характеристики автоматически. 

Задав имя поперечного сечения, его форму, размеры и нажав клавишу Calculate/Display 
можно визуализировать сечение на экране (рис. 3.3.4). Нажатие клавиши Apply или OК 
сохранит поперечное сечение в базе данных. 

Затем в окне задания свойств следует выбрать это или какое-нибудь другое поперечное 
сечение в поле Section Name. В результате все поля геометрических характеристик сечения 
балки заполнятся автоматически. 

Определив форму и характеристики поперечного сечения и используя клавишу 
Application Region окна (рис.3.3.1) можно задать, каким силовым элементам это свойство 
будет принадлежать. 

 
Рис. 3.3.4. Визуализация сечения на экране 



3.3.2. Ориентация балочного элемента 
Ось X системы координат балочного элемента направлена от первого узла элемента ко 

второму. Оси Y и Z перпендикулярны оси X. Поперечное сечение строится в плоскости YZ 
(ось Y на рис. 3.3.4 обозначена цифрой 2, а ось Z цифрой 1). 

Начальный и конечный узлы балочного элемента неоднозначно задают положение балки в 
пространстве, а именно неясно как ориентированы оси Y и Z системы координат балочного 
элемента относительно глобальной системы координат, в которой моделируется конструкция. 
То есть поперечное сечение балочного элемента может как бы вращаться вокруг продольной 
оси балки. Для однозначного определения балочного элемента в пространстве, кроме 
начального и конечного узлов, задают ориентацию оси Y местной системы координат 
балочного элемента относительно глобальной системы координат. 

Ориентация балочного элемента задается в окне (рис. 3.3.2) в позиции Bar Orientation двумя 
способами: 

1. узлом, который вместе с двумя узлами элемента задает плоскость XY местной системы 
координат элемента (в столбце Value Type выпадающий список установлен в положение 
Node ID); 

2. вектором, параллельным плоскости XY местной системы координат балочного элемента 
(в столбце Value Type выпадающий список установлен в положение Vector). 

В данной задаче будут рассматриваться силовые элементы с осесимметричным поперечным 
сечением. Очевидно, что в случае осесимметричного сечения задание ориентации может быть 
любым, без какого бы то ни было влияния на результат. Единственное ограничение 
заключается в том, что не допускается совпадение оси Y элементной системы координат с 
продольной осью элемента (она же ось X элементной системы координат). 



 

 

3.3.3. Элемент сосредоточенной массы Mass 
Элемент сосредоточенной массы Mass является одним из средств моделирования 

инерционных характеристик конструкции в динамических расчетах и используется для 
моделирования частей конструкции, обладающих массой, но не имеющих жесткости (не 
участвующих в силовой работе конструкции). Краткое описание этого элемента находится в 
разделе 4.6.1. Элемент Mass помимо своего основного назначения может быть использован и 
в статических расчетах, например для моделирования силы веса конструкции. 

Топологически элемент Mass представляет собой точку, связанную с одним узлом, где 
находится сосредоточенная масса. При задании свойства для этого элемента могут быть 
заданы следующие инерционные характеристики: 

• массы моделируемого объекта по разным направлениям; 
• моменты инерции моделируемого объекта; 
• смещения центра масс объекта от узла вдоль осей глобальной системы координат; 
• др. 

Характеристики элемента Mass задаются в приложении  командой 
Create>0D>Mass. 

В окне команды (рис.3.3.5) в поле Property Set Name задается имя свойства или имя 
выбирается из списка в поле Existing Property Sets. 

Далее в выпадающем списке Option(s) следует выбрать тип элемента Lumped 
(сосредоточенная масса). Затем следует нажать клавишу Input Properties и в  появившемся 
окне задать характеристики элемента Mass (рис.3.3.6). В поле Select Members опции 
Application Region задается объект (точка, узел), к которому присоединяется масса. 

 



3.3.4. Природа потери устойчивости в упругих системах 
Расчет конструкции на устойчивость ферменной конструкции будет выполняться в 

линейной постановке (устойчивость по Эйлеру). В ходе этого расчета перемещения 
предполагаются малыми. 

Не будет лишним сказать несколько слов о природе потери устойчивости. Рассмотрим 
конструкцию, статически нагруженную таким образом, что потеря устойчивости еще не 
наступила. Естественно, что конструкция будет деформироваться так, чтобы уравновесить 
внешнюю нагрузку упругими силами и будет оставаться в этом положении равновесия, пока не 
изменится нагрузка. Если сообщить этой конструкции малое отклонение от положения 
равновесия, то наряду с уже действующими силами в конструкции возникнут два 
дополнительных фактора. 

1. Упругие силы, стремящиеся вернуть конструкцию в положение равновесия (Первая 
система сил). 

2. Система сил, обусловленная изменением геометрии конструкции (Вторая система сил). 
Природа этой системы сил следующая. Рассматриваемое малое отклонение вызывает 
изменение геометрии конструкции. Нагрузка на конструкцию с измененной геометрией 
действует иначе, чем на конструкцию в ее начальном состоянии. В связи с этим нагрузку 
удобно делить на две составляющие. Первая составляющая – это часть нагрузки, 
действие которой на конструкцию с изменением геометрии конструкции осталось 
неизменным. Вторая составляющая – часть нагрузки, действие которой на конструкцию 
при искажении геометрии изменилось (рис. 3.3.7). Вторая составляющая нагрузки мала 
по сравнению с первой ввиду малости изменений конструкции. Вторую составляющую 
нагрузки будем называть второй системой сил. 

Насчет первой системы сил все ясно – эти силы стремятся вернуть конструкцию в 
положение равновесия. Величина этих сил прямо пропорционально зависит от величины 
отклонения от положения равновесия и не зависит от величины внешней нагрузки. 

Со второй системой сил дело обстоит иначе. Эта система сил часто может стремиться 
вывести конструкцию из положения равновесия и увеличить породившее ее изменение 
геометрии конструкции. И что самое главное, величина этих сил прямо пропорционально (в 
случае малых отклонений) зависит не только от величины отклонения, но и от величины 
внешней нагрузки. Зависимость этих сил от нагрузки обусловлена тем, что вторая система сил 
есть не что иное, как часть внешней нагрузки и будет расти вместе с ней. Таким образом, при 
малых значениях нагрузки действие второй системы сил будет меньше чем первой, и 
конструкция вернется в положение равновесия. При больших нагрузках может получиться так, 
что действие второй системы сил начнет преобладать над действием первой и конструкция уже 
не сможет вернуться к положению равновесия. Это и будет потерей устойчивости. 

Классический пример потери устойчивости – потеря устойчивости сжатой балки - приведен 
на  
рис. 3.3.7. 



P = Рос

Балка с неизмененной
геометрией: сила Р –сила
осевого сжатия

 Отклонение от
положения
равновесия

Балка с измененной геометрией:
сила Р раскладывается на две составляющие
– силу осевого сжатия Рос и перерезывающую
силу Рперер.
В данном примере Рперер является силой,
обусловленной изменением геометрии
конструкции. Отметим также, что в данном
конкретном случае Рперер стремится
увеличить изгиб балки, препятствуя
возвращению конструкции в положение
равновесия.

P Pперер
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Рис. 3.3.7. Потеря устойчивости балки, нагруженной сжимающей осевой силой 

Результатом расчета потери устойчивости конструкции по Эйлеру является коэффициент 
критической нагрузки и форма потери устойчивости. 

Физический смысл коэффициента критической нагрузки заключается в том, что, 
перемножив приложенные к конструкции силы на этот коэффициент, мы получим критическую 
нагрузку – нагрузку, при превышении которой силы, отклоняющие конструкцию от положения 
равновесия, превышают силы, возвращающие конструкцию в положение равновесия. 

Форма потери устойчивости – характер малых отклонений конструкции от положения 
равновесия, которые соответствуют критической нагрузке. Поскольку анализ устойчивости – 
разновидность задачи нахождения собственных значений (вспоминаем линейную алгебру), то 
форма потери устойчивости находится с точностью до множителя. Перемещения потерявшей 
устойчивость конструкции, по крайней мере, в первый момент, будут складываться из 
перемещений, найденных из статического расчета, и перемещений из формы потери 
устойчивости, перемноженных на какой-то множитель. 

 



 

 

3.3.5. Описание конструкции 
В данной задаче требуется рассчитать ферменную конструкцию. Ферма имеет вершину и 

основание в виде четырехугольника. Длина стороны вершины а в, длина стороны основания 
а н. Высота фермы h. Предлагается несколько вариантов конструкции (рис. 3.3.8).  
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Рис. 3.3.8. Варианты ферменной конструкции 



 

 

Конструкция сварена из стальных труб (рис. 3.3.9). В каждой из четырех верхних угловых 
точек конструкции крепится оборудование массой М. Значения характеристик конструкции 
для различных  вариантов содержатся в табл.3.3.1. 

 
Рис. 3.3.9. Поперечное сечение стержней ферменной конструкции 

Рекомендуется использовать следующую систему единиц: силы в [Н], размеры в [мм], 
напряжения и давления в [МПа], а массу в [т]. 

 



3.3.6. Нагрузки и закрепления 
Эксплуатационная нагрузка на рассматриваемую конструкцию состоит из трех 

составляющих: 
 вес оборудования (груза), закрепленного на верхней части конструкции в четырех углах 

(4 * М кг); 
 вес конструкции (суммарная масса всех стержней фермы); 
 ветровая нагрузка. 
Массу оборудования предлагается моделировать в виде сосредоточенных масс в четырех 

верхних углах фермы. Сосредоточенные массы моделировать элементами типа Mass. 
Масса конструкции может быть задана в виде плотности материала (подробнее об этом 

ниже). 
Для упрощения моделирования силы давления ветра принимаются следующие допущения: 
1. Сила давления ветра направлена горизонтально вдоль одной из сторон прямоугольного 

основания фермы; 
2. Разные стержни фермы наклонены под разными углами к направлению ветра. 

Вследствие чего площадь миделя и угол атаки для разных стержней будут разными, а, 
следовательно, разными будут и погонные силы для разных стержней. Для упрощения 
примем погонную силу для всех стержней равной погонной силе, которая действовала 
бы, если бы стержни были расположены перпендикулярно направлению ветра. В таком 
случае погонная сила, действующая на единицу длины стержня, будет вычисляться по 
формуле 
  LSqCLF x // ⋅⋅= , 
где F – суммарная сила давления ветра на стержень фермы;  
L – длина стержня;  
Cx – коэффициент лобового сопротивления для цилиндрической поверхности; 

2

2vq ⋅
=
ρ  – скоростной напор;  

LDS ⋅=  - площадь миделя стержня;  
ρ =1.29 кг/м3 - плотность воздуха;  
v – скорость ветра. 

Скорость ветра примем равной 40 м/с, коэффициент лобового сопротивления Cx, равным 
0.8. 

Ферма крепится к жесткому фундаменту за четыре угловые точки основания фермы. 
Причем, в этих четырех узлах крепления фермы не допускаются ни поступательные 
перемещения угловых точек основания, ни вращательные перемещения этих точек. 



3.3.7. План решения задачи 
1. Выполнить линейный статический расчет конструкции. Проанализировать 

распределение нормальных напряжений по стержням фермы. 
2. Выполнить расчет на устойчивость. Посмотреть какие стержни фермы потеряли 

устойчивость и объяснить почему. 
3. На основе полученных значений максимальных напряжений и коэффициента 

критической нагрузки сделать заключение о прочности. Конструкция должна 
удовлетворять следующим требованиям: 
 Нормальные напряжения не должны по абсолютной величине превышать 200 МПа; 
 коэффициент критической нагрузки не должен быть ниже 1.0. 

4. Составить отчет решения задачи, который должен содержать следующую информацию:  
 описание варианта конструкции; 
 значения максимальных напряжений и перемещений с указанием наиболее нагруженных 

элементов конструкции; 
 значения реакций в опорах; 
 приблизительные расчеты, подтверждающие отсутствие ошибок в конечно-элементном 

расчете; 
 результаты расчета на устойчивость; 
 заключение о прочности. 



3.3.8. Особенности геометрического моделирования ферменной конструкции 
Геометрическая модель ферменной или рамной конструкции должна состоять из кривых 

(Curve), проходящих через центры тяжести сечений труб. 
Кривые можно построить по заранее созданным точкам вершин фермы в приложении 

 с помощью команды Create>Curve>Point. 
Кривые, моделирующие длинные ребра фермы, можно разбить по высоте командой 

Edit>Curve>Break (рис. 3.3.10) следующим образом. 

 
Рис. 3.3.10. Окно команды Edit>Curve>Break 

• В опции Option существуют возможности Point (разбить по точке), Parametric (разбить в 
пропорции), Plane (разбить плоскостью). Достаточно удобно использовать опцию 
Parametric, установив в поле Parametric Value нужное значение параметра разбивки; 

• Отключить Auto Execute; 
• Выбирать поочередно в поле Curve List разбиваемые кривые; 
• Выполнить команду – Apply; 
• Проверять выполнение команды подведением мыши к разбитой кривой – должны 

загораться отрезки, на которые разбита кривая; 

• Если Вы ошиблись, отмените последнюю команду, нажав клавишу . 
В результате будут получены отрезки кривых и точки на концах отрезков. 
Теперь по точкам – команда Create>Curve>Points - можно построить все необходимые 

кривые для геометрической модели фермы. 
 



3.3.9. Задание характеристик материала и свойств элементов 

Характеристики материала зададим, как обычно, в приложении . Вызовем окно 
команды Create>Isotropic>Manual Input. В поле Material Name нужно задать имя материала. 
Нажатием клавиши Input Properties вызовите окно ввода свойств материала и задайте там 
значение модуля упругости, коэффициента Пуассона и плотности (Density). В поле Constitutive 
Model нужно выбрать Linear Elastic (линейный упругий материал). 

Для создания свойств конечных элементов надо перейти в приложение  и для 
создания свойств труб фермы вызвать команду Create>1D>Beam. При выполнении этой 
команды сделайте следующее: 

• Задайте имя свойства в поле Property Set Name; 
• В опции Option выберите General Section (CBEAM) и Standard Formulation; 
• нажмите клавишу Input Properties и в появившемся окне задайте имя материала и имя 

формы сечения; 
• В этом же окне нажатием клавиши Create Sections/Beam Library вызовите окно Beam 

Library , пользуясь клавишами , выберите из набора форм сечений сечение 
трубы и задайте внешний и внутренний радиус трубы (R1, R2); 

• Нажмите клавишу Calculate/Display и проверьте по рисунку сечения на экране, 
правильно ли Вы его задали; 

• Не забудьте нажать кнопку – Apply; 
• Вернувшись в окно команды Create>1D>Beam, в поле Application Region выберите все 

кривые (Curve) фермы. Это можно сделать, заключив рисунок фермы на экране в 

замкнутую ломаную кривую, используя клавишу  (Polygon); 
• Не забудьте нажать кнопку – Apply. 
Для создания свойств элементов Mass вызовите команду Create>0D>Mass. При выполнении 

этой команды сделайте следующее: 
• В окне команды в поле Property Set Name задайте имя свойства или выберите имя из 

списка в поле Existing Property Sets; 
 В опции Option(s) выберите тип элемента Mass  - Lumped; 
 Клавишей Input Properties вызовите окно, в котором задайте значение массы элемента  

Mass – ОК; 
 В поле Select Members опции Application Region задайте точки 4-х вершин фермы. 
Геометрическая модель фермы, для которой заданы свойства для всех элементов 

конструкции, готова к разбиению на конечные элементы. 
 



3.3.10. Создание конечно-элементной сетки 
Для создания конечно-элементной сетки труб фермы вызовем окно команды 

Create>Mesh>Curve (рис. 3.3.11) приложения . 

 
Рис. 3.3.11. Окно команды Create>Mesh>Curve 

В этом окне сделайте следующее: 
• В опции Topology выберите Bar2; 
• Отключите Automatic Calculation; 
• В поле Value секции Global Edge length задайте длину конечного элемента. Для того 

чтобы удовлетворительно описывались формы потери устойчивости, каждый силовой 
элемент фермы должен быть разбит не менее чем на 10 элементов. Исходя из этого 
соображения, определите нужную в Вашем случае длину элемента; 

• В поле Curve List выберите все кривые фермы, пользуясь, например, средством выбора 
объектов (Polygon); 

• Apply. 
В результате будут созданы конечные элементы труб фермы, в полях Node и Element секции 

Output ID list появится число созданных узлов и элементов. 

Создадим конечные элементы Mass командой приложения  Create>Element>Edit. В 
появившемся окне нужно выбрать в поле Select Existing Prop созданное ранее свойство для 
элементов Mass, отключить Automatic Calculation и в поле Node 1 выбрать поочередно узлы 4-х 
вершин фермы, к которым присоединяется масса. 

При разбиении геометрической модели конечно-элементной сеткой, элементы на разных 
кривых создаются отдельно друг от друга. Поэтому соседние элементы в точке соединения 
кривых будут связаны не с общим узлом, а с несколькими совпадающими узлами – для каждой 
кривой свой узел. Для объединения (сшивания) таких совпадающих узлов необходимо 

выполнить команду Equivalence>All>Tolerance Cube приложения . 
 



3.3.11. Задание закреплений 
Опирание конструкции в углах основания можно моделировать двумя способами 

(приложение , команда Create>Displacement>Nodal): 
 закрепляя точки геометрической модели (при выборе объектов для закрепления 

пользоваться опцией Geometry); 
 закрепляя узлы конечно-элементной модели (при выборе объектов для закрепления 

пользоваться опцией FEM). 
Создайте закрепления 4-х углов основания. Способ закрепления выберите сами. 
Вид конечно-элементной модели варианта ферменной конструкции показан на рис. 3.3.12. 

 
Рис. 3.3.12. Конечно-элементная модель фермы 



3.3.12. Задание нагрузок 

Силу веса можно задать с помощью команды приложения  
Create>Inertial Load>Element Uniform. Для этого в поле New Set Name введите имя нагрузки. 
Вызовите клавишей Input Data окно, где в поле Trans Accel в формате <0 0 0> задайте 
ускорение свободного падения (9,82м/сек2) по вертикальной оси фермы. 

В результате во время расчета ко всем элементам, обладающим массой, прикладывается 
сила веса. Элементы, обладающие массой, это элементы сосредоточенной массы Mass и 
элементы других типов, для которых определены плотность и/или неконструкционная масса. 

Плотность является характеристикой материала и должна быть задана при создании 
материала или при его модификации в позиции Density. Для стали плотность равна 7800кг/м3. 

Неконструкционная масса предназначена для моделирования не силовых элементов 
конструкции, покрытий и т.д., расположенных на конечном элементе. Неконструкционная 
масса является характеристикой свойства. Она может быть задана при создании свойства 
элемента или при его модификации в позиции Nonstructural mass/Area (неконструкционная 
масса на единицу площади) для оболочечных элементов и в позиции Nonstructural mass/Length 
(неконструкционная масса на единицу длины) для линейных элементов (балки, стержни и т.д.). 

Ветровая нагрузка представляет собой силы, действующие по направлению ветра на все 
стержни фермы. Причем было принято допущение, что погонная сила для всех стержней 
одинакова (см. раздел 3.3.6). 

Подобную нагрузку можно приложить с помощью команды Create>CID Distributed 

Load>Element Uniform приложения  следующим образом:  
 В поле New Set Name ввести имя нагрузки; 
 В опции Target Element Type выбрать 1D; 
 Вызвать клавишей Input Data окно задания величины нагрузки, где в поле Distr Force в 

формате <0 0 0> задать вектор погонной силы ветра, а в поле Analysis Coordinate Frame 
выбрать систему координат, в которой задаются компоненты вектора погонной нагрузки; 

 В поле Application Region выбрать все кривые (Curve) фермы, заключив рисунок фермы 

на экране в замкнутую ломаную кривую, используя клавишу  (Polygon); 
• Не забудьте нажать кнопку– Apply; 
 



3.3.13. Запуск расчета на устойчивость 

Напомним, что запуск на расчет выполняется через приложение . 
Тип анализа выбирается с помощью клавиши Solution type. Выберите Buckling. 
Нажмите последовательно клавиши Solution Parameters и Eigenvalue Extration. В 

появившемся окне (рис. 3.3.13) задайте: 
• В опции Extration Method (метод решения) выберите – Lanczos; 
 В поле Number of Desired Roots число получаемых форм потери устойчивости – 1. 

 
Рис. 3.3.13. Окно задания параметров расчета устойчивости 



 

 

3.3.14. Отображение результатов 
Напоминаем, что для того чтобы посмотреть результаты в системе Patran, нужно 

присоединить файл результатов, полученных системой MSC.Nastran, к базе данных Patran 

(приложение , команда Attach XDB>Result Entities>Local, клавиша Select Result File, 
указать файл с результатами *.xdb, нажать клавишу Apply). 

После расчета на устойчивость Nastran создает два результата расчета (Result Cases) с 
результатами статического расчета и с результатами расчета на устойчивость. Статический 
расчет нужен для вычисления матриц дифференциальной жесткости, которые используются 
при расчете на устойчивость. 

Результаты расчета на устойчивость состоят из коэффициентов критической нагрузки 
потери устойчивости и форм потери устойчивости. 

Величину коэффициента критической нагрузки Eigenvalue можно посмотреть в окне 

приложения  в поле Select Result Cases в названии соответствующего Result Cases 
(...Mode 1: Factor =). Форма потери устойчивости хранится в векторе Eigenvectors Translation 
этого Result Cases и обычно отображается в виде деформаций. 

Нарисуйте деформации и напряжения в трубах фермы, полученные в статическом 
конечно-элементном расчете, и форму потери устойчивости, полученную в расчете Buckling. 

Виды напряжений, вычисляемые для балочного элемента Beam, приведены в табл.3.3.2. 

Используйте для этого приложение  и команды Create>Deformation, 
Create>Fr inge, Create>Quick Plot, работа с которыми подробно разбиралась в предыдущих 
задачах. 

На рис. 3.3.14 показана первая форма потери устойчивости одного из вариантов фермы. 
 



 

 

 
Рис. 3.3.14. Первая форма потери устойчивости  

одного из вариантов конструкции фермы.(см. видео) 
 

На рис. 3.3.15 приведены деформации одного из вариантов фермы. 



 

 

 
Рис. 3.3.15. Деформации фермы под нагрузками 



 

 

3.3.15. Проверка отсутствия ошибок 
Желательно, чтобы способ проверки правильности КЭ-модели ферменной конструкции 

Вы придумали сами. 
В качестве рекомендации сравните критическую нагрузку, полученную в 

конечно-элементном расчете, с критической нагрузкой для теряющего устойчивость стержня, 
полученную по формуле Эйлера: 

( )2

2

L
EJPкр
⋅

=
µ
π

, 
где J - момент инерции сечения, L - длина стержня, µ - коэффициент, характеризующий 
граничные условия. Нижний конец стержня заделан, а верхний может перемещаться вдоль 
оси стержня и поворачиваться с жесткостью, определяющейся изгибной жесткостью балки. 
Граничные условия на верхнем конце находятся где-то между ползуном, двигающимся вдоль 
стержня с шарниром (как на рис.3.3.7) и этим же ползуном, но без шарнира. Коэффициент µ 
для этих граничных условий равен 0,7 и 0,5 соответственно. 



3.3.16. Контрольные вопросы 
При решении этой задачи Вы познакомились с балочным элементом и элементом 

сосредоточенной массы, а также с расчетом конструкции на устойчивость. Кроме того, Вы 
должны были освоить некоторые особенности моделирования и отображения результатов в 
MSC.Patran. Ниже приведен список контрольных вопросов по этим темам. 

1. Балочный элемент Beam в MSC.Nastran. Топология и свойства балочного элемента. 
2. Система координат балочного элемента. Задание ориентации балочного элемента. 
3. Какие конструкции можно моделировать балочным элементом? 
4. Элемент сосредоточенной массы в MSC.Nastran. 
5. Понятие потери устойчивости конструкции. 
6. Физический смысл коэффициента критической нагрузки и формы потери устойчивости. 
7. Задание закреплений в точках и узлах. Преимущества и недостатки этих двух способов 

задания закреплений. 
8. Задание инерционных нагрузок в виде ускорения свободного падения. 
9. Источники инерционных сил в модели MSC.Nastran. 
10. Как запустить расчет на устойчивость? 
11. Какие результаты выдает MSC.Nastran для балочных элементов? 
12. Какие результаты выдаются после расчета на устойчивость и как их посмотреть? 
13. Объясните, почему одни элементы ферменной конструкции сжаты, а другие – 

растянуты? 
14. Почему, на Ваш взгляд, по первой форме потери устойчивости теряют устойчивость 

именно эти элементы фермы в Вашей задаче? 
15. От каких параметров стержня зависит критическая нагрузка потери устойчивости от 

сжатия? 



3.4. Пример решения задачи №4 “Моделирование и расчет конструкции 
стрингерного отсека ракеты-носителя в среде MSC.Patran/MSC.Nastran” 

Целью решения данной задачи является моделирование конструкции стрингерного отсека 
ракеты-носителя (РН), выполнение расчетов напряженно-деформированного состояния и 
потери устойчивости в линейной постановке. 



 

 

3.4.1. Задание 
Разработать конечно-элементную модель конструкции стрингерного отсека РН, 

изображенного на рис. 3.4.1.  

  L

360°/Ν стр

∅ D
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L/N шп

 
Рис. 3.4.1. Конструкция стрингерного отсека 

Исходные данные для моделирования приведены в табл.3.4.1. Поперечные сечения 
подкрепляющих элементов изображены на рис.3.4.2. В сечении стыка рассматриваемого 
стрингерного отсека с верхней частью летательного аппарата действуют следующие 
корпусные расчетные нагрузки: 

1. продольная сила N = 300 кН; 
2. перерезывающая сила Q = 150 кН; 
3. изгибающий момент M = 1500 кНм. 
Стыковочные шпангоуты изготовлены из сплава АМГ6 (Е = 70000 МПа, σт = 160 МПа), а 

обшивка, стрингеры и промежуточные шпангоуты изготовлены из сплава Д16 (Е = 75000 
МПа, σт = 320 МПа). 

Рассчитать стрингерный отсек на статическую нагрузку и на устойчивость (Buckling). 
На основе анализа полученных результатов сделать заключение о прочности. 
Результаты работы оформить в виде отчета. 
 



3.4.2. Создание геометрической модели стрингерного отсека 
Конструкция стрингерного отсека состоит из обшивки, стрингеров и шпангоутов. Обшивка 

будет моделироваться оболочечными элементами Shell, а стрингеры и шпангоуты – балочными 
элементами Beam. 

Геометрические модели для обшивки и для подкрепляющих элементов должны составлять 
единое целое, т.к. необходимо, чтобы сетки балочных элементов и оболочечных элементов 
можно было сшить между собой. Другими словами, требуется, чтобы во всех узлах балочных 
элементов находились и узлы оболочечных элементов. Это будет выполняться автоматически, 
если оболочечные элементы будут создаваться на поверхностях, а балочные – на кривых, 
являющихся границами этих поверхностей. Узлы балочных конечных элементов, созданных на 
кромке поверхности, будут совпадать с узлами оболочечных элементов, созданных на самой 
поверхности. При совпадении границ соседних поверхностей Patran автоматически объединяет 
их в одну кривую. Это удобно, так как если бы это было не так, то мы бы имели дело с 
совпадающими кривыми, на которых возникли бы совпадающие элементы. Следствием этого 
было бы увеличение жесткости силового набора в два раза. 

Геометрическая модель, созданная по данной идеологии, будет представлять собой 
цилиндрическую оболочку, составленную из прямоугольных поверхностей, соответствующих 
областям обшивки между соседними стрингерами и шпангоутами. Такую геометрическую 
модель можно создать следующим образом: 

1) войти в приложение ; 
2) создать кривую, являющуюся образующей отсека; 
3) создать поверхность, соответствующую оболочке между двумя стрингерами (угол 

360°/Nстр), выполнив над образующей кривой команду создания поверхности вращения 
Create>Surface>Revolve. В ходе выполнения этой команды в поле Axis следует указать 
ось вращения, в поле Total Angle указать угол поворота и в поле Curve List – кривую, 
которую поворачиваем; 

4) скопировать созданную поверхность по окружному направлению с помощью команды 
Transform>Surface>Rotate. В процессе выполнения этой команды потребуется ввести 
вектор, задающий положение оси вращения (поле Axis), число копий (позиция Repeat 
Count) и угол, на который будет повернута каждая последующая копия поверхности 
относительно предыдущей (поле Rotation Angle); 

5) создать плоскости, содержащие в себе промежуточные шпангоуты, командой 
Create>Plane>Point Vector. При выполнении этой команды потребуется указать точку, 
лежащую в создаваемой плоскости, и вектор, перпендикулярный этой плоскости; 

6) разрезать созданные поверхности по сечениям промежуточных шпангоутов с помощью 
команды Edit>Surface>Break. При выполнении этой команды следует выбрать в списке 
Option пункт Plane, в поле Surface List выбрать рассекаемые поверхности, а в поле Break 
Plane List выбрать плоскость, по которой выполняется рассечение. Также должна быть 
выбрана опция Delete Original Surfaces, чтобы удалить неразрезанные поверхности. Если 
этого не сделать, ненужные уже поверхности будут мешать выбирать разрезанные 
поверхности при выполнении следующих операций. 

 



3.4.3. Создание свойств конструкционных материалов 

Создание материалов производится в приложении  так же, как и в предыдущих 
работах за исключением того, что в данной задаче используются два материала и требуется 
обязательно задать их плотность. Плотность материала вводится для того, чтобы можно было 
автоматически вычислить массу модели конструкции отсека. 



3.4.4. Создание свойств конечных элементов 
При решении данной задачи потребуется создать одно оболочечное свойство Shell для 

обшивки и три балочных свойства Beam для моделирования силового набора. Создание 
оболочечных и балочных свойств обсуждалось при решении задач №1 и №3 соответственно. 
В данной задаче нужно обсудить только несколько особенностей. 

Во-первых, при создании свойств (приложение  команда Create>1D>Beam) для 
разных свойств потребуется указывать разные кривые. Для гибкого выбора кривых 
рекомендуется использовать команду Preferences>Picking.главного меню системы 
(рис.3.4.3). В окне этой команды обратите внимание на раздел Rectangle/Polygon Picking, 
содержащий опции Enclosure Entire Entity (выбор объектов целиком охваченных рамкой) и 
Enclosure Any Portion of Entity (выбор объектов частично охваченных рамкой). Кроме того, 
при выборе пользуйтесь клавишами Add и Remove секции Application Region, которые 
добавляют выбранные объекты в список или убирают их из него соответственно. Можно 
также редактировать список выбора вручную, если Вы заметили, например, что он содержит 
объект, который Вы не хотели выбирать. 

Во-вторых, в предыдущей работе было все равно как задавать ориентацию балочных 
элементов, поскольку их сечение (труба) было осесимметричным. Теперь же ориентация 
сечения профиля стрингера и шпангоута (поле Bar Orientation в окне Input Properties 
команды Create>1D>Beam) должна быть задана строго определенным образом, чтобы 
сечения силового набора разместились так, как они размещены в моделируемой конструкции. 
Ориентация балочного элемента определяет положение элементной системы координат (СК) 
относительно глобальной СК. Ось Х элементной СК направлена от первого узла балочного 
элемента ко второму. Направление оси Y можно задавать двумя способами: вектором, 
образующим вместе с осью Х элементной СК плоскость XY, и узлом, лежащим в плоскости 
XY элементной СК. В отсеке осесимметричной формы удобно задавать ориентацию либо с 
помощью узла, лежащего на оси отсека, либо вектором, направленным по радиальному 
направлению. Этот вектор для всего силового набора одновременно можно задать в 
цилиндрической системе координат, ось Z которой совпадает с осью отсека. 

Направление оси Y элементной системы координат относительно сечения можно увидеть, 
выполнив команду Tools>Beam Library главного меню. В появившемся окне задания 
параметров поперечных сечений выполнить команду Modify>Standard Shape>Nastran 
Standard, выбрать нужное сечение и нажать кнопку Calculate/Display. Появится окно с 
изображением поперечного сечения и осью, имеющей номер 2 и являющейся осью Y 
элементной системы координат. 

Задание ориентации сечения в окне Input Properties команды Create>1D>Beam с 
помощью узла выглядит как обычная ссылка на узел (например, “Node 1”), а задание 
ориентации вектором может выглядеть следующим образом “< -1 0 0 Coord 1 >”. Если 
система координат с номером 1 цилиндрическая, то в этом примере вектор ориентации 
направлен вдоль радиального направления внутрь отсека. 

Создание новой системы координат выполняется в приложении Geometry с помощью 
команды Create>Coord>3Point. При выполнении этой команды нужно: 

• в выпадающем списке Type выбрать тип системы координат; 
• в поле Origin ввести координаты начала системы координат; 
• в поле Point on Axis3 указать координаты точки на оси Z, а в поле Point on Plane1-3 

указать координаты точки, лежащей в плоскости XZ (или RZ для цилиндрической СК). 
В-третьих, в этой задаче нужно задавать смещение нейтральной оси балочных элементов 



относительно линии узлов. Это смещение задается в окне Input Properties команды 
Create>1D>Beam в полях Offset @ Node 1 и Offset @ Node 2 (в нашем случае концы 
балочных конечных элементов должны иметь одинаковые смещения и оба эти поля должны 
иметь одинаковые значения). Смещение задается в виде вектора, чтобы поперечное сечение 
стрингера заняло положение, показанное на рис. 3.4.4. 

Нейтральная ось сечения

Положение линии узлов

ось Y элементной СК

ось Y элементной СК

Положение линии узлов

Нейтральная ось сечения

Смещение нейтральной оси(offset)

Смещение нейтральной оси(offset)

а) Ориентация стрингера

б) Ориентация стыковочного шпангоута
 

Рис. 3.4.4. Взаимное положение стрингера и обшивки 



3.4.5. Создание КЭ сетки 

Создание конечно-элементной сетки выполняется в приложении  при помощи команд 
Create>Mesh>Surface и Create>Mesh>Curve. При выполнении этих команд нужно поставить 
одинаковый размер конечных элементов (в секции Global Edge Length опция Automatic 
Calculation должна быть неактивна, а поле Value должно содержать одинаковый размер 
элемента). Размер элемента рекомендуется задавать с таким расчетом, чтобы на меньшей 
стороне панелей обшивки помещалось 5 элементов. Это понадобится для хорошего описания 
формы потери устойчивости каждого элемента конструкции. 

После этого следует объединить сетки оболочечных и балочных элементов, удалив 
совпадающие узлы командой Equivalence>All>любой. 

При проверке правильности ориентации и смещения профилей силового набора полезно 
включить режим отображения поперечных сечений балочных элементов с помощью команды 
главного меню Display>Load/BC/Elem Props и в появившемся окне в выпадающем списке 
Beam Display выбрать 2D Mid Span+Offsets. 



3.4.6. Особенности закрепления отсека 
С общей идеологией задания закреплений для расчетов ракетно-космических конструкций 

можно познакомиться в [7]. 
Стрингерная оболочка по радиальному направлению, как правило, имеет жесткость намного 

меньшую, чем по продольному или окружному направлению. Поэтому можно считать, что по 
радиальному направлению она не воспринимает нагрузок от вышестоящего отсека РН и не 
передает нагрузки нижестоящему отсеку РН. В связи с этим закрепление отсека по нижнему 
стыковочному шпангоуту, включающее в себя закрепление по радиальному направлению, 
будет вносить ничем не обусловленное стеснение конструкции. Для того чтобы закрепить 
нижний стыковочный шпангоут по всем степеням свободы, за исключением радиального 
направления, нужно изменить систему координат закрепляемых узлов на цилиндрическую. Ось 
Z цилиндрической СК должна совпадать с продольной осью отсека. 

Изменим систему координат закрепляемых узлов на цилиндрическую СК с помощью 
команды Modify>Node>Edit из приложения Elements. В появившемся окне нужно выбрать 
опцию Analysis Coordinate Frame, и в поле Analysis Coordinate Frame указать СК, а в поле Node 
List указать список узлов, у которых мы меняем систему координат. 

При создании закреплений в узлах сечения нижнего стыкового шпангоута (окно Input Data 
команды Create>Displacement>Nodal приложения Load/BC) в позиции Analysis Coordinate 
Frame нужно выбрать созданную Вами СК. В поле Translations <T1 T2 T3> закрепить все 
степени свободы кроме перемещения по радиальному направлению (поступательная степень 
свободы T1). В поле Rotations <R1 R2 R3> закрепить поворот в плоскости оболочки (поворот 
R1). 



3.4.7. Особенности приложения нагрузок 
Распределение нагрузки, приходящей от верхнего отсека, по сечению верхнего 

стыковочного шпангоута, выполним с помощью кинематической связи RBE2 (абсолютно 
жесткая кинематическая связь). Для этого в центре сечения верхнего стыковочного шпангоута 
создайте узел. В этот узел приложите нагрузку с помощью команды Create>Force>Nodal 
приложения Load/BC. Нагрузку из этого узла нужно передать на узлы верхнего стыковочного 
шпангоута. 

Передача сил по радиальному направлению запрещается по тем же соображениям, что и при 
задании закреплений. Поэтому все узлы, между которыми будет распределяться нагрузка, 
должны иметь цилиндрическую СК. Центральный узел, в который прикладывается нагрузка, не 
должен иметь базовую цилиндрическую СК, поскольку он лежит на оси Z этой СК и для него 
неизвестно где радиальное и где окружное направление. Система координат этого узла остается 
базовой. 

С помощью команды Create>MPC>RBE2 приложения Elements создайте абсолютно 
жесткую кинематическую связь. В окне команды нажмите клавишу Define Terms. В 
появившемся окне отметьте опцию Create Independent (независимый) и укажите в поле Node 
List узел, в который приложена нагрузка. Потом отметьте опцию Create Dependent (зависимый). 
В списке DOFs выберите степени свободы узлов, присоединяемые к жесткому телу, и укажите 
в поле Node List узлы, между которыми данная нагрузка будет распределяться (узлы на верхнем 
стыковочном шпангоуте). Общие сведения о конечном элементе абсолютно жесткой 
кинематической связи RBE2 и особенности его применения находятся в разделе 4.6.3. 
 



 

 

3.4.8. Создание люка 
В реальных изделиях для разных целей приходится регулярную конструкцию перерезать 

люками, которые могут существенно влиять на напряжения и деформации. 
Попробуйте смоделировать люк в стрингерном отсеке. Сами выберите его положение и 

размеры. 
Один из способов моделирования люка следующий. 

1. Удалите из своей модели стрингерного отсека все конечные элементы вместе с 
узлами. Останется геометрическая модель. 

2. Создайте в приложении  объемное тело вращения, пересекающее оболочку 
отсека по границе люка. 

3. Разбейте поверхности оболочки отсека, в которых вырезается люк, по граням 
объемного тела с помощью команды Edit>Surface>Break. При выполнении этой 
команды следует выбрать из выпадающего списка Option позицию Surface, в поле 
Surface List указать разбиваемую поверхность отсека, а в поле Break Surface List 
указать поверхность грани объемного тела, по пересечению с которой будет 
разбиваться первая поверхность отсека. Разбейте, таким образом, все поверхности 
отсека, пересекаемые поверхностью грани объемного тела люка. 

4. В результате этих разбиений возникнет ситуация когда граничная кривая одной 
поверхности отсека будет соприкасаться с граничными кривыми двух (может быть 
и более) других поверхностей. В этой ситуации нельзя получить точно 
совпадающие конечно-элементные сетки на границах этих поверхностей и такие 
сетки нельзя будет “сшить” между собой. Это можно исправить, разбивая грани 
таких поверхностей на две командой приложения Geometry - Edit>Surface>Edge 
Match. При выполнении этой команды следует выбрать из выпадающего списка 
Option позицию Surface-Point, в поле Surface List указать поверхность, грань 
которой должна быть разбита на две, а в поле Point List указать точку, по которой 
разбивается грань. 

5. Удалить поверхности расположенные внутри выреза люка. 
6. Добавить в поля Application region свойств оболочечных элементов новые 

поверхности, возникшие из-за выреза люка, а в поля Application region свойств 
балочных элементов новые кривые. 

7. Разбить поверхности и кривые на конечные элементы, сшить конечно-элементные 
сетки на них между собой и с кинематической связью. Затем изменить системы 
координат для узлов в верхнем и нижнем сечениях оболочки отсека. 

Вид КЭ-модели стрингерного отсека с вырезом приведен на рис. 3.4.5. 



 

 

 
Рис. 3.4.5. Конечно-элементная модель стрингерного отсека 



3.4.9. Запуск расчета на устойчивость и статику 
В соответствии с заданием выполните конечно-элементные расчеты напряженно-

деформированного состояния и потери устойчивости в линейной постановке. 
Процедуры запуска на расчет и отображения результатов расчетов обсуждались при 

решении предыдущих задач. 
 



 

 

3.4.10. Анализ результатов 
Визуализируйте результаты расчетов. 
Анализ напряжений в обшивке и стрингерах, значения коэффициента критической 

нагрузки потери устойчивости позволяют сделать заключение о прочности рассматриваемой 
конструкции стрингерного отсека и предложить меры по изменению конструкции с целью 
удовлетворения условиям прочности. 

На рис. 3.4.6 - 3.4.8 приведен вид некоторых результатов расчетов. 

 
Рис. 3.4.6. Деформации конструкции отсека под нагрузкой 

(см. видео) 



 

 

 
Рис. 3.4.7. Нормальные напряжения в обшивке 

 
Рис. 3.4.8. Форма потери устойчивости стрингерного отсека 

(см. видеo) 
 



 

 

Проектировщику важно знать укладывается ли он в весовые лимиты. Величина массы 
КЭ-модели служит хорошим прогнозом массы конструкции. “Взвешивая” отдельные части 
КЭ-модели, можно анализировать массу разных частей конструкции (стрингеров, обшивки, 
шпангоутов и пр.). Массу конечно-элементной модели конструкции называют теоретической 
массой. Масса реальной конструкции больше, так как включает так называемые 
конструкционные привесы (крепеж, мелкие технологические усиления, несиловые элементы 
и др.). 

Определить массу модели можно с помощью команды Tools>Mass Proper ties главного 
меню, вызвав окно Show 3D, рис.3.4.9. Нажмите клавишу Define Region. В появившемся окне 
в опции Region можно выбрать для взвешивания конечные элементы, находящиеся в группе 
(Group), все элементы модели (All) или элементы, выбранные в список (Selected). 

В опции Include можно выбрать в качестве объектов для взвешивания геометрические 
объекты (Geometry), конечные элементы (FEM), и те и другие (Both). В опции Display Method 
выбрать Summary или Entity. Обратите внимание на появляющиеся слева от окна меню, 
облегчающие выбор нужных элементов для взвешивания. Выбрав элементы для 
взвешивания, выполните команду, нажав клавишу ОК. В окне команды Show 3D в 
выпадающих списках Density/Concentrated Mass (плотность/сосредоточенная масса) и 
Thicknesses/Areas/ NSM (толщины/площади/неконструкционные массы) выберите Use Element 
Properties (использовать свойства элементов). 

В результате на экране появится таблица масс, вид которой показан на рис.3.4.10. В 
столбце Mass указана общая масса. 

Измерьте отдельно массы обшивки, стрингеров, промежуточных шпангоутов и 
стыковочных шпангоутов. 
 



3.4.11. Контрольные вопросы 
При решении этой задачи Вы научились моделировать и анализировать силовую работу 

довольно сложной конструкции стрингерного отсека в системе MSC.Patran/Nastran. Ниже 
приведен список контрольных вопросов по этим темам. 

1. Силовая работа стрингерного отсека. 
2. Опишите способ построения геометрической модели оболочечных подкрепленных 

конструкций, примененный при решении данной задачи. 
3. Способы задания ориентации балочных элементов. 
4. Создание закреплений в системе координат пользователя. 
5. Приложение корпусных нагрузок к сечению отсека с помощью конечного элемента 

абсолютно жесткой связи. 
6. Как с помощью Patran взвесить КЭ-модель и ее фрагменты? 



3.5. Пример решения задачи №5 “Проектирование конструкции 
углесотопластикового головного обтекателя ракеты-носителя в среде 
MSC.Patran/MSC.Nastran” 

Целью решения этой задачи является моделирование трехслойной конструкции головного 
обтекателя ракеты-носителя с использованием конечных элементов типа Laminate, выполнение 
расчетов напряженно-деформированного состояния, потери устойчивости и собственных форм 
колебаний. Кроме того, требуется подобрать число слоев однонаправленного углепластика в 
несущих слоях обтекателя для обеспечения условий прочности. 
 



3.5.1. Многослойный конечный элемент типа Laminate 
Конечный элемент типа Laminate состоит из одного или нескольких слоев. Каждый слой 

воспринимает мембранную нагрузку и может иметь свой материал, толщину и ориентацию 
материала. Обычно используется для моделирования многослойных композитных оболочек. 
Более детальное описание элемента типа Laminate приведено в разделе 4.4. 

Характеристики элемента задаются при определении свойства элемента - команда 
Create>2D>Shell. В появившемся окне нужно, в отличие от свойств обычных оболочечных 
элементов, в верхнем выпадающем списке Options выбрать пункт Laminate. В окне задания 
свойств в поле Material Name нужно выбрать материал типа Composite, а в поле Material 
Orientation нужно указать направление, от которого будут откладываться углы ориентации 
слоев. Направление указывается либо ссылкой на ось системы координат, либо вектором. 



3.5.2. Собственные колебания 

Собственными колебаниями называются колебания конструкции, протекающие при 
отсутствии внешних воздействий. Эти колебания характеризуются собственной формой 
колебаний и собственной частотой, которые находятся посредством решения задачи о 
собственных значениях для динамического уравнения с правой нулевой частью [8,9]. 
Перемещения системы при i-м тоне собственных колебаний имеет вид 

{ } { } )sin( tUu iii ⋅⋅⋅= ωξ  , 

где { }u  - вектор перемещений точек конструкции;  
{ }iU  - форма собственных колебаний по i-у тону;  

iω  - i-я собственная частота;  

iξ  - амплитуда колебаний по i-у тону или модальное перемещение;  
t - время. 

Число собственных колебаний системы равно числу степеней свободы. Чем выше частота 
собственных колебаний, тем сложнее собственная форма. Какой тон собственных колебаний 
будет возбужден, зависит от вида начального воздействия на конструкцию. Большинство 
воздействий, возникающих при эксплуатации конструкций, вызывают колебания с низшими 
собственными частотами. Для того чтобы возбудить собственные колебания с высокими 
собственными частотами, нужно чтобы начальное воздействие резко изменялось во времени. 

Низшие тона собственных колебаний представляют собой наиболее естественные для 
конструкции движения. 

Собственные формы и частоты колебаний являются интегральными характеристиками 
инерционных и упругих свойств конструкции. Часто требования к жесткости конструкции РН 
формулируются в виде ограничения на нижнюю частоту собственных колебаний. 



 

 

3.5.3. Конструкция головного обтекателя 
Головной обтекатель (ГО) представляет собой трехслойную оболочку, имеющую форму, 

представленную на рис. 3.5.1. 

 
 Рис. 3.5.1. Основные размеры конструкции обтекателя 

В сечении стыка ГО с ракетой-носителем (РН) на оболочке ГО установлен стыковой 
шпангоут. Поперечное сечение шпангоута в реальных конструкциях имеет довольно 
сложную форму, и здесь будет моделироваться упрощенно. Представим шпангоут в виде 
стенки из алюминиевого сплава, обращенной внутрь оболочки, высотой 100 мм и толщиной 3 
мм. 

Трехслойная оболочка состоит из двух несущих слоев углепластика и заполнителя между 
ними из металлических сот. Несущий слой, в свою очередь, состоит из 4 однонаправленных 
слоев углепластика с разной ориентацией относительно продольного направления: 0°, 45°, 
90°, 135°. Толщина каждого слоя кратна 0.15 мм (толщина одного слоя углепластика). Высота 
сотового заполнителя - 20 мм. Характеристики материалов сот и однонаправленного слоя 
углепластика приведены в табл.3.5.1. 

Неконструкционная масса (NonStructural) оболочки обтекателя - 6 кг/м2. 
Неконструкционная масса учитывает массу немоделируемых в данной модели элементов 
конструкции: теплозащитное покрытие, замки и профили продольного и поперечного стыков, 
слои стеклоткани, наматываемые из технологических соображений, клеи и пр. 

 



3.5.4. Случаи нагружения 
Рассмотрим следующие случаи нагружения. 
1. Подъем РН на стартовую позицию. Головной обтекатель закреплен в корневом 

сечении и нагружен боковой перегрузкой 9.81 м/с2. 
2. Аэродинамическое давление на участке выведения. Cлучай симметричного обтекания. 

Зависимость давления от продольной координаты следующая: 
• на сферической части ГО давление изменяется линейно с 70 КПа на переднем конце 

ГО до 30 КПа на границе с конической частью; 
• на конической части ГО давление изменяется линейно с 30 КПа на переднем конце 

конической части до 10 КПа на границе с цилиндрической частью; 
• на цилиндрической части ГО давление постоянно и составляет -5 КПа. Знак минус 

означает, что на этом участке давление действует изнутри ГО. 
3.   Аэродинамическое давление на участке выведения при максимальном скоростном 
напоре (случай “max q”). Распределение давления по половине оболочки обтекателя для 
этого случая приведено в табл.3.5.2. Распределение давления по другой половине 
симметрично первой половине. 

 



3.3.5. Критерии прочности 
1. Напряжения для всех слоев углепластика по направлению волокон не должны 

превышать допустимых - 100 МПа. 
2. Коэффициент критической нагрузки потери устойчивости не должен быть меньше 1.0. 
3. Нижняя частота собственных колебаний не должна быть ниже 10 Гц. 



3.5.6. Задание 
1. Разработать КЭ модель головного обтекателя. Размеры ГО для разных вариантов 

конструкции приведены в табл. 3.5.3. 
2. Провести линейный статический расчет, анализ начальной потери устойчивости для 

рассматриваемых случаев нагружения и анализ собственных колебаний. 
3. В случае если конструкция не удовлетворяет условиям прочности или, наоборот, 

удовлетворяет с большим запасом, предложить новые толщины слоев углепластика и 
проверить новый вариант конструкции на прочность. Толщина слоев углепластика 
должна быть кратна толщине углеленты, из которой они изготавливаются – 0.15 мм.  

 
Таблица 3.5.3.  

Варианты конструкции головного обтекателя 

 
 



3.5.7. Геометрическая модель конструкции головного обтекателя 
Поскольку и конструкция и нагрузки симметричны относительно плоскости угла атаки, 

ожидается, что и решение будет симметричным. В этом случае можно моделировать не весь 
обтекатель, а только его половину. 

Геометрическую модель обтекателя можно строить разными способами. 
Один из них следующий. 
1. Создать кривые (Curve), которые вращением вокруг продольной оси обтекателя 

образуют форму обтекателя. 
2. Построить поверхности (Surface) по этим кривым – команда Create>Surface>Revolve. 

Причем поворот выполнить на 90 градусов, поскольку поворот сразу на 180 градусов 
может привести к некоторым сложностям при создании конечно-элементной сетки. 

3. Скопировать построенные в предыдущем пункте поверхности поворотом на 90 градусов 
(команда Transform>Surface >Rotate). 

Вид геометрической модели одного из вариантов ГО показан на рис. 3.5.2. 

 
Рис. 3.5.2. Вид геометрической модели обтекателя 



 

 

3.5.8. Создание свойств конечных элементов и материалов 
Следует создать материалы для однонаправленного углепластика и сот (см. табл.3.5.1), а 

также для торцевого шпангоута. Создать материалы нужно в приложении Mater ials. 
Материалы для однонаправленного углепластика и сот - ортотропные. Ортотропные 

материалы создаются командой Create>2D Orthotropic>Manual Input. Задание 
характеристик ортотропного материала на примере сот показано на рис. 3.5.3. 

 
Рис. 3.5.3. Окно задания характеристик для ортотропного материала  

Далее следует создать композиционный материал с помощью команды 
Create>Composite>Laminate. При выполнении этой команды в специальной форме, 
показанной рис. 3.5.4, задаются материалы, толщины и ориентации слоев. 

Как создать свойство торцевого шпангоута Вы уже знаете из примера решения задачи №4. 
Создание свойства многослойной оболочки рассмотрено при описании элемента Laminate 

в разделе 3.5.1. Отметим только, что следует создать разные свойства для разных частей 
оболочки: конической, сферической, цилиндрической и цилиндрической корневой. Эти части 
оболочки нагружены по-разному и, возможно, потребуется задавать для них разные толщины 
несущих слоев. 



 

 

 
Рис. 3.5.4. Окно задания характеристик для многослойного композиционного материала 



3.5.9. Создание конечно-элементной сетки 
Создание конечно-элементной сетки производится таким же образом, как в предыдущей 

работе (см. раздел 3.4.5). 
Вид конечно-элементной модели одного из вариантов обтекателя показан на рис. 3.5.5. 

 
Рис. 3.5.5. Вид конечно-элементной модели обтекателя 

 



3.5.10. Создание закреплений 
Модель ГО закрепляется за сечение стыка с РН по всем степеням свободы, кроме 

направления по нормали к оболочке. Такое закрепление приблизительно соответствует 
условиям, в которых работает головной обтекатель, установленный на РН. Закрепления следует 
прикладывать в цилиндрической системе координат, ось Z которой совпадает с продольной 
осью ГО. Для этого нужно сделать следующее. 

1. Создать цилиндрическую систему координат, у которой продольная ось совпадает с 
продольной осью модели обтекателя – команда Create>Coord>3Point приложения 
Geometry. 

2. Сменить систему координат закрепляемых узлов с системы координат Coord 0 на 
созданную цилиндрическую систему с помощью команды Modify>Node>Edit 
приложения Elements, модифицируемый параметр Analysis Coordinate Frame. 

3. При задании закреплений с помощью команды Create>Displacement>Nodal приложения 
Loads/BCs указать в окне Input Data в поле Analysis Coordinate Frame созданную 
цилиндрическую систему координат. 

Если рассматривается половина конструкции, нужно задать дополнительно закрепления, 
моделирующие плоскость симметрии обтекателя. Узлы в плоскости симметрии не могут 
выходить из этой плоскости, а также не могут поворачиваться вокруг осей, лежащих в 
плоскости симметрии, поскольку такой поворот означал бы выход из плоскости симметрии 
точек рядом с узлом. Таким образом, у узлов, находящихся в плоскости симметрии, должны 
остаться незакрепленными только поступательные перемещения в плоскости симметрии и 
поворот вокруг нормали к плоскости симметрии. 



3.5.11. Задание нагрузок 
Нагрузки на обтекатель в данной работе содержат несколько случаев нагружения. 

Создаваемые нагрузки и закрепления попадают в активный случай нагружения модели (Load 
Case). При создании новой модели в системе Patran автоматически создается случай 
нагружения с именем Default (по умолчанию). В предыдущих работах все создаваемые 
нагрузки и закрепления попадали в этот случай, что было приемлемо т.к. конструкции в этих 
работах рассчитывались для одного случая нагружения. Кроме того, при запуске на расчет 
случай Default выбирается как расчетный по умолчанию. Поэтому при запуске на расчет в 
команде Analysis>Entire Model>Full Run не было надобности указывать, для какого случая 
нагружения выполняется расчет. Из-за того, что в этой работе случаев нагружения несколько, 
придется создавать случаи нагружения самим и явно указывать при запуске на расчет, для 
какого случая нагружения он будет выполняться. 

Случаи нагружения создаются в приложении Load Cases командой Create. Сменить 
активный случай нагружения можно в процессе выполнения любой команды создания или 
модификации нагрузок и закреплений в приложении Loads/BCs. Кроме того, перечень нагрузок 
и закреплений для случая нагружения можно задать при создании случаев нагружения (команда 
Create приложения Loads/BCs) и модификации (команда Modify приложения Loads/BCs). Для 
этого нужно нажать клавишу Assign/Prioritize Loads/BCs. С помощью этих команд убедитесь, 
что заданное ранее закрепление содержится во всех случаях нагружения. 

Приложение нагрузок в виде перегрузки рассматривалось при решении задачи №3 
(раздел 3.3.12) и здесь останавливаться на этом не будем. 

Для задания давления, переменного по поверхности обтекателя, сначала требуется задать 
закон изменения давления в виде поля (Field) системы Patran. Создать поле, задающее закон 
изменения давления от координат элемента, можно с помощью команды 
Create>Spatial>Tabular Input (создание пространственного поля заданием таблицы значений) 
приложения Fields. При выполнении этой команды следует выбрать систему координат, в 
которой будет задаваться поле, и координаты, от которых будет зависеть значение поля. В 
табл. 3.5.2 давление задается в зависимости от продольной и окружной координаты 
цилиндрической системы координат. Далее, нажав кнопку Input Data, вызывается окно, 
содержащее таблицу, в которой левый столбец и в случае двух переменных верхняя строка 
служат для ввода значений координат, а остальное поле таблицы служат для ввода значений 
поля. Ввод значений осуществляется следующим образом: выделяется ячейка таблицы, 
которую вы решили заполнить, а потом в поле Input Scalar Data вводится значение, которое 
последующим нажатием кнопки Enter посылается в выделенную ячейку. Значения координат 
должны вводиться в эту таблицу в порядке возрастания. Поле для второго случая нагружения 
будет зависеть от одной координаты (продольной), а поле для третьего случая нагружения – от 
двух координат. 

Приложение давления задается командой Create>Pressure>Elemental. При выполнении 
этой команды следует задать имя нагрузки, в выпадающем списке выбрать к каким элементам 
будет прикладываться давление к оболочечным (2D) или объемным (3D) элементам. В окне 
Input Data задать величину давления в поле Top Surface Pressure или значением (при 
постоянном давлении) или выбрав в списке Spatial Fields поле, задающее закон изменения 
давления от координат элемента. В поле Load/BC Scale Factor можно задать множитель, на 
который будет умножено значение поля. Эту возможность можно использовать, например, в 
случае если давление в поле было задано не в тех единицах измерения, в каких должно 
прикладываться давление. В регион приложения давления рекомендуется выбирать не 
геометрические поверхности, а конечные элементы (опция FEM, в поле Element List, список 
элементов), поскольку, как показывает опыт, приложение переменного давления на 
геометрические объекты, не всегда работает корректно. 
 



3.5.12. Запуск расчетов 
Запуск на расчет производится командой Analysis>Entire Model>Full Run аналогично 

предыдущим работам, за исключением того, что необходимо выбрать случаи нагружения 
(клавиша Subcase Select). Кроме того, требуется дополнительный заказ результатов расчета по 
напряжениям в слоях, который делается через кнопку Subcases. Здесь нужно выбрать действие 
Create, в списке Available Subcases выбрать расчетный случай (одноименный со случаем 
нагружения), для которого нужно заказать напряжения в отдельных слоях композиционного 
материала, затем нажать клавишу Output Request. В появившемся окне в выпадающем списке 
Form Type выбрать пункт Advanced, в списке Output Requests выбрать строчку, начинающуюся 
со слова STRESS (напряжение), и после этого в выпадающем списке Composite Plate Opt 
выбрать пункт Ply Stresses (выдача напряжений для слоев элементов Laminate). 

Расчет собственных колебаний включается выбором опции Normal Modes, доступной через 
кнопку Solution Type. Расчетный случай для этого расчета должен содержать закрепление в 
стыке с обтекателем и закрепления условия симметрии.  

В результате расчета собственных колебаний должно появится 10 результатов, содержащих 
собственные формы колебаний, названия которых содержат собственные частоты. Число 
вычисляемых тонов собственных колебаний задаются при запуске на расчет последовательным 
нажатием кнопок Subcases, Subcase Parameters и изменением значения числа тонов в поле 
Number of Desired Roots 



 

 

3.5.13. Анализ результатов расчетов 
Некоторые результаты по напряженному состоянию для элемента Laminate, выдаваемые 

MSC.Nastran, приведены в табл.3.5.4. 
Напряжения для элементов Laminate вычисляются в системе координат, связанной с 

ориентацией материала в слое элемента. Поскольку ориентация материала в разных слоях 
элемента может быть различной, для каждого слоя напряжения выдаются в своей системе 
координат. Система координат, связанная с ориентацией материала, строится следующим 
образом: ось Хм повернута относительно системы координат элемента на угол ориентации 
материала и совпадает таким образом с первым направлением ортотропного материала; ось 
Yм лежит в плоскости элемента, перпендикулярна оси Хм и совпадает со вторым 
направлением ортотропного материала; ось Zм перпендикулярна плоскости элемента. 

На рис. 3.5.6 - 3.5.11 приведены примеры некоторых результатов расчетов. 
Определите массу обтекателя. Для этого нужно воспользоваться командой Tools>Mass 

Proper ty главного меню. 
Выведите на экран в виде заливки напряжения во всех зонах оболочки для всех ее слоев 

по направлению волокна в слое, а также форму и критическую нагрузку потери 
устойчивости, формы и частоты собственных колебаний. 

Сравните эти результаты с требованиями прочности. В случае невыполнения требований 
прочности, увеличьте толщину слоев углепластика. Какие слои и в каких зонах оболочки 
обтекателя следует увеличивать, определите на основе анализа результатов расчетов. В 
случае, если условия прочности для какой-либо зоны оболочки обтекателя выполняются с 
большим запасом, уменьшите направления укладки в несущем слое с 4-х до 3-х. Например, 
можно перейти к укладке 0°, 60°, 120° или 30°, 90°, 150°. 

Снова “взвесьте” обтекатель и определите, какую массу конструкции Вам удалось 
съэкономить. 

 
Рис. 3.5.6. Деформированное состояние обтекателя  



 

 

под нагрузкой на фоне недеформированной конструкции 
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Рис. 3.5.7. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,  
ориентированного под углом 0 град к продольной оси обтекателя 
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Рис. 3.5.8. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,  
ориентированного под углом 45 град к продольной оси обтекателя 
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Рис. 3.5.9. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,  
ориентированного под углом 90 град к продольной оси обтекателя 
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Рис. 3.5.10. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,  
ориентированного под углом 135 град к продольной оси обтекателя 



 

 

  
Рис. 3.5.11. Первая форма потери устойчивости носовой части оболочки обтекателя 

(см. видео) 
 



3.5.14. Контрольные вопросы 
При решении данной задачи Вы научились моделировать силовую работу головного 

обтекателя ракеты, познакомились с элементом многослойной оболочки Laminate и с расчетом 
собственных колебаний, а также попробовали уменьшить массу конструкции, не нарушая 
требований прочности. Ниже приведен список контрольных вопросов по этим темам. 

1. Конечный элемент Laminate. Свойства. Угол ориентации материала. 
2. Что такое собственные колебания? 
3. Плоскость симметрии конструкции и КЭ-модели. Закрепления, соответствующие 

плоскости симметрии. 
4. Способы приложения давления к КЭ-модели в программе Patran. 
5. Силовая работа трехслойной оболочки. 
6. Какие изменения в конструкцию оболочки Вы внесли для удовлетворения требования 

прочности и снижения ее массы? 



 

 

3.6. Пример решения задачи №6 “Оптимизация распределения материала в 
оболочечных конструкциях около концентраторов напряжений в среде 
MSC.Patran/MSC.Nastran” 

При проектировании оболочечных конструкций актуальна задача определения 
распределения материала около неоднородностей, таких как отверстия, место приложения 
сосредоточенной нагрузки и др. Используем для решения таких задач алгоритм численной 
однокритериальной оптимизации. 

Постановка задачи однокритериальной оптимизации заключается в определении целевой 
функции, проектных переменных и ограничений. 

Проектные переменные - параметры конструкции, которые мы можем менять для 
улучшения конструкции. Ограничения - условия, которым обязательно должна 
удовлетворять конструкция. Целевая функция служит для сравнения разных вариантов 
конструкции с целью определения лучшего из них. 

Для нахождения распределения материала в оболочечной конструкции около 
неоднородности может быть использована следующая постановка задачи оптимизации: 
1) проектными переменными является толщина оболочки, которая переменна по 

поверхности оболочки и поэтому толщина каждого конечного элемента в модели должна 
быть независимой проектной переменной; 

2) ограничением является требование, чтобы эквивалентные напряжения в конструкции не 
превышали предела текучести материала; 

3) целевой функцией является масса конструкции. Чем меньше масса, тем лучше 
конструкция. 
Значения ограничений и компоненты вектора градиента целевой функции и ограничений 

в пространстве проектных параметров будут отыскиваться из конечно-элементного расчета. 
Оптимизируемая конструкции представляет собой прямоугольный фрагмент оболочки. 
Рассмотрим два вида задач, когда к краю оболочки приложена сосредоточенная сила и 

когда оболочка с отверстием в центре равномерно нагружена по краям. 
Варианты заданий изображены на рис.3.6.1. Размеры фрагментов оболочки 500Х500 мм, 

диаметр отверстия 50 мм, минимально допустимая толщина оболочки 1 мм. Стрелками, 
выходящими из точки, обозначены сосредоточенные силы, а остальными стрелками - 
распределенные силы. Сосредоточенные силы равны 200 кН, сосредоточенные моменты 
равны 25 кНм. Распределенные силы, изображенные тремя стрелками, равны 200 кН, а одной 
стрелкой - 70 кН. 

Материал оболочки - алюминиевый сплав с характеристиками: Е=70000 МПа, µ=0.3, 
σт=160 МПа. 

 



3.6.1. Задание  
С помощью оптимизационного расчета в системе MSC.Patran/MSC.Nastran определить 

распределение материала в оболочке. 
 



3.6.2. Моделирование 
В вариантах задач оптимизации 1-5 вблизи точки приложения сосредоточенной силы 

напряжения будут очень высокими, и их максимальное значение будет зависеть от размера 
конечного элемента - чем меньше элемент, тем больше напряжения. При оптимизации будет 
получаться, что очень трудно удовлетворить требованиям по напряжениям в элементах, 
присоединенных к узлу (точке), куда приложена сосредоточенная сила. В действительности 
сосредоточенных сил не бывает. Любая сила прикладывается не к точке, а к какой-то области 
конструкции с конечными размерами. На этом основании в наших задачах не будут 
оптимизироваться толщины элементов, находящихся в окрестности точки с радиусом 20 мм. 
Для того чтобы выделить эту область в конечно элементной сетке, в геометрической модели ей 
должна соответствовать отдельная поверхность. 

Вблизи отверстия и около точки приложения сосредоточенной силы напряжения меняются 
быстро. Чтобы отследить эти изменения, конечно-элементная сетка должна быть этих местах 
подробной. По мере удаления от отверстия или от точки приложения силы напряжения 
меняются медленнее и, чем дальше от этих концентраторов, тем менее подробной нужна сетка. 
Чтобы подробность конечно-элементной сетки менялась подобным образом, можно вокруг 
отверстия или вокруг окрестности приложения силы создать концентрически расширяющиеся 
четырехугольные поверхности (рис. 3.6.2). Эти поверхности можно разбить на концентрически 
расширяющуюся конечно-элементную сетку, которая учитывает изложенные выше 
соображения. 

 
Рис. 3.6.2. Геометрическая модель одной четвертой фрагмента оболочки с отверстием в центре  

и концентрическая конечно-элементная сетка вокруг отверстия 
 

При построении КЭ-модели следует обратить внимание на симметрию конструкции. Если 
конструкция, нагрузка и закрепления симметричны, то можно моделировать половину или даже 
четвертую часть конструкции, заменяя отброшенную часть конструкции условиями симметрии. 

Моделирование фрагмента оболочки рекомендуется осуществлять следующим образом. 
1. Построить кривые, ограничивающие оболочку, область концентрической сетки и 

отверстие или область вокруг приложения силы. 

2. Командой Create>Curve>Chain приложения   объединить эти кривые в 
контуры (замкнутые кривые) вокруг области приложения нагрузки, области 
концентрической сетки и остальной части оболочки. Командой 



Create>Surface>Trimmed создать поверхности, соответствующие области приложения 
нагрузки, области концентрической сетки и остальной части оболочки. 

3. Создать материал. 
4. Создать свойство элементов Shell. При этом для сокращения времени 

оптимизационного расчета толщину оболочечных элементов желательно задать как 
можно ближе к ожидаемой оптимальной. Разбить граничную поверхность на конечные 
элементы Shell с созданным свойством так, чтобы число элементов не превышало 300. 
КЭ-сетка не должна содержать треугольные элементы, так как это вызовет сложности 
при задании ограничений. 

5. Создать закрепления условий симметрии и закрепления, соответствующие Вашему 
варианту задачи. 

6. Создать нагрузку. 
7. Размножить свойство конечных элементов, т.е. сделать так, чтобы у каждого конечного 

элемента было свое свойство. Это нужно, чтобы толщины разных элементов в процессе 
оптимизации могли меняться независимо. Размножить свойства можно с помощью 

команды Expand приложения . 
 



3.6.3. Постановка задачи оптимизации в среде MSC.Patran/MSC.Nastran 
С начала следует создать проектные переменные с помощью команды главного меню 

Tools>Model Variables главного меню. В появившемся окне вызовите команду 
Create>Variable>Property. При выполнении этой команды в поле Select Property Set выберите 
свойства конечных элементов, которые будут меняться при оптимизации. Это удобно сделать с 
помощью клавиши Select Psets by Elements (выбор свойств с помощью выбора 
соответствующих им элементов). В задачах с сосредоточенной нагрузкой не следует создавать 
переменные для свойств элементов в области вокруг точки приложения силы. В опции 
Dimension выберите 2D, а в опции Type – Shell. Затем из списка Existing Variables в поле 
Select Property Name укажите Thickness (толщина). 

Постановка задачи оптимизации в MSC.Patran выполняется с помощью команды главного 
меню Tools>Design Study. В появившемся окне вызовем команду Create>Objective и создадим 
целевую функцию. При выполнении этой команды в выпадающем списке Solution следует 
выбрать позицию Global, а в  выпадающем списке Response позицию Weight (вес конечно-
элементной модели). Далее укажите имя целевой функции и в выпадающем списке MinMax 
выберите позицию minimum. 

Создадим ограничения с помощью команды Create>Constraint. При выполнении этой 
команды в выпадающем списке Solution следует выбрать позицию Linear Static, а в 
выпадающем списке Response позицию Stress (ограничиваем напряжения, полученные в 
линейном статическом анализе). В поле Constraint Name введите имя задаваемых ограничений. 
Далее в секции Constraint Region выберите опцию FEM (задание ограничений для отдельных 
конечных элементов), а выпадающие списки установите в положение 2D и Plate/Shell. В поле 
Select finite elements выберите все элементы модели кроме элементов в окрестности точки 
приложения сосредоточенной силы, поскольку изменением выбранных проектных переменных 
невозможно повлиять на напряжения в этих элементах. В опции Stress component выберите вид 
напряжения, которое не должно превышаться - эквивалентное напряжение по Мизесу 
(von Mises), В опции Location on Element задайте положение на элементе, где будет вычисляться 
значение этого напряжения - в центре элемента на координате Z1 (по толщине оболочки). В 
полях Lower Bound и Upper Bound укажите минимальное и максимальное значения напряжения. 

Теперь опишем задачу оптимизации с помощью команды Create >Design Study. При 
выполнении этой команды введите имя задачи оптимизации, а затем с помощью кнопок 
Select Objective и Select Constraints выберите заданные ранее целевую функцию и ограничения. 

Выберем проектные переменные (клавиша Select Design Variables). В появившейся таблице 
(рис. 3.6.3) в первом столбце расположены обозначения проектных переменных. Во втором 
столбце - признак того участвует ли переменная в оптимизационном расчете (для всех 
переменных должно быть Yes). В третьем столбце – начальное значение проектной переменной. 
В 4-м столбце - значение переменной на выбранном шаге оптимизации (если оптимизационный 
расчет уже выполнен, выбор шага осуществляется клавишей Design Cycle Select). В 5-м и 6-м 
столбцах – минимальное и максимальное значение проектной переменной (ограничения, 
которые нужно обязательно задать). В 7-м столбце максимальное изменение проектной 
переменной за итерацию в долях (рекомендуется оставить значение 1.0 , а при плохой 
сходимости процесса можно попробовать задать меньшее значение). 



 

Рис. 3.6.3. Окно выбора проектных переменных (клавиша Select Design Variables) 



3.6.4. Запуск оптимизационного расчета 
Перед оптимизационным расчетом для проверки КЭ-модели выполните линейный 

статический расчет. 

Запуск оптимизационного расчета производится в приложении  командой 
Optimize>Entire Modal>Full Run следующим образом. 
1. Введите имя оптимизационного расчета. 
2. С помощью клавиш Select Design Study и Select Objective выберите задачу оптимизации и 

целевую функцию. 
3. Нажав клавишу Translation Parameters, выберите тип файла результатов расчета, для чего в 

верхней части появившегося окна включите опцию op2 и выключите остальные опции этой 
группы. Это необходимо сделать поскольку формат файла .xdb не позволяет (по крайней 
мере пока) выдавать результаты оптимизационного расчета в полном объеме. 

4. Клавишей Optimization Parameters вызовите окно для настройки оптимизационного 
решателя. В поле Maximum Number of Standard Design Cycles задайте максимальное 
количество шагов процесса оптимизации. При пробном отладочном запуске достаточно 5-и 
шагов, а при отыскании оптимальной конструкции для данной задачи достаточно 20-и. В 
поле Fract. Prop. Delta (в нижней части окна) указывается, на сколько процентов за один 
шаг может измениться значение проектных переменных. Увеличение значения в этом поле 
может ускорить сходимость к оптимальной конструкции, однако чрезмерное увеличение 
может привести к тому, что процесс будет расходиться. Рекомендуется, по крайней мере, в 
первом запуске оставить эти настройки без изменений. Подтвердите выбранную настройку, 
нажав клавишу ОК. 

5. Вернувшись, таким образом, в окно команды Optimize>Entire Modal>Full Run, нажмите 
клавишу Subcases и создайте оптимизационный расчетный случай. Выберите расчетный 
случай Default в поле Available Subcases или создайте новый расчетный случай. В поле 
Available Load Cases выберите случай нагружения. Затем, нажав кнопку 
Select Constraints/Objective, выберите для расчетного случая ограничения. Подтвердите 
создание расчетного случая нажатием кнопки Apply. 

6. Выполните команду Apply в приложении Analysis. 

Некоторые версии системы MSC.Patran некорректно заказывают выделение файла под 
результаты расчета при типе файлов OP2. В этом случае расчет выполнен не будет, а файл с 
расширением F06 содержит сообщения “SYSTEM FATAL 6357” Если это случилось, откройте 
файл задания на расчет (файл c расширением .bdf) и перед строчкой “ASSIGN OUTPUT2=…” 
поставьте символ ‘$’. Повторите расчет, такая ошибка не должна появиться. 
 



3.6.5. Причины завершения расчета 
При правильной постановке задачи оптимизационный расчет может закончиться четырьмя 

ситуациями. 
1. Итерационный процесс оптимизации сошелся к минимуму целевой функции. 
2. Итерационный процесс сошелся к минимальному найденному значению целевой 

функции при ненарушении ограничений. В этом случае файл .F06 содержит фразу “RUN 
TERMINATED DUE TO HARD CONVERGENCE TO AN OPTIMUM AT CYCLE 
NUMBER = n”. 

3. Итерационный процесс не смог найти конструкцию, удовлетворяющую ограничениям, и 
сошелся к конструкции наименее нарушающей ограничения. 

4. Итерационный процесс остановился из-за достижения максимального количества 
итераций. В этом случае файл F06 содержит фразу “RUN TERMINATED DUE TO 
MAXIMUM NUMBER OF DESIGN CYCLES”. 

Для рассматриваемой задачи возможны ситуации 2, 3 и 4. 
Причиной возникновения третьей ситуации в этой задаче может быть следующее. При 

задании толщин оболочки в качестве проектных переменных мы ограничивали изменение 
значения толщины определенной величиной. Если для того, чтобы воспринять приложенную 
нагрузку с приемлемыми напряжениями, потребуется толщина больше, алгоритм оптимизации 
с одной стороны должен увеличить толщину для снижения напряжений, а с другой стороны ему 
это делать запрещено пользователем. 

При ситуации 4 нужно увеличить максимальное число итераций и/или увеличить 
ограничение на изменение переменной за одну итерацию (Move Limit). Ускорить нахождение 
оптимального решения можно удачным выбором начального распределения толщины по 
оболочке близкого к оптимальному распределению. 



3.6.6. Возможные ошибки 
При решении оптимизационных задач могут встречаются следующие ошибки. 
1. Одно и тоже свойство связано одновременно с несколькими проектными переменными. 

Сообщение может быть следующее: 
*** USER FATAL MESSAGE 7197 (DOPR1I) 
     PTYPE=PSHELL   PID=     270 PROPERTY NAME=       T IS DEFINED MORE THAN ONCE 
BY  DVPREL1      552 ENTRY. 
     USER INFORMATION: DESIGNED PROPERTIES ON  DVPREL1 MUST BE UNIQUE. 

В этом случае удалите лишние проектные переменные. 
2. Ошибка задания ограничений на напряжения в треугольных элементах. Сообщение имеет 

вид: 
*** USER FATAL MESSAGE 5626 (DSAD12) 
     ITEM CODE   19 REFERENCED ON DRESP1 ENTRY      963 WITH RTYPE = STRESS   
     IS INVALID FOR ELEMENT TYPE TRIA3      74. 
     USER ACTION: CHECK THE SPECIFIED ITEM CODE WITH THOSE LISTED IN 
                  APPENDIX A OF THE MSC.NASTRAN QUICK REFERENCE GUIDE. 
Ограничения для напряжений записываются только для четырехугольных элементов, и если 

встречается треугольный элемент (TRIA3), ограничение записывается неверно. В приведенном 
выше сообщении Nastran говорит именно об этом. Рекомендуется перегенерировать КЭ-сетку 
таким образом, чтобы она состояла только из четырехугольных элементов. 

3. Наложено ограничение на напряжения для элементов с каким-либо свойством, в то время 
как в модели элементов с этим свойством нет. Сообщение подобно этому: 

*** USER FATAL MESSAGE 7127 (DOPR3B) 
DRESP1 BULK DATA ENTRY OF ID        8 REFERENCES PTYPE PSHELL   PID      270 
     THERE ARE NO ELEMENTS CORRESPONDING TO THIS COMBINATION. 
4. Изменением имеющихся проектных переменных нельзя повлиять на одно из ограничений 

и, следовательно, удовлетворить ему. Сообщение следующее: 
THE GRADIENT OF CONSTRAINT NUMBER         1 IS ZERO 
  CONSTRAINT IS REMOVED FROM THE ACTIVE SET 
  ** THIS IS A VIOLATED CONSTRAINT 

  ** A FATAL ERROR WILL BE GENERATED 



 

 

3.6.7. Анализ результатов оптимизационного расчета 
В случае успешного завершения расчета загрузите в Patran результаты с помощью 

команды приложения  Access Result>Read OutPut2>Result Entities. После 
выполнения этой команды для всех итераций оптимизации будут загружены результаты 
статического расчета и значения проектных переменных. 

Максимальные значения эквивалентных напряжений в конструкции на последней 
итерации не должны превышать σт. Обратное будет свидетельствовать о том, что 
оптимизационный алгоритм по каким-то причинам не нашел приемлемого, с точки зрения 
ограничений, варианта конструкции. Листинг истории изменения целевой функции и 
максимального значения ограничений в процессе оптимизации можно найти в файле с 
расширением .F06. Пример такого листинга показан на рис.3.6.4. 

Ниже листинга истории изменения целевой функции в файле приводится таблица истории 
изменения проектных переменных. 

Отобразить полученные в процессе оптимизации толщины элементов можно следующим 
образом. 

Чтобы загрузить в свойства элементов толщины, полученные в результате оптимизации, 
вызовите команду главного меню Tools>Design Study. В появившемся окне выберите 
команду Create>Design Study.. В поле Existing Design Study выберите нужный 
оптимизационный расчет, нажмите клавишу Design Variables, в появившемся окне нажмите 
клавишу Design Cycle Select и выберите последний шаг оптимизации. 

После этого через приложение Proper ty можно отобразить толщину элементов фрагмента 
оболочки заливкой - команда Show. При выполнении этой команды выберите в поле Existing 
Properties толщину (Thickness), в выпадающем списке Display Method выберите пункт Scalar 
Plot, а в секции Select Groups выберите опцию All Groups. 

В некоторых версиях MSC.Patran отобразить толщины оболочки таким образом не удается 
и тогда это можно сделать другим способом: 

• В результате оптимизационного расчета появляется файл с расширением .pch. Этот 
файл содержит операторы MSC.Nastran, определяющие проектные переменные и 
свойства элементов. В нашем таком файле операторы содержат оптимальные 
толщины (PSHELL). Скопируйте в буфер все операторы PSHELL; 

• Откройте файл задания на расчет с расширением .bdf и замените средствами 
текстового редактора слово PHELL на $PSHELL. Этим действием мы 
закомментируем (не будем выполнять) операторы свойств со старыми толщинами. 

• В файле задания на расчет (*.bdf) вставьте скопированные операторы в конец этого 
файла перед ключевым словом ENDDATA. Этим действием мы поместили в этот 
файл операторы свойств с новыми толщинами. После этого файл задания на расчет 
сохраните с новым именем. 

• Откройте новую пустую базу данных MSC.Patran. 
• Выполните команду File>Impor t и в появившемся окне выпадающие списки Object 

и Source установите в позиции Model и Nastran Input соответственно. Затем 
выберите только что созданный -bdf файл. В результате в MSC.Patran загрузится 
КЭ-модель с новыми толщинами. В этой модели с помощью команды Show 
приложения Proper ties можно отобразить толщины элементов после оптимизации. 

Примерный вид распределения материала после оптимизации в оболочке вблизи 
отверстия показан на рис. 3.6.5. 



 

 

 
Рис. 3.6.5. Распределение толщин в оболочке вблизи отверстия после оптимизации  



 

 

3.6.8. Контрольные вопросы 
При решении данной задачи Вы познакомились с процедурами и результатами 

оптимизации конструкций в системе MSC.Nastran. Ниже приведен список контрольных 
вопросов по этим темам. 

1. Объясните смысл понятий “проектные переменные”, “ограничения” и “целевая 
функция” в процедуре оптимизации. 

2. Какие параметры конструкции мы назначили в качестве проектных переменных в 
нашей задаче, какова целевая функция и ограничения? 

3. Каковы особенности моделирования фрагмента оболочки, дискретно нагруженной 
сосредоточенной силой, для целей оптимизации с ограничениями по напряжениям? 

4. Где и как создаются проектные переменные в системе Patran? 
5. Где и как задаются ограничения целевая функция в системе Patran? 
6. Как настроить параметры и запустить процесс оптимизации из системы Patran? 
7. Какие результаты получает система Nastran в случае успешного решения 

оптимизационной задачи? 
8. Прокомментируйте распределение материала в оболочке, полученное в результате 

оптимизации. 
9. Какие ошибки, прервавшие процесс оптимизации, сделали Вы при решении данной 

задачи и как Вы их обнаружили и исправили? 
 



3.7. Пример решения задачи №7 “Оптимизация ферменных и рамных 
конструкций в среде MSC.Patran/MSC.Nastran” 

В этом примере рассмотрим возможности оптимизации ферменных и рамных конструкций 
Цель этой работы получить как можно более легкую конструкцию, отвечающую условиям 

прочности и жесткости, подбирая размеры поперечных сечений для стержней фермы. 
 



3.7.1. Рассматриваемая конструкция 
Используем для оптимизации КЭ-модель фермы, разработанную Вами при решении задачи 

№3. 
 



3.7.2. Постановка задачи оптимизации 
В качестве целевой функции принимаем массу конструкции. 
Ограничения принимаем следующими: напряжения для рассматриваемого случая 

нагружения не должны превышать 200МПа. 
Проектными переменными являются размеры поперечных сечений стержней фермы. При 

этом поперечное сечение по длине одного стержня будем считать постоянным. 
 



3.7.3. Модификация КЭ-модели 
Для того чтобы оптимизатор системы MSC.Nastran мог менять поперечные сечения разных 

стержней независимо друг от друга, нужно задать для оптимизируемых стержней разные 
свойства. Они должны ссылаться каждое на свое поперечное сечение. 

КЭ-модель фермы, разработанную в работе №3, модифицируем - примем для всех стержней 
фермы поперечное сечение типа прямоугольная труба (рис. 3.7.1). 

 
Рис. 3.7.1. Поперечное сечение стержней фермы 

До оптимизации поперечные сечения должны отличатся друг от друга только именем, и 
иметь размеры, показанные на рис. 3.7.1. Создайте отдельные свойства для продольных 
элементов и для раскосов для каждой секции фермы, а также отдельные свойства для 
поперечных элементов по каждой границе между секциями. При создании свойств следует в 
выпадающих списках Options выбрать пункты General Sections и Standard Formulation. Кроме 
того, в окне задания характеристик сечения в выпадающем списке справа от поля Section Name 
следует выбрать пункт Dimension. Для каждого свойства следует назначить свой список кривых 
для региона применения данного свойства (Application Region). 



3.7.4. Нагрузки и закрепления 
Закрепления остаются такими же, как в работе №3. 
Нагрузки будут состоять из двух случаев нагружения. Первый случай будет таким же, как в 

работе №3, а второй будет отличаться от первого только направлением ветра. Направление 
ветра во втором случае задайте перпендикулярным по отношению к направлению ветра в 
первом случае. Задание двух случаев нагружения обусловлено тем, что при оптимизации 
только на один случай размеры сечения по одному направлению (a1 и t1) могут приобрести 
значения отличные от размеров по другому направлению (a2 и t2). Это может произойти из-за 
того, что учитывается ветер только с одной стороны и оптимизатор спроектирует ферму 
эффективно воспринимающую только такой ветер. Из общих соображений следует, что для 
фермы, воспринимающей любой ветер, эти размеры должны быть равны друг другу. Чтобы 
добиться этого, следует проводить оптимизацию для более чем одного случая нагружения с 
разными направлениями ветра. 
 



3.7.5. Задание условий оптимизации  
Для того чтобы задать в качестве проектных переменных размеры поперечного сечения 

следует выполнить команду Tools>Model Variables>Create> Variable>Beam Dimension. При 
этом в выпадающем списке Type следует выбрать тип сечения трубы (Box), в списке 
Select Beam Section выбрать все используемые поперечные сечения, а в списке 
Select Beam Dimension выбрать размер поперечного сечения, который станет изменяться в 
процессе оптимизации. 

При выполнении команды Tools>Design Study следует установить границы изменения 
проектных переменных и определить целевую функцию также как в работе №3. Ограничения 
по напряжениям задаются нажатием кнопки Design Constraints и выполнением в появившемся 
окне команды Create>Linear Static>Stress. При выполнении этой команды следует задать имя 
ограничения, а также задать область приложения ограничения, выбрав опцию Pset и установив 
выпадающие списки на пункты 1D и Bar. Далее задать в выпадающем списке Stress Component 
тип напряжения, на которое накладывается ограничение, а в выпадающем списке Location on 
Element задать конец балочного элемента, на котором ограничивается напряжение. После этого 
в полях Lower Bound и Upper Bound задайте минимальное и максимальное допустимые 
значения напряжения соответственно. Ограничения на напряжения следует задавать для обоих 
концов балочного элемента (End A и End B) и для максимального и минимального напряжений 
по сечению балки (Maximum и Minimum). 
 



3.7.6. Запуск оптимизационного расчета 
Перед тем как запускать оптимизационный расчет следует проверить правильность модели, 

запустив статический анализ и анализ собственных форм. Техническую сторону смотрите в 
работах №3 и №6. 
 



3.7.7. Анализ результатов 
Загрузить оптимальные значения проектных переменных можно командой главного меню 

Tools>Design Study. В появившемся окне выберите команду Create>Design Study. В поле 
Existing Design Study выберите нужный оптимизационный расчет, нажмите клавишу Design 
Variables, в появившемся окне нажмите клавишу Design Cycle Select и выберите последний шаг 
оптимизации. 

Отобразить изменение проектных переменных, целевой функции, напряжений, прогибов и 
др. в зависимости от номера цикла оптимизации в виде графиков можно выполнив команду 
Create>Graph>Y vs X приложения Results. В списке Select Result Cases нужно выбрать циклы 
оптимизации, для которых будет построен график. В выпадающем списке X нужно выбрать 
пункт Global Variable и рядом в выпадающем списке Variable пункт Design Cycle. В 
выпадающем списке Y нужно выбрать либо Result для отображения напряжений, перемещений 
или других откликов, либо Global Variable для отображения целевой функции или проектных 
переменных. В первом случае под списком Y появится список Select Y Result, где можно 
выбрать отображаемые результаты расчета, а во втором случае появится выпадающий список 
Variable, где можно будет выбрать целевую функцию или проектные переменные. Однако 
чтобы построить эти графики нужно, чтобы результаты расчетов записывались в файл *.op2 для 
каждого цикла оптимизации, что по умолчанию не делается. Чтобы заказать эту выдачу 
результатов нужно при запуске оптимизации в команде Optimize>Entire Model>Full Run 
приложения Analysis в окне Optimization Parameters в поля Print Design Data(P1) evry n-th cycle 
и Print Analysis Results (NASPRT) evry n-th cycle ввести значение 1. 
 



4. Библиотека конечных элементов MSC.Nastran для расчета ракетно-
космических конструкций 

Здесь рассмотрены наиболее часто используемые конечные элементы системы MSC.Nastran. 
Для каждого конечного элемента приводится следующая информация:  
 топология элемента (число узлов в конечном элементе и их расположение); 
 местная система координат конечного элемента; 
 жесткости, которые элемент привносит в конечно-элементную модель, и 

характеристики, от которых эти жесткости зависят (свойства); 
 виды конструкций, при моделировании которых данный элемент используется; 
 кроме того, обсуждаются некоторые особенности применения конечного элемента, 

незнание которых может привести к ошибкам в конечно-элементной модели. 



4.1. Одномерные элементы 

Одномерными элементами называются элементы, связывающие между собой два узла 
конечно-элементной сетки. Различные типы таких элементов используются для моделирования 
соответствующих им типов конструкций. 



4.1.1. Стержневой элемент типа Rod 
Краткая характеристика. Одноосный элемент, работающий только на растяжение, сжатие и 

кручение. Не работает на изгиб, сдвиг не учитывается. 

 
Рис. 4.1.1. Конечный элемент типа Rod 

Применение. Стержневой элемент Rod обычно используется для моделирования ферменных 
конструкций, когда нет необходимости исследования устойчивости отдельных стержней ферм, 
а также для моделирования пружин, работающих на сжатие и кручение. 

Форма. Линия, соединяющая два узла (рис. 4.1.1). 
Система координат элемента. Ось OX элемента направлена из узла, указанного в описании 

элемента первым, ко второму. 
Свойства. Площадь поперечного сечения, полярный момент инерции, коэффициент для 

расчета напряжений от кручения, неконструкционная масса на единицу длины. 
Примечания. Особенности использования стержневого элемента Rod обусловлены тем, что 

данный элемент связывает не все степени свободы своих узлов. Для того, чтобы связать все 
степени свободы узла (чтобы не было в узле механизма), нужно, чтобы к нему были 
присоединены хотя бы три стержневых элемента (если к этому узлу не присоединены какие-
либо другие элементы). Данная особенность использования стержневых элементов 
иллюстрируется на рис. 4.1.2. Степени свободы узла 2 (см. рис. 4.1.2А) по перемещениям вдоль 
осей X и Z глобальной системы координат и по поворотам вокруг осей X и Z не связаны с 
опорой. Таким образом, стержень, закрепленный только за один узел, является механизмом и 
такую модель нельзя рассчитать на статику или устойчивость. В узле 4 (см. рис. 4.1.2B) степени 
свободы, которые не связаны стержнем с опорой, закреплены, и этот стержень механизмом не 
является. Узел 6 также прикреплен к основанию по всем степеням свободы (см. рис. 4.1.2C) 
поскольку к нему подходят три стержневых элемента, соединяющих его с основанием. Причем 
важно заметить, что если бы два из этих трех элементов были параллельны друг другу, то 
модель на рис. 4.1.2C снова стала бы механизмом. Модель на рис. 4.1.2D является механизмом 
из-за того, что узлы 10, 11, 16, 17, 18 и 19 не присоединены к модели по степеням свободы, 
перпендикулярным к стержням. 
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Рис. 4.1.2. Ситуации, возникающие при использовании стержневых конечных элементов: А и D – 
незакрепленные конечно-элементные модели; В и С - закрепленные конечно-элементные модели 



4.1.2. Балочный элемент типа Beam 
Краткая характеристика. Одноосный элемент (рис. 4.1.3), работающий на растяжение, 

сжатие, кручение и изгиб. Этот элемент может иметь переменное сечение, то есть для каждого 
конца элемента можно задавать различные свойства. 

Применение. Используется для моделирования рамных и ферменных конструкций.  
Форма. Линия, соединяющая два узла.  
Система координат. Ось Х элемента направлена из первого узла ко второму. Направление 

оси Y элемента задается либо точкой в плоскости XY, либо вектором, лежащим в плоскости XY 
и несовпадающим с осью Х. Ось Z, определяется как векторное произведение осей Х и Y 
элемента. 

Свойства. Площадь поперечного сечения, моменты инерции (I1, I2, I12), полярный момент 
инерции (характеризует кручение), площади сдвига в направлении осей X и Y элемента, 
неконструкционная масса на единицу длины, точки на поперечном сечении для расчета 
напряжений. Если элемент имеет переменное сечение, то можно задать разные свойства для 
каждого из его концов. 

 
Рис. 4.1.3. Конечный элемент типа Beam 

Примечания. Элемент Beam реализует теорию балок, изучавшуюся в курсе “Сопротивление 
материалов”, и решение, получаемое на модели, составленной из этих конечных элементов, не 
зависит от того, на сколько элементов разбиты балки конструкции. Таким образом, точное 
решение в линейной статике можно получить даже на модели, в которой каждая балка 
конструкции разбита на один элемент типа Beam. Однако если исследовать конструкцию на 
устойчивость или получить собственные колебания, необходимо разбивать каждую балку 
конструкции на несколько элементов, чтобы узловые перемещения модели могли бы описывать 
форму потери устойчивости или собственную форму колебаний. 
 



 

 

4.2. Плоские элементы 

Плоские элементы (рис.4.2.1), используются для моделирования мембран, оболочечных 
конструкций и пластин. Все они сходны по принципам построения и порядку нумерации 
узлов в элементе. Простейшими типами таких элементов являются треугольный элемент с 
тремя узлами и четырехугольный элемент с четырьмя узлами. Кроме того, имеются более 
сложные шестиузловые "параболические" треугольники и восьмиузловые "параболические" 
четырехугольники. 

При моделировании конструкций с помощью плоских элементов рекомендуется 
стремиться к тому, чтобы их форма приближалась к равносторонним треугольникам или 
четырехугольникам. В этом случае полученные результаты будут наиболее точными. 

Важно отметить одну особенность выдачи результатов для плоских элементов в системе 
MSC.Nastran. Компоненты напряженного состояния выдаются в местных системах координат 
элементов. Поэтому если конечно-элементная сетка имеет элементы непрямоугольной 
формы, то смотреть компоненты напряжений не имеет смысла, так как оси систем координат 
для разных элементов будут иметь разное направление. 

 



 

 

4.2.1. Элемент Shear  Panel (сдвиговая панель) 
Краткая характеристика. Плоский элемент, который воспринимает только сдвиговые 

усилия в плоскости элемента. 
Применение. Используется для моделирования конструкций, содержащих очень тонкие 

упругие листы, которые обычно подкрепляются дополнительными жесткостями. 
Форма. 4-узловой четырехугольник. 
Система координат. Система координат элемента показана на рис.4.2.1. 
Свойства. Толщина, неконструкционная масса на единицу площади. 
 

Примечание. Элемент типа Shear Panel не создает жесткостей между всеми степенями 
свободы присоединенных к нему узлов и оболочка, набранная только из таких элементов, 
будет являться механизмом. Обычно данный элемент используют для моделирования 
потерявшей устойчивость обшивки в подкрепленной оболочке, причем по периметру 
элемента сдвиговой панели ставятся элементы Beam, моделирующие силовой набор 
оболочки. 



 

 

4.2.2. Мембранный элемент типа Membrane 
Краткая характеристика. Плоский элемент, который воспринимает нагрузки, 

действующие в плоскости элемента. 
Применение. Используется для моделирования очень тонких упругих листов или плоского 

напряженного состояния.  
Форма. Плоский трехузловой или шестиузловой треугольник, четырехузловой или 

восьмиузловой четырехугольник. 
Система координат. Система координат элемента показана на рис.4.2.1. Установка 

нужного направления свойств материала осуществляется путем поворота оси ориентации 
материала Хм. 

Свойства. Толщина пластинки, неконструкционная масса на единицу площади. 
Примечания. Элемент не создает жесткости по степеням свободы из плоскости оболочки. 

Поэтому силы, перпендикулярные оболочке, в частности давление, не будут восприниматься 
сеткой мембранных элементов. 



 

 

4.3. Универсальный оболочечный элемент типа Shell 

Краткая характеристика. Комбинированный плоский оболочечный элемент. Этот элемент 
может воспринимать мембранные силы в плоскости элемента, сдвиговую и изгибную 
нагрузку, перпендикулярные плоскости элемента. 

Применение. Любые конструкции, состоящие из тонких и средней толщины пластин или 
оболочек. 

Форма. Плоский трехузловой или шестиузловой треугольник, четырехузловой или 
восьмиузловой четырехугольник. 

Система координат. Система координат элемента показана на рис.4.2.1. Установка 
нужного направления свойств материала осуществляется путем поворота оси ориентации 
материала Хм. 

Свойства. Толщина, неконструкционная масса на единицу площади, расстояние от 
нейтральной линии до верхнего и нижнего волокон при расчете напряжений. 

Примечания. Элемент типа Shell не создает ни жесткости ни массы в своих узлах по 
степеням свободы вращения вокруг нормали к плоскости элемента. Это может привести к 
ошибкам моделирования при присоединении к оболочке, набранной из элементов Shell, 
элементов других типов, создающих по данным степеням свободы и жесткость и массу, 
например элементов типа Beam (см. пример на рис. 4.3.1). В примере на рис. 4.3.1A момент 
вокруг оси Y, который приходит с элемента Beam, не воспринимается элементами Shell и 
элемент Beam может вращаться вокруг своей оси, не вызывая реакции со стороны оболочки. 
Таким образом, мы получаем в этом случае скрытый механизм (незакрепленную 
конструкцию). На рис. 4.3.1B эта ошибка устранена вспомогательными элементами типа 
Beam, установленными в плоскости оболочки и воспринимающими момент вокруг оси Y. 

X
Y

Z

A) B)

 
Рис. 4.3.1. Присоединение элементов типа Beam к оболочке из элементов типа Shell 

Максимальные напряжения при изгибе оболочки имеют место на верхней или нижней 
поверхности. Поэтому все напряжения для элемента Shell выдаются и для верхней и для 
нижней оболочки элемента. Верхней называется поверхность, расположенная со стороны 
положительного направления оси Z элементной системы координат. 

Из-за особенностей функции формы трехузловой элемент Shell вносит в модель 



 

 

завышенную жесткость на сдвиг в плоскости элемента. Поэтому нужно по возможности 
избегать использовать трехузловые элементы. 

 



4.4. Слоистый элемент типа Laminate 

Краткая характеристика. Подобен элементу типа Shell, за исключением того, что этот 
элемент (рис. 4.4.1) состоит из одного или нескольких слоев (layers). Каждый из слоев может 
иметь свои свойства материала. MSC.Nastran допускает использование элементов, включающих 
в себя до 45 слоев. 

 
Рис. 4.4.1. Конечный элемент типа Laminate 

Применение. Обычно используется для моделирования многослойных композитных 
оболочек. 

Форма. Плоский трехузловой или шестиузловой треугольник, четырехузловой или 
восьмиузловой четырехугольник. 

Система координат. Система координат элемента аналогична элементам типа Shell. 
Свойства. Для каждого слоя задаются: материал, угол ориентации свойств материала и 

толщина слоя. Помимо этого вводятся: расстояние от нейтральной плоскости до нижнего слоя, 
неконструкционная масса на единицу площади, допустимый сдвиг между слоями и 
используемая теория разрушения. 
 



4.5. Объемный элемент типа Solid 

Краткая характеристика. Трехмерный объемный элемент. 
Применение. Моделирование любых трехмерных конструкций. 
Форма. Четырехузловой тетраэдр, шестиузловая пятигранная призма, восьмиузловой 

гексаэдр, десятиузловой тетраэдр, пятнадцатиузловая пятигранная призма и двадцатиузловой 
гексаэдр, рис. 4.5.1. 

 
Рис. 4.5.1. Конечные элементы типа Solid 

Система координат. Может быть привязана к узлам элемента или приводиться в 
соответствие с глобальной (базовой) системой координат. 

Свойства. Оси ориентации свойств материала. 
Примечания. Для задания нагрузки в виде давления необходимо указывать номер грани 

элемента, на которую действует давление. На рис. 4.5.1, 4.5.2 показана нумерация граней для 
всех разновидностей элементов типа Solid. Номера граней обозначены символами от F1 до F6, 
которые обведены окружностями. Положительное давление всегда считается направленным к 
центру элемента. 

Этот элемент создает жесткости только по поступательным степеням свободы 
присоединенных узлов. Следствием этого является невозможность приложения закреплений по 
вращательным степеням свободы узлов объемных элементов и невозможность приложения к 
этим узлам нагрузки в виде моментов. 



 
Рис. 4.5.2. Параболические конечные элементы типа Solid 



4.6. Другие элементы 

Типы элементов для моделирования инерционных характеристик частей конструкции, 
моделирования кинематических связей и др. 
 



4.6.1. Элемент типа Mass 
Краткая характеристика. Обобщенный трехмерный массовый и/или инерционный элемент, 

который размещается в узле конечно-элементной сетки. Центр масс может быть сдвинут 
относительно узла. Более общей формой этого элемента является элемент типа Mass Matrix 
(матрица масс). 

Применение. Используется для моделирования частей конструкций, обладающих массой, но 
не имеющих жесткости. 

Форма. Точка, соединенная с одним из узлов сетки. 
Система координат. Согласуется с указанной системой координат. 
Свойства. Масса, моменты инерции (Ixx, Iyy, Izz, Ixy, Iyz, Izx), сдвиг центра масс 

относительно узла. 
 



4.6.2. Упругий элемент типа Spring 
Краткая характеристика. Элемент, сочетающий в себе упругий (пружина) и демпфирующий 

элементы. Может работать на растяжение (сжатие) и кручение. Для других случаев 
предусмотрен альтернативный вариант этого элемента, который описан ниже. 

Применение. Используется для моделирования элементов конструкции, которые работают 
или только на растяжение (сжатие), или только на кручение. 

Форма. Линия, соединяющая два узла.  
Система координат. Ось Х элемента направлена из первого узла ко второму.  
Свойства. Жесткость, коэффициент демпфирования. 

 



4.6.3. Упругий элемент типа Dof Spring 
Краткая характеристика. Элемент, сочетающий в себе упругий (пружина) и демпфирующий 

элементы. Этот элемент соединяет любую, выбранную (из шести), степень свободы в первом 
узле с любой степенью свободы во втором узле. 

Применение. Используется для соединения двух степеней свободы с заданной жесткостью. 
В зависимости от соединяемых степеней свободы и расположения узлов в пространстве с 
помощью такого элемента можно моделировать как части конструкции, работающие только на 
растяжение-сжатие, так и более сложные ее компоненты. 

Форма. Соединяет два узла. В MSC.Nastran изображается в виде линии, но на самом деле 
является более сложным элементом и находится в зависимости от соединяемых степеней 
свободы. 

Система координат. Определяется узловыми степенями свободы. 
Свойства. Степени свободы (для каждого из узлов), жесткость, коэффициент 

демпфирования. 
 



4.6.4. Элемент абсолютно жеской связи RBE2 
В пре-, постпроцессоре Femap подобный конечный элемент называется Rigid. 
Краткая характеристика. Элемент представляет собой жесткую связь между выбранным 

главным узлом и одним или несколькими другими узлами. 
Применение. Моделирование связей, которые являются очень жесткими по сравнению с 

остальными элементами конструкции. 
Форма. Один главный узел, соединенный с дополнительными узлами. 
Система координат. Система координат отсутствует. Работа элемента связана с заданными 

узловыми степенями свободы. 
Свойства. Отсутствуют. 
Примечания. С помощью элементов RBE2 предоставляется возможность создавать 

кинематические связи двух видов. 
Первый вид кинематической связи соответствует абсолютно жесткому телу. Перемещения 

главного (независимого) узла определяют перемещения абсолютно жесткого тела. Степени 
свободы дополнительных (зависимых) узлов считаются присоединенными к абсолютно 
жесткому телу и их перемещения определяются перемещениями абсолютно жесткого тела. 
Если степень свободы является зависимой несколько раз (например, является зависимой в 
нескольких элементах RBE2 или является зависимой в элементе RBE2 и закреплена), то 
система уравнений получится несовместной и Nastran выдаст сообщение об ошибке. 

Второй вид кинематической связи называется интерполяционным. Здесь перемещения 
главного узла определяются как средние значения перемещений дополнительных узлов. Есть 
возможность задавать разные весовые коэффициенты для разных дополнительных узлов. 
Независимыми степенями свободы для этого типа кинематической связи являются степени 
свободы дополнительных узлов, а зависимыми - степени свободы главного узла. Как и для 
первого типа, важно обратить внимание, чтобы степень свободы не была зависимой несколько 
раз. 

Оба типа элементов RBE2 работают корректно только при справедливости допущения о 
малости перемещений, т.е. перемещения не должны оказывать существенного влияния на 
геометрию конструкции. Перемещения узлов элемента RBE2 первого типа при немалом 
повороте показаны на рис. 4.6.1. 

 
Рис. 4.6.1. Перемещение зависимых узлов элемента RBE2 первого типа при немалом повороте главного 

узла:  
а) как должно быть; б) как перемещения моделируются элементом RBE2 



4.6.5. Контактный элемент типа GAP 
Краткая характеристика. Элемент для нелинейного анализа (большие перемещения), 

который может иметь различные жесткости для моделирования работы на растяжение, сжатие и 
сдвиг. 

Применение. Используется в контактных задачах для моделирования зазоров (сближение 
контактирующих поверхностей) и мест, где зазоры могут появиться (расхождение 
контактирующих поверхностей). Кроме того, в определенных пределах может моделировать 
скольжение контактирующих поверхностей относительно друг друга (более подробную 
информацию об этом элементе можно найти в полной документации по системе MSC.Nastran 
[3]). 

Форма. Линия, соединяющая два узла.  
Система координат. Ось Х элемента направлена из первого узла ко второму. Ось Y 

располагается перпендикулярно оси Х и лежит в плоскости, определяемой первым, вторым и 
дополнительным третьим узлом (или вектором ориентации). Ось Z определяется как векторное 
произведение осей Х и Y элемента. 

Свойства. Величина начального зазора, жесткость на сжатие, жесткость на растяжение, 
поперечная жесткость при закрытом зазоре, коэффициенты трения по осям Y и Z, 
предварительная нагрузка. 

Примечания. Жесткости конструкции в контактирующих узлах не должны отличаться более 
чем в 103 раз. Если это условие не будет соблюдено, возможны проблемы со сходимостью 
нелинейного итерационного процесса. 
 



4.6.6. Графический элемент типа PLOTEL 
Краткая характеристика. Этот элемент не предназначен для моделирования элементов 

конструкции. Он не обладает жесткостью и массой. Применяется только в графических целях. 
Применение. Используется для графического представления частей конструкции, которые 

не будут подвергаться анализу, но могут помочь в визуализации модели. 
Форма. Линия, соединяющая два узла.  
Система координат. Отсутствует.  
Свойства. Не имеет. 
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